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Preface 
Storage Navigator Modular is an application that allows you to configure and monitor your 
Hitachi TagmaStore® Adaptable Modular Storage (AMS) and Workgroup Modular Storage 
(WMS) disk array subsystems.  

This document describes the requirements and procedures for executing configuration 
setting and display, information display, and error monitoring of the Hitachi TagmaStore 
Adaptable Modular Storage (AMS) and Workgroup Modular Storage (WMS) disk array 
subsystems using Storage Navigator Modular for Web. Before starting operations, please read 
this document to ensure that you thoroughly understand operating instructions and 
procedures. 

This document is intended for users with a background in data processing and who 
understand RAID disk array subsystems and their basic functions. Specific examples of 
appropriate users include:  

 System administrators responsible for the operation of systems, including array units. 

 System engineers responsible for the construction of systems, including array units. 

 Customer support engineers responsible for the maintenance of array units. 

This document assumes the following: 

 The user is familiar with the Adaptable Modular Storage (AMS) and/or Workgroup 
Modular Storage (WMS) subsystem. 

 The user has a thorough knowledge of basic Windows® operations including Microsoft® 
Internet Explorer. 

 The user is capable of installing and setting IIS (Internet Information Service) for 
Windows systems. 

Note: The screens shown in this document were captured on a Windows 2000 system with an 
array unit configured as a dual system and connected to a LAN. Some screens are different 
on a Windows 2003 system. 

Notice: The use of Storage Navigator Modular for Web and all other Hitachi Data Systems 
products is governed by the terms of your agreement(s) with Hitachi Data Systems. 

Software Version 

This document revision applies to TagmaStore Adaptable Modular Storage and Workgroup 
Modular Storage version 7.10 and higher. 
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Comparing the Web, GUI, and CLI Versions of Storage Navigator Modular 

Storage Navigator Modular software has three separate versions for managing the Hitachi 
TagmaStore Adaptable Modular Storage and Workgroup Modular Storage: the Web version 
(described in this user guide), a graphical user interface (GUI) version, and a command line 
interface (CLI) version. The following table provides an overview: 
 

Application User Interface Configuration Comparisons User Guide 

Storage Navigator 
Modular for Web 

Web browser  Operating system: Windows 
 Network: One or more 

storage subsystems, a Web 
server and Web client 
computer are connected 
through a LAN. 

 Installation: The application is 
installed on the Web server. 
The Java™ runtime 
environment (for running 
Java applets in a browser) is 
installed on the Web client 
computer.  

 Operation: User runs the 
program from a Web browser 
on the client computer. 

 Used with HiCommand 
Device Manager software 
to help centrally manage 
storage subsystems.  

 May also be used without 
HiCommand software. 

 Requires a Web server. 

Storage Navigator 
Modular for Web User’s 
Guide (MK-95DF719) 

Storage Navigator 
Modular Graphical 
User Interface (GUI) 

Traditional 
graphical user 
interface (GUI) 

GUI appearance is similar to 
Web version. 

Storage Navigator 
Modular Graphical User 
Interface (GUI) User’s 
Guide (MK-95DF711) 

Storage Navigator 
Modular Command 
Line Interface (CLI) 

Command line 
interface (CLI) 

 Operating system: Windows, 
or UNIX®/Linux® 

 Network: Storage 
subsystems connect to the 
host computer through a 
LAN.  

 Installation and operation: 
Program is installed on and 
run from the host computer.  

For users that prefer 
command line interfaces or 
wanting to run scripts. 

Storage Navigator 
Modular Command Line 
Interface (CLI) User’s 
Guide (MK-95DF712) 

Convention for Storage Capacity Values 

Storage capacity values for hard disk drives are calculated based on the following values: 

1 KB = 1,000 bytes 
1 MB = 1,0002 bytes 
1 GB = 1,0003 bytes 
1 TB = 1,0004 bytes 

Storage capacity values for logical units (LUs) are calculated based on the following values: 

1 KB = 1,024 bytes 
1 MB = 1,0242 bytes 
1 GB = 1,0243 bytes 
1 TB = 1,0244 bytes 
1 block = 512 bytes 
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Chapter 1 Overview of TagmaStore® AMS and WMS 

1.1 Overview of TagmaStore AMS and WMS 

The TagmaStore Adaptable Modular Storage (AMS) and Workgroup Modular Storage (WMS) 
provide scalable, cost-effective modular storage for Microsoft Exchange Server and other 
business applications. You can use the AMS or WMS to implement storage consolidation, first 
SAN deployment, backup, or data archiving. 

The AMS and WMS enable you to meet compliance requirements, protect your data, and 
reduce recovery times, while benefiting from flexible storage solutions that allow you to 
manage your data growth. The centralized storage infrastructure allows you to reduce the 
complexity and cost of your storage management. Fully redundant and hot-swappable 
components let you to keep applications online, while within-system volume replication and 
incremental copy functions allow for frequent backups. The available RAID-6 architecture 
gives you high availability and rapid RAID group rebuild, while the Hi-Track “call home” 
service and remote maintenance functions provide the security of 24/7 support from expert 
service professionals. 

You can partition and dedicate cache to maximize the performance of high-I/O operations. 
You can leverage the AMS or WMS together with the enterprise-class TagmaStore Universal 
Storage Platform (USP) or Network Storage Controller (NSC) to implement a tiered storage 
solution to manage the data lifecycle. Simple SAN and SAN Starter solutions allow easy 
deployment. SAN-attached servers can use diskless boot, and Network Attached Storage 
(NAS) applications allow for high-capacity storage. 
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Chapter 2 Storage Navigator Specifications and Requirements 

Storage Navigator Modular for Web is used to reference status and to set up the 
configuration of an array unit.  

This chapter contains the following sections: 

 2.1 Notes on Using Storage Navigator Modular 

 2.2 Operating System Environments 

 2.3 Connecting 

 2.4 Installing  
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2.1 Notes on Using Storage Navigator Modular 

When using Storage Navigator Modular, consider the following: 

 All of the output files from the Storage Navigator Modular are sent to the Web server 
side. Specify all of the files that Storage Navigator Modular inputs and all of the 
applications that the Storage Navigator Modular activates as files on the Web server 
side. 

 The application program that is specified by Storage Navigator Modular is executed by 
the SYSTEM account of a Web server. Therefore, the application that has the GUI or 
requires the authority for the network access cannot be specified. Also, the necessary 
DDL must be set for the path of the system environment variables of the Web server. 
When the data definition language (DDL) that is necessary for the path of the system 
environment variables of the Web server is not found, the application program cannot be 
executed. 

 The Storage Navigator Modular functions of cannot be used unless a TCP/IP 
communication is made between the array unit and the Web server. Verify that the 
TCP/IP is set correctly. 

 Some Storage Navigator Modular functions are not available while the array unit is online 
with a host. For more information, see Chapter 3. 

 When a high I/O load exists, the functions that are available while online might cause a 
command time-out in the host or a recovering fault in Storage Navigator Modular. 
Hitachi Data Systems recommends that these functions be executed while offline. 

 When Storage Navigator Modular is installed in the host connected to an array unit, I/O 
loading from a host might cause a command time-out on the host side or an abnormal 
termination on the Storage Navigator Modular side. 

 Installing Storage Navigator Modular in a host that does not connect an array unit is 
recommended. 

 At least one logical unit must be configured in the array unit to make all of Storage 
Navigator Modular functions available. If no logical unit is defined in the array unit, 
some functions cannot be executed. 

 When the Web server enters the suspension status (low power mode) while Storage 
Navigator Modular is running, Storage Navigator Modular might not operate correctly 
after the Web server is released from the suspension status. 

 When you operate Storage Navigator Modular, disable power management through 
Windows® so that the Web server will not enter the suspension status. 

 Storage Navigator Modular allows multiple Array Unit screens to open for one array unit. 
When performing operations by opening multiple Array Unit screens for one array unit, 
operations may terminate abnormally. Open only one Array Unit screen for one array 
unit to operate an array unit. 

 You can perform error monitoring when an Array Unit screen is open. However, when 
you perform error monitoring with operations of a Array Unit screen concurrently, error 
monitoring operation and Array Unit screen operations may terminate abnormally. To 
start error monitoring, close all Unit screens, then perform error monitoring. 
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 Setting items displayed in the window for setting the configuration, etc. can be changed 
in some windows with the Tab key. When the setting items cannot be changed with the 
Tab key, specify the setting items using a mouse. 

 If Storage Navigator Modular does not succeed in connecting to the array unit, the 
following message may display: 

An invalid response was received from the subsystem 

This message indicates that Storage Navigator Modular may have been connected to the 
array unit while the array unit automatically rebooted. Reconnect to the array unit after 
3 minutes. 

 Storage Navigator Modular may hang up in the following cases: 

– The communication with the connected array unit fails due to controller blockage, 
array unit failure, disconnected LAN connection, or the array unit receives a 
Reset/LIP from the host. 

– Other applications are working concurrently and memory utilization or a CPU use 
rate is high. 

If Storage Navigator Modular hangs up, terminate it forcibly. Check the array unit status 
and the connection status of the LAN. Reboot Storage Navigator Modular once again. 

 The Java™ Applet Window may be displayed at the bottom of a screen item (such as a 
dialog box, popup menu, combo box) on a Storage Navigator Modular panel (see Figure 
3.3). This is not an error. 

 When Storage Navigator Modular is booted up by Windows, a Main screen may not open, 
depending on the version of DirectX. Update the DirectX of version 8.1 or later (only 
client PC side). 

 If v monitor color is not adjusted after starting Storage Navigator Modular under Solaris™, 
use a /usr/sbin/fbconfig command to increase the color number depth. The depth of the 
color number that can be specified is -prconf option. 

 If the Next or Back button is pressed continuously at a short interval while using the 
System Parameter Wizard, the screen may freeze. To avoid this, verify that the page is 
changed in the Wizard screen before pressing the Next or Back button. 

 When the installation for altering the Windows version is performed, the Windows 
version begins its service automatically and the installation is completed. 

 A user who has already logged in can be automatically logged out when another user logs 
in or the same user logs in again. If the preceding user is still using it, an error or a 
wrong indication may result. 

 When Web Navigator connects the disk array subsystem over a LAN, it uses the TCP/IP 
port number of 2000. The TCP/IP port number of the disk array subsystem is set as 2000 
by default. Since the setting of the port number of the disk array subsystem 
(AMS500/AMS200/WMS100 with the microprogram version of 0726/E or later, 
9500V/9520V with the microprogram version of x65B/H or later) can be changed. Check 
the port number setting in the Web window when the disk array subsystem cannot be 
connected. 

 The restrictions listed in Table 2-1 exist if Storage Navigator Modular is used in 
combination with other programs, for one array unit: 
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Table 2-1 Restrictions for Multiple Programs used Concurrently for One Array Unit 

Program Name Concurrent Use Supported Concurrent Use Not Supported 

Storage Navigator Modular  –     Storage Navigator Modular (Note 1) 
–     SNMP Agent 
–     DAMP Web Server 

–     DAMP GUI 
–     DAMP for Web 

DAMP GUI –     SNMP Agent 
–     DAMP Web Server 

–     Storage Navigator Modular 
–     DAMP GUI 
–     DAMP for Web 

DAMP (Web) –     SNMP Agent 
–     DAMP Web Server 

–     Storage Navigator Modular 
–     DAMP GUI 
–     DAMP for Web 

SNMP Agent –     Storage Navigator Modular 
–     DAMP GUI  
–     DAMP for Web 
–     SNMP Agent 
–     DAMP Web Server 

 N/A 

Disk Array Unit Web Server –     Storage Navigator Modular 
–     DAMP GUI  
–     DAMP for Web 
–     SNMP Agent 
–     DAMP Web Server 

 N/A 

Note 1: You can have two concurrent instances of Storage Navigator Modular, provided that 
they are not connected to the same array system. If one instance terminates forcibly, that 
may affect the other instance.  

Additionally, if one Storage Navigator Modular terminates forcibly while using two Storage 
Navigator Modular products simultaneously, another Storage Navigator Modular may 
terminate abnormally. If this occurs, operate the Storage Navigator Modular that has 
abnormally terminated again. 

If you run a combination of programs in which concurrent use is not allowed, when a 
program with a usage restriction placed on it has been started, start another program with 
that combination after terminating the running program. 

To operate other programs, refer to their respective user’s guides, which are provided with 
the program products. 
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 When connecting the disk array subsystem with Storage Navigator Modular over a LAN, 
the disk array subsystem may not be able to connect because a time-out of the data 
transfer occurs. This will depend on the LAN environment. When Storage Navigator 
Modular cannot be connected with the disk array subsystem, verify that the connection 
is correct using the ping command. If a response to the ping command is normal, the 
LAN environment may affect the data transfer. The length of data to be transferred can 
be changed with the “lanconf.inf” file in the directory in which Storage Navigator 
Modular is installed. The default setting is “32768”. Change the setting to “16384” or 
“8192”, in this order or to a multiple of 1024, and then retry. The new setting becomes 
effective from the next operation. A restart of Storage Navigator Modular is not required. 
Operation of Storage Navigator Modular may take some time, depending on the setting. 
If the connection cannot be made regardless of the setting change, review the LAN 
environment. 

 If an array unit failure is detected, contact the Hitachi Customer Engineer. 

 Do not use the reserved words prescribed for each OS and device names that indicate 
the input/output destinations as a file name when a file is output. Windows includes 
“con”, “pm”, “aux”, etc., and UNIX includes “/dev*”, etc. For example, when con.txt 
is specified as an output file name, an error message displays. 

 If the Web Navigator is used in a server that has two or more LAN cards or an IP address, 
see Appendix D. 
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2.2 Operating System Environments 

Storage Navigator Modular is operated by connecting to the array unit over a LAN. When an 
array unit is connected to a LAN, the Web server, in which Storage Navigator Modular is 
installed, must be connected with the network and must operate normally. 

 Web server 

– OS: Windows NT 4.0 (SP6a), Windows 2000 (SP1, SP2, SP3), Windows XP (SP2), 
Windows Server 2003 (SP1), or Windows Server 2003 (R2). 

– Web server: IIS, Hitachi Web Server. 

– CPU: Pentium® III, IV (500 MHz or more is recommended.) 

– Memory: 256 MB or more is recommended. 

– Available disk capacity: 26 MB max. (Free capacity of 100 MB or more is required.) 

– Network adapter. 

– Monitor: Resolution 1,024 × 768 or more is recommended, 256 colors or more. 

 Web client 

– OS: Windows 2000 (SP1, SP2, SP3, SP4), Windows XP (SP1, SP2), Windows Server 
2003 (SP1), or Windows Server 2003 (R2). 

– Browser: IE 5.5 (SP1, SP2), IE6.0 (SP1, SP2). 

– CPU: Pentium-III, IV (333 MHz or more is recommended.) 

– Memory: 256 MB or more is recommended. 

– Available disk capacity: A free capacity of 100 MB or more is required. 

– Network adapter. 

– Monitor: Resolution 1,024 × 768 or more is recommended, 256 colors or more. 

 JRE 

– Windows: j2re-1_4_2_07-windows-i586-p.exe 

 LAN connection 

– When an array unit is connected directly to a Web server, a 10BaseT/100BaseT 
twisted pair cable crossover cable is used. 

– When an array unit is connected to a Web server over a hub, a 10BaseT/100BaseT 
twisted pair cable is used. 

 Port number of TCP/IP 

– When connecting the disk array subsystem and a LAN, Web Navigator uses the port 
number of 2000. When changing the port number, add “df-damp-snm port 
number/TCP” to the services file of the OS. In addition, when changing the port 
number, it is also required to change the port number of the disk array subsystem to 
be connected. When the port number of the disk array subsystem is set as 2000, the 
disk array subsystem can be connected to the LAN though it takes time for the 
connection even if another port number is registered in the services file. 
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2.3 Connecting the Interface 

This section provides examples of connections between a host in which Storage Navigator 
Modular has been installed and an array unit. 

When two or more LAN cards are installed in a Web server and a segment set in each LAN 
card is different from the others, the disk array subsystem can be accessed only from the 
LAN card managed by the Web server as a Local host. When accessing the disk array 
subsystem from the other segment, make the configuration that a router is used. Install one 
LAN card in the Web server to be installed. 

 

Array Unit 
(single system) 

10BaseT/100BaseT cable (cross) or twisted 

pair cable (cross) 

Hub

LAN

Web server

CTL1 

CTL0 

Array Unit 

(dual system) 

LAN 

LAN 

LAN 

LAN

Web client

 

Figure 2.1 LAN with a Hub 

Note: If an array unit is already connected with a LAN, a Web server is connected to the 
same network as the array unit. 

 

Array Unit

LAN 

LAN

Web server

10BaseT/100BaseT (cross) twisted pair cable
(cross)  

Figure 2.2 LAN without a Hub 
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2.4 Installing Storage Navigator Modular 

This section describes the following procedures to install Storage Navigator Modular: 

 Installing Storage Navigator Modular on the Web Server. 

 Installing the Java Plug-in on the Web client. 

 Ensuring that there are no conflicts with the firewall software or Web DAMP software. 

To upgrade an installed Storage Navigator Modular to version 6.00, see section 2.5. 

2.4.1 If Resource Manager 9500V/9520V for Web (Web DAMP) is Installed 

If Web DAMP is installed, Storage Navigator Modular does not recognize the subsystem unless 
you perform the following steps before you register the subsystem with Storage Navigator 
Modular. 

Perform the following to ensure that Storage Navigator Modular operates correctly when 
Web DAMP is installed: 

1. Install Storage Navigator Modular. See section 2.4.2. 

2. Copy the utlprm.inf file from the Web DAMP folder ( typically C:\Program Files\DA 
Manager Web) to the Storage Navigator Modular Web installation folder (typically 
C:\Program Files\Storage Navigator Modular Web). 

3. Start Storage Navigator Modular. See section 4.1.1.  

4. Enter Management Mode. 

5. From the Edit menu, select Modify.  

The Modify Array Unit window displays.  

6. Click OK. 

2.4.2 Installing Storage Navigator Modular on the Web Server  

Storage Navigator Modular is installed on a web server (see section 2.2 for compatible web 
servers). Before installing Storage Navigator Modular, ensure that the web server operates 
correctly. 

To install Storage Navigator Modular on the Web server: 

1. Start the Web server. See section 4.1.1. 

2. Boot up Windows. 

3. Execute SNM-xxxx-W-Web.exe in the stonavm_win directory of the provided CD. 

(The portion “xxxx” of file names varies with the version of Storage Navigator Modular, 
etc.) 

4. Register the location for installation with the Web server. 
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5. When running Storage Navigator Modular with HiCommand Device Manager, set the 
memory size (for details see Appendix B: Notes on Making Multiple Launches). 

2.4.3 Ensuring that Firewall Software does not Block Access to Storage Navigator Modular 

After installing Storage Navigator Modular on the web server, ensure that any firewall 
software on the web server computer does not block access to Storage Navigator Modular: 

 If you use Windows Firewall: Follow the procedure below for Windows Server 2003 (SP1) 
or Windows XP (SP2). 

 If you use other firewall software: Refer to your firewall documentation to ensure that 
access is permitted to the Storage Navigator Modular program, jre1.4.2\bin 
lient\snmsrv.exe. 

To set access to Storage Navigator Modular through the Windows Firewall: 

1. From the Control Panel, select Windows Firewall. 

The Windows Firewall dialog box displays. 

2. If the Windows Firewall setting is: 

– Off: The firewall will not interfere with Storage Navigator Modular. Close the 
firewall dialog box and discontinue this procedure. 

– On: Ensure that the Don’t allow exceptions option is not selected and continue with 
this procedure. 

3. Select the Exceptions tab. 

4. Click Add Program. 

5. Click Browse to navigate to and select the jre1.4.2\bin\client\snmsrv.exe file 
in the installation folder. The default location is C:\Program Files\Storage 
Navigator Modular Web\jre1.4.2\bin\client\snmsrv.exe. 

Note: If you experience Web server communication problems, you may also need to ensure 
that the firewall does not block the Web server application. 

2.4.4 Installing Java Plug-in on Web Client 

Install the Java Plug-in, which is included as part of the Java 2 Runtime Environment, 
Standard Edition (JRE). The plug-in uses applets in the client browser to communicate with 
Storage Navigator Modular on the web server. 

Note: Installing the Java Plug-in when a different version is already installed may cause 
operating problems with the Web client. If you experience such problems, uninstall the 
other version. 

To install the Java plug-in on a Windows web client:  

1. Start the Web client. See section 4.1.1.  

2. Boot Windows. 
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3. Run the j2re-1_4_2_07-windows-i586-p.exe that is bundled with the supplied CD.  

To install the Java plug-in on a Solaris web client: 

Install the j2re-1_4_2_07-solaris-sparc.sh that is bundled with the supplied CD. 

2.5 Upgrading the Storage Navigator Modular 

Before performing an upgrade, be sure to terminate Storage Navigator Modular. 

To upgrade the Storage Navigator Modular: 

1. On the Web server:  

a. Execute the SNM-xxxx-W-Web.exe in the stonavm_win directory of the provided 
CD-R. (The portion “xxxx” of file names varies with the version of Storage Navigator 
Modular, etc.) The updated Storage Navigator Modular can be run without restarting 
Web server. 

b. Ensure that any firewall software does not block access to Storage Navigator 
Modular. See section 2.4.3. 

2. On the Web client: Activate Storage Navigator Modular from the browser. See section 
4.1.1. 

2.6 Uninstalling Storage Navigator Modular 

To uninstall Storage Navigator Modular: 

1. On the Web server:  

a. From Control Panel, use Add or Remove Programs to uninstall Storage Navigator 
Modular. 

b. Delete the installation folder (typically C:\Program Files\Storage Navigator 
Modular Web).  

2. On the Web client: From Control Panel, use Add or Remove Programs to uninstall 
Java 2 Runtime Environment Standard Edition j2re-1.4.2_07. 
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Chapter 3 Functions 

This chapter includes the following: 

 3.1 Storage Navigator Modular Functions for AMS/WMS 

 3.2 Screens  

 3.3 Pop-Up (Right-Click) MenusPop-Up (Right-Click) Menus 
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3.1 Storage Navigator Modular Functions for AMS/WMS 

Table 3-1 lists the Storage Navigator Modular functions. The functions that are available 
varies, depending on the current Storage Navigator Modular operation mode: monitor mode 
[Normal] or management mode [Management]. The mode can be changed in the startup 
screen prior to connecting to the array unit. 

Table 3-1 Storage Navigator Modular Functions  

Mode Category Name of 
Function 

Outline of Function Remarks Usability 
During 
Operation Normal Mgmt 

Component 
status display 

Displays the status of a 
component, such as drive 
and fan, by using an icon. 

⎯ Yes Yes Yes Configuration 
display 

Property 
display 

Displays the status about 
system components of the 
subsystem, RAID, logical 
units, etc. 

⎯ Yes Yes Yes 

RAID group 
creation 

Adds a RAID group. You 
can set a new RAID group 
by specifying its disk 
number, RAID level, and 
group range for the RAID 
group to be created. 

⎯ Yes No Yes RAID group 
definition 

RAID group 
deletion 

Deletes a defined RAID 
group or a specified RAID 
group. 

Caution: This 
function 
invalidates user 
data of the deleted 
RAID group. 

No No Yes 

LU creation Used to add a logical unit 
(LU). A new logical unit is 
added by specifying its 
capacity. 

A logical unit can 
be added only in 
an order of lower 
to higher 
numbers.  

Yes No Yes 

LU formatting Makes a defined logical unit 
(LU) accessible by the host.  
This function writes null data 
to the specified logical unit. 

This operation is 
always required to 
make a logical unit 
accessible to the 
host. 
Caution: This 
function 
invalidates all user 
data on disks. 

No/Yes No Yes 

LU deletion Deletes the last defined 
logical unit (LU). 

Caution: This 
function 
invalidates user 
data on the 
deleted LU. 

No No Yes 

LU definition 

Change of 
default 
controller in 
charge of an 
LU 

Changes the default 
controller in charge of an 
logical unit (LU) as follows: 
CTL0 → CTL1 and 
CTL1 → CTL0 

⎯ Yes No Yes 
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Mode Category Name of 
Function 

Outline of Function Remarks Usability 
During 
Operation Normal Mgmt 

Parity 
Correction 

Restores the logical unit in 
which the parity error has 
occurred. 

⎯ Yes No Yes 

LU creation Creates logical units using a 
Wizard 

⎯ Yes No Yes 

Setting up 
spare disk 
drive 

Sets up spare disk drives. ⎯ Yes No Yes 

Differential 
Management 
LU 

Sets up the differential 
management LU 

⎯ Yes No Yes 

Command 
device 

Sets up the command 
devices 

⎯ Yes No Yes 

Setting the 
selection 

Setup and 
display of the 
priced optional 
features  

Opens and closes the priced 
optional features key, and 
sets and displays the 
enable/disable condition. 

⎯ Yes No Yes 

Setting the 
boot option 

Sets up the boot option. To make the 
setting valid, 
restart the 
subsystem. 

No No Yes 

Setting and 
display of the 
fibre-channel 
information 

Sets and displays port 
addresses and security 
information, etc. 

⎯ No No Yes 

System 
parameter 

Sets up the System 
parameters. 

⎯ Yes No Yes 

Port option Sets up the port options. ⎯ Yes No Yes 

Setting the 
drive 
restoration 
option 

Sets a drive restoration 
mode, automatic or non-
automatic start of copy-
back, and automatic or non-
automatic start of correction 
copy, time interval, restoring 
processing unit size, and 
Dynamic sparing mode. 

Optimum time 
interval and 
restoring 
processing unit 
are set before 
shipment.  
Do not change 
these values 
unless required; 
decreased 
performance could 
result. 

No No Yes 

Configuration 
setting 

On-line verify 
setting 

Sets execution or non-
execution of the on-line 
verify function and an 
interval for it. 

Note that an 
incautious change 
in the setting may 
decrease the level 
of performance. 

No No Yes 

Configuration 
setting 
(continued) 

LAN 
configuration 
information 
setting 

Sets the IP Address, Sub 
Net Mask, Default Gateway 
Address, and the DHCP 
mode. 

⎯ Yes No Yes 
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Mode Category Name of 
Function 

Outline of Function Remarks Usability 
During 
Operation Normal Mgmt 

Setup and 
display of RTC 

Sets and displays the date 
and time. 

⎯ Yes No Yes 

Configuration 
information file 
output and its 
setup by use of 
a file. 

Outputs system parameters 
and RAID group and logical 
unit configuration 
information to a file 
individually. 
Sets system parameters 
and RAID group and logical 
unit configuration 
information using a file. 

If system 
parameters are 
set using a file, 
restart the 
subsystem in 
order to validate 
the settings. 
When RAID/LU 
configuration 
information is set, 
if setting it with 
user data stored in 
the disk drive, the 
user data is set 
invalid. 

Yes Yes Yes 

Microprogram 
replacement 

Downloads and updates the 
microprogram of the 
subsystem. 

To validate the 
downloaded 
microprogram, 
restart the 
subsystem. 

No/Yes No Yes 

Statistical 
information 
display 

Controller use 
information 
display 

Displays previous statistical 
information by selecting a 
related item. 

⎯ Yes No Yes 

Performance Command 
operation 
status display 

Outputs the command 
operation status during a 
certain period or a specified 
period to the file in the text 
format. 

⎯ Yes Yes Yes 

Error monitoring Report when a 
failure occurs 
and controller 
status display 

Displays the status of the 
subsystem, and displays the 
result of monitoring it by 
polling. 
When an error is detected 
while monitoring, outputs 
the error into a log file, 
sends it to a specified 
address by E-Mail, and 
starts a specified 
application.  

If a failure occurs, 
contact 
maintenance 
personnel. 

Yes Yes Yes 
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3.2 Screens 

The Storage Navigator Modular operations screen consists of three screens, dialog boxes, and 
error messages. This section describes the configurations of the three screens. 

When you start Storage Navigator Modular, the Main screen displays. The Main screen of 
Storage Navigator Modular is located within the browser. 

Task bar

Menu bar

Tree view box

List view box

Status bar

Tool bar

 

Figure 3.1 Storage Navigator Modular Main Screen 

This screen includes the task bar, the menu bar, the tool bar, two view boxes, and the 
status bar; this is similar to other Windows applications. 

Displayed in the tree view box are group names that have been registered. Displayed in the 
list view box are array unit names that have been registered in a group. 

Double-clicking + Group + enables you to fold a group into its icon and display the group. 

Clicking a group icon displays only the array units that have been registered in that specific 
group. Clicking + Group + displays all array units that have been registered. 

When you double-click a registered array unit name, an Array Unit screen displays. On the 
Array Unit screen, the status of the array unit system components and configuration 
information of logical units, etc. displays selectively by switching the tab. For example, the 
following screen displays a connection with an AMS500 subsystem. 



18 Chapter 3 Functions 

 

Figure 3.2 Component Status Tab (AMS500 shown) 

3.2.1 Menu and Tool Bars 

The following sections contain examples of the various icons and objects that display on the 
Main screen, the Array Unit screen, and the Status Bars. 

3.2.1.1 Main Screen 

File: 

Menu Toolbar Function 

Open 
 

Displays the Unit screen. 

Reboot ⎯ Reboot the subsystem. 
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Edit: 

Menu Toolbar Function 

Add 
 

Registers the subsystem. 

Add Automatically ⎯ Registers the subsystem automatically. 

Modify ⎯ Changes the registration contents of the subsystem. 

Delete 
 

Deletes the registration of the subsystem, which is registered in the 
Storage Navigator Modular. 

Monitoring ⎯ Sets the Monitoring Enable or Disable. 

View: 

Menu Toolbar Function 

Icon 
 

Displays the property of the subsystem by an icon. 

Detail 
 

Displays the property of the subsystem in detail. 

Refresh ⎯ Checks the status of the subsystem. 

Tool: 

Menu Toolbar Function 

Operation Mode Change 
 

Changes the active mode. 

 Set Password ⎯ Sets the password. 

Error Monitoring Execution 
 

Executes the error monitoring. 

 Scheduled Execution ⎯ Starts the error monitoring. 

 Stop ⎯ Stops the error monitoring. 

 Options 
 

Displays the Monitoring Options screen. 

 Account ⎯ Registers the failure monitoring account. 

User Regist/Delete ⎯ Registers or deletes the users who login Storage 
Navigator Modular. 

Help: 

Menu Toolbar Function 

Version ⎯ Displays the revision of the Storage Navigator Modular. 
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3.2.1.2 The Unit Screen 

Mode: 

Menu Toolbar Function 

Exit 
 

Terminates the Array Unit screen. 

View: 

Menu Toolbar Function 

Properties ⎯ Displays the property of the subsystem. 

Drive Configuration ⎯ Displays the drive configuration of the subsystem. 

Refresh 
 

Refreshes the Array Unit screen. 

Settings: 

Menu Toolbar Function 

RAID Group Create 
 

Displays the RAID group settings screen. 

 Delete ⎯ Delete specified RAID group. 

Logical Unit Create 
 

Displays the logical unit settings screen. 

 Format 
 

Formats the logical unit (Max. 6). 

 Change Default Controller ⎯ Changes default controller of the logical unit. 

 Parity Correction ⎯ Corrects the logical unit parity. 

 Delete ⎯ Deletes specified logical unit. 

Tools: 

Menu Toolbar Function 

Wizard 
 

Starts the logical unit wizard. 

Configuration Settings 
 

Displays the configuration settings screen. 

Mapping Guard ⎯ Display the LU mapping guard settings screen. 

Performance Output File 
 

Outputs the performance of the subsystem. 

Settings ⎯ Sets the collection of performance statistics. 

Statistical Information 
 

Displays the statistics information of the subsystem. 

Information Message ⎯ Displays the information message of the subsystem. 

Tuning Parameter ⎯ Displays the tuning parameter screen. 
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3.2.2 Status Bars 

Table 3-2 lists the status bars that are described throughout this User’s Guide. 

Table 3-2 Status Bar Descriptions 

Status Bar Description 

 
Error Monitoring is stopped. 

 
Error Monitoring is running. 

 
Error Monitoring in the interval. 

3.3 Pop-Up (Right-Click) Menus 

The pop-up menus are context-sensitive and display when you click the right the mouse 
button on the Main screen or Array Unit screen (Logical Status tab). 

3.3.1 Pop-up Menus on Main Screen 

Figure 3.3 shows the pop-up menu that displays when you select a disk array subsystem on 
the Main screen.  
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Figure 3.3 Pop-up Menu on Main Screen: Disk Array Subsystem Selected 

Table 3-3 describes the Figure 3.3 pop-up menu options. 

Table 3-3 Pop-up Menu Options on Main Screen: Disk Array Subsystem Selected 

Selection Menu Option Function 

Open Displays the Unit screen. 

Modify Changes the registration contents of the subsystem. 

Delete Deletes the registration of the subsystem registered in the Storage Navigator 
Modular. 

Monitoring Sets the Monitoring Enable or Disable. 

Add Registers the subsystem. 

View Sets the view mode. 

Disk array subsystem icon 

Refresh Checks the status of the subsystem. 
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Figure 3.4 shows the pop-up menu that displays when nothing is selected on the Main screen 

 

Figure 3.4 Pop-up Menu on Main Screen: No Selection 

Table 3-4 describes the Figure 3.4 pop-up menu options. 

Table 3-4 Pop-up Menu Options on Main Screen: No Selection 

Selection Menu Option Function 

Add Registers a new subsystem. 

View Sets the view mode. 

None (List view box with 
nothing selected) 

Refresh Checks the status of the subsystem, and refreshes the screen. 

3.3.2 Pop-up Menus on Array Unit Screen 

Figure 3.5 shows the pop-up menu that displays when a RAID group number is selected on 
the Array Unit screen.  
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Figure 3.5 Pop-up Menu on Array Unit Screen: RAID Group Number Selected 

Table 3-5 describes the Figure 3.5 pop-up menu options. 

Table 3-5 Pop-up Menu Options on Array Unit Screen: RAID Group Number Selected 

Selection Menu Option Function 

Create New Logical Unit Displays the property dialog box for creating a new logical 
unit. 

Display Drive Configuration Displays the drive configuration of the subsystem. 

Delete Deletes the selected RAID group. 

RAID group number icon 

Properties Displays the property of the RAID group. 

Figure 3.6 shows the pop-up menu that displays when RAID Groups is selected on the Array 
Unit screen. 
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Figure 3.6 Pop-up Menu on Array Unit Screen: RAID Groups Selected 

Table 3-6 describes the Figure 3.6 pop-up menu option. 

Table 3-6 Pop-up Menu Options on Unit Screen: RAID Groups Selected 

Selection Menu Option Function 

RAID Groups Create New RAID Group Displays the RAID group settings screen. 

Figure 3.7 shows the pop-up menu that displays when one logical unit icon is selected on the 
Array Unit screen. 



26 Chapter 3 Functions 

 

Figure 3.7 Pop-up Menu on Array Unit Screen: One Logical Unit Selected 

Table 3-7 describes the Figure 3.7 pop-up menu options. 

Table 3-7 Pop-up Menu Options on Array Unit Screen: One Logical Unit Selected 

Selection Menu Option Function 

Format Format the logical unit. 

Change Default Controller Change default controller of logical unit. 

Parity Correction Correct the logical unit parity. 

Delete Delete the selected logical unit. 

Logical unit icon (one) 

Properties Display the property of the logical unit. 

Figure 3.8 shows the pop-up menu that displays when multiple logical unit icons are selected 
on the Array Unit screen.  
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Figure 3.8 Pop-up Menu on Array Unit Screen: Multiple Logical Units Selected 

Table 3-8 describes the Figure 3.8 pop-up menu options. 

Table 3-8 Pop-up Menu Options on Array Unit Screen: Multiple Logical Units Selected 

Selection Menu Option Function 

Format Format the logical units (maximum 6). 

Parity Correction Correct the logical unit parity. 

Logical unit icons (two or 
more) 

Delete Delete the selected logical units. 
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Figure 3.9 shows the pop-up menu that displays when a drive icon is selected on the Array 
Unit screen. 

 

Figure 3.9 Pop-up Menu on Array Unit Screen: Drive Selected 

Table 3-9 describes the pop-up menu option in Figure 3.9.  

Table 3-9 Pop-up Menu Options on Array Unit Screen: Drive Selected 

Selection Menu Option Function 

Drive icon Display Drive 
Configuration 

Display the drive configuration of an array unit. 
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Chapter 4 Operating the Storage Navigator Modular GUI 

The Storage Navigator Modular GUI displays the status of array units, sets up the 
configuration of array units, and monitors array units for errors. 

The operations in this chapter can be used for Windows. 

This chapter includes the following: 

 4.1 Basic Operations 

 4.2 Main Screen and Array Unit Screen Properties 
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4.1 Basic Operations 

This section describes the following basic operations: 

 Starting 

 Password Setting 

 Changing the Operation Mode 

 Registering an Array Unit 

 Version Display 

 Terminating 

 Restarting an Array Unit 

The operation of these functions conforms to Windows. 

When changing the TCP/IP port number of the disk array subsystem (see Table 4-1), that is 
connected over a LAN, register the changed port number as “df-damp-snm port 
number/TCP”. Before starting Web Navigator, you must register the changed port number in 
the services file of the OS on which Web Navigator is installed. If it is not registered, the 
disk array subsystem may not be able to be connected to the LAN. 

Table 4-1 Registering a Changed TCP/IP Port Number 
Disk Array Subsystem Microprogram Version 

AMS500/AMS200/WMS100 0726/E or later 

9500V/9520V x65B/H or later 

 

4.1.1 Starting 

To start the Storage Navigator Modular, use the appropriate procedure.  

 Web Server 

 Web Client 

Web Server 

1. Set the directory in which Storage Navigator Modular is installed as a virtual directory. 
Complete the setting of the virtual directory from the Internet Service Manager of the 
IIS. For setting the virtual directory, refer to Windows Help. 

2. Verify through Control Panel → Administrative Tools → Services whether Web  
Navigator (SNM Server) has started. 

Start the SNM Server if it has not started. 
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Web Client 

 Activate the browser and specify the URL as follows. See Figure 4.1. 

 Example: http//############/web_nav/ 

The URL of Web Navigator
A virtual directory of Web 
Navigator prepared in the 
Web server. 

IP address or host name of 
Web server 

 

Figure 4.1 Specify URL 

For the URL, specify a host name or IP address of Storage Navigator Modular. Do not 
specify a loop back address such as localhost and 127.0.0.1. 

The window for activating the applet displays. 

Note: When Storage Navigator Modular is used on Windows, an error may occur in which the 
menu display is disabled by a menu bar operation with the mouse. If this occurs, disable the 
pointer tail or the pointer shadow in Mouse properties in the Control Panel. 

If the menu display has not recovered, disable the Scheme for the Pointers tab in the 
Mouse properties. 

Erroneous settings may disable the display menu. If the menu display remains disabled, set 
the value to 65536 or less for the Color pallet properties in the Display. 
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Operating the Web Client 

1. In the Storage Navigator Modular screen, select Click here to log on. See Figure 4.2. 

 

Figure 4.2 Storage Navigator Modular Log in Window 

The logon screen displays. 

2. Enter your logon information and click LOGIN. 

For the initial default logon after installation, enter the following: 

– User ID: tempuser 

– Password: 12mak7si 
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Storage Navigator Modular starts in Normal Mode and the Main screen displays. See 
Figure 4.3. 

 

Figure 4.3 Storage Navigator Modular Web Main Window 

The following functions are performed from the Main screen: 

– Registering the array unit (Register, Delete, Change, and Refer of the property). 

– Executing error monitoring and setting error monitoring option. 

– Changing the operation mode. 

– Setting and changing the password for logging on to Management Mode. 

– Displaying the version. 

Note: When Storage Navigator Modular is first started, the change mode function is 
disabled. To enable the change mode, register the password. See section 4.1.2. 

3. Click the icon of an array unit on the Main screen. 
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4. From the File menu, click Open or click (  ). This operation can also be done from 
the context menu of the subsystem icon. 

The Array Unit screen of the subsystem displays. See Figure 4.4. 

 

Figure 4.4 Array System Viewer – Array Unit 

The following functions are performed in the Array Unit screen: 

– Displaying the status of the array unit. See section 4.2.2. 

– Displaying and defining the RAID/logical unit. See section 5.1. 

– Displaying and defining the configuration information (the setting of spare drives). 
See Chapter 6. 

– Setting system parameters. See section 9.6. 

4.1.2 Registering and Deleting Users 

Use the following procedure to register the users who log on to Storage Navigator Modular or 
to delete users who are registered: 

1. On the Tool menu, click User Regist/Delete. 

2. Enter the User ID and Password using four to eight alphanumeric characters (0 to 9, a to 
z, and/or A to Z), then click Add.  

Up to 20 users can be registered. See Figure 4.5. 
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Figure 4.5 User Information Dialog Box 

When deleting a registered user, enter the registered information User ID and Password 
and click Delete. You need to have at least one registered user. you cannot delete the 
last user. 

3. When the confirmation message displays, click OK. 

Note: When using Storage Navigator Modular, delete the temporary user ID and password 
after you register a new user. 

4.1.3 Automatic Log-off 

If the Web Server is not accessed within 20 minutes when Storage Navigator Modular is used 
by the Web client, a log-off will occur automatically. 

Access from Storage Navigator Modular to the Web server occurs when performing operations 
such as setting configurations. Changing displayed contents, such as changing the selected 
Tab key of the Array Unit screen, do not initiate an automatic log-off. 

When an automatic log-off occurs, a message displays informing you that the Web server 
cannot be connected because an automatic log-off was caused by the operation. When the 
message displays, log on again after shutting down Storage Navigator Modular completely. 

An automatic log-off occurs when a secondary screen, such as the Configuration Setting 
screen and System Parameters Wizard screen, is opened after the Main and Array Unit 
screens. The secondary screen returns after the message displays. When this occurs, quit 
Storage Navigator Modular completely after closing the secondary screen by clicking Cancel 
or Close. 

4.1.4 Setting Passwords 

To set a password when using Storage Navigator Modular in Management mode: 

To Enter or Change a Password: 

1. From the Tool menu of Storage Navigator Modular Web, select Operation Mode  Set 
Password. 

2. Enter the password information. Passwords may have up to 12 alphanumeric characters. 

3. Click OK.  
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To Delete a Password: 

Note: To delete a password, Storage Navigator Modular must be uninstalled and reinstalled. 

1. Delete the directory where Storage Navigator Modular is installed. 

Note: To save the information of the registered array unit, back up the utlprm.inf and 
utlprm2.inf files in the directory where Storage Navigator Modular is installed. 

2. Create a directory with the same path and the same name as those of the directory 
deleted in step 1. 

3. Re-install Storage Navigator Modular. 

Note: When the utlprm.inf and utlprm2.inf files have been backed up in step 1, copy 
these files to the directory created in step 2. 

4.1.5 Changing Operation Mode 

Storage Navigator Modular is provided with two operation modes: Normal mode and 
Management mode. In Normal mode, both array unit configuration and status are displayed. 
In Management mode, the array unit configuration can be set in addition to Normal mode 
functions. 

Change the operation mode in accordance with the operation of the array unit. 

Changing from Normal Mode to Management Mode 

Change the operation mode from Normal mode to Management mode. When logging-in is 
performed in Normal Mode, Normal mode displays in Operation mode in the upper part of 
the Main screen. 

1. From the Tool menu of Storage Navigator Modular Web, select Operation Mode  
Change, or click . 

2. When the password-input screen displays, enter a password and click OK. See Figure 4.6. 

 

Figure 4.6 User Mode Change 

Management mode displays in Operation Mode in the upper part of the Main screen. 
Storage Navigator Modular operates in Management mode. 



 Hitachi TagmaStore AMS and WMS Storage Navigator Modular for Web User’s Guide 37 

Changing from Management Mode to Normal Mode 

You can change the operation mode from Management mode to Normal mode. Logging in is 
performed in Management Mode. Management Mode displays in Operation Mode (it displays 
in the upper part of the Main screen). 

1. On the Tool menu, select Operation Mode  Change, or click . 

2. When the confirmation message displays, click OK. 

Normal mode displays in Operation mode in the upper part of the Main screen. Storage 
Navigator Modular operates in Normal mode. 

4.1.6 Registering Subsystem 

To operate the array unit from Storage Navigator Modular, register the subsystem. You 
cannot register a subsystem that does not exist. 

New Automatic Registration 

1. On the Edit menu of Storage Navigator Modular Web, select Add Automatically. You can 
also complete this operation from the context menu of the list view box. The Add Array 
Unit Automatically window displays. See Figure 4.7. 

 

Figure 4.7 Add Array Unit Automatically 

2. Enter the IP addresses in the From: and To: boxes of IP Address to Search of the Search 
Array Unit and click Start. 

The window displays the available IP addresses. See Figure 4.8. 
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Figure 4.8 Add Array Unit Automatically - IP Address 

3. Under Search Results, select one or more names to register and click . 

The selected subsystems are moved from the Search Results list to the Array Units to 
Add list of the Add Array Unit. See Figure 4.9. 

 

Figure 4.9 Add Array Unit Automatically - Search Results 

4. Click OK. 

5. When the confirmation message displays, click OK. 
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6. The Result screen shows that subsystems are added. Click Close. See Figure 4.10. 

 

Figure 4.10 Result Window 

The updated Main screen displays, as illustrated in Figure 4.3. 

New Registration 

1. On the Edit menu of Storage Navigator Modular Web Main window, select Add, or click 
. You can also complete this operation from the context menu of the list view box. 

2. The TCP/IP simple connection dialog displays. Input the IP address of controller 0 and/or 
controller 1, and click OK or Detail. See Figure 4.11. 

 

Figure 4.11 Add Array Unit 
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3. Enter the registration information and click OK. See Figure 4.12. 

 

Figure 4.12 Add Array Unit - Registration 

– Connection: TCP/IP(LAN) 

– IP Address or Host Name: Specify the connection information of controller 0/1. 
Specify IP Address or Host Name. 

– Name: Registered name of the subsystem. Specify up to 16 alphanumeric characters 
or characters (-, _, @, ., space code). 

– Group: Group name when the subsystems are controlled as a group. Specify the 
group name using up to 16 alphanumeric characters or characters (-, _). When the 
subsystems are controlled as a group, input its name. If not, it is not necessary to 
input the name. The maximum registered number of groups is 200. 

– Error Monitoring: Specify whether or not to perform error monitoring. 

– Check (ON display): Error monitoring. 

– No check (OFF display): No error monitoring. 

Note: In the subsystem in a dual system, only one controller can be used in the LAN 
connection mode. Specify IP Address/Host Name for the connected controller side only. 
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4. When the registration completion Message dialog box displays, click OK. See Figure 4.13. 

 

Figure 4.13 Message Window 

The updated Storage Navigator Modular Web Main window displays as shown in Figure 
4.3. 

When you input Group, the subsystem icon displays in the frame enclosed with the input 
group.   

 
Dual system 

 

Single system 
 

Figure 4.14 Subsystem Icons 

Changing Registration Contents 

To change the registration contents of array units registered in Storage Navigator Modular: 

1. Click the icon of the subsystem on the Main screen of the Storage Navigator Modular. On 
the Edit menu, select Modify. 

You can also complete this operation from the context menu of the disk array subsystem 
icon. 

2. Change the registration contents and click OK. See Figure 4.15. 
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Figure 4.15 Modify Array Unit 

3. Click OK to continue through the confirmation messages. The updated Main screen 
displays. 

Deleting Registration 

To delete the registration of an array unit that is registered in Storage Navigator Modular. 

1. Click the icon of an array unit on the Main screen of the Storage Navigator Modular. On 
the Edit menu, select Delete or click  in the tool bar. You can also complete this 
operation from the context menu of the disk array subsystem icon. 

2. When a message displays confirming whether the registration should be deleted, click 
OK. 

3. The Result screen displays. Click Close. See Figure 4.16. 
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Figure 4.16 Result Window  

The updated Main screen displays. 

Displaying Registration Contents 

To display the registration contents of the subsystem that is registered in Storage Navigator 
Modular: 

1. Click the icon of the subsystem on the Main screen of the Storage Navigator Modular. On 
the Edit menu, select Delete. Or click  in the tool bar. You can also complete this 
operation from the context menu of the subsystem icon. 

2. Click OK to acknowledge the confirmation deletion message. 

3. The Result screen displays. Click Close. 

The updated Main screen displays. 

4.1.7 Version Display 

To display the version of Storage Navigator Modular: 

On the Help menu, select Version. The Storage Navigator Modular version displays. 

4.1.8 Terminating Storage Navigator Modular 

To terminate Storage Navigator Modular when the Array Unit screen is open, close it and 
terminate Storage Navigator Modular:  

1. Click  on the Main screen. 

2. Click  on the Applet screen. 

The Main screen closes and Storage Navigator Modular is terminated. When you run the Web 
server, close the prompt screen. 
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4.1.9 Restarting Subsystem 

WARNING: Rebooting requires stopping I/O from the host.  

WARNING: If you are using TrueCopy or TrueCopy Extended Distance and you are required to 
reboot the subsystem, change the pair status to PSUS before you reboot. 

WARNING: If you are using a NAS, you must also stop the clusters between NAS units. When 
restarting the subsystem, you must restart the clusters. 

To restart the subsystem: 

1. Click the icon of an array unit on the Main screen of the Storage Navigator Modular.  

2. On the File menu on Storage Navigator Modular Web Main window, select Reboot. 

3. Click OK, as needed, to acknowledge the restart confirmation messages. 

4. When restarting an array unit, the restart time displays. Restarting takes approximately 
4 to 15 minutes. 

Note: It may take time for an array unit to respond, depending on the condition of the 
array unit. If it does not respond after 15 minutes, check the condition of the array unit. 

5. A message displays indicating that restart has terminated. Click OK. 
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4.2 Main Screen and Array Unit Screen Properties 

This section describes the Main screen and Array Unit screen properties. 

4.2.1 Displaying Main Screen Property 

Display the array unit status and information by using icons. 

Array Unit Status 

 ,     Gray 
 Initial Main screen when starting Storage Navigator Modular. 
 Out of error monitoring. 

 ,   Gray +  Blue 
 Normal 

 ,   Gray + Yellow 
 Warning 

 ,   Gray 
 Subsystem is system down. 
 Subsystem is power off. 
 Error in communication with the subsystem. 

4.2.2 Displaying Status and Properties of Subsystem and Components 

To show the properties and status of subsystem components on the Storage Navigator 
Modular: 

On the File menu, select Open, or click . The subsystem component status displays. 
See Figure 4.17. 
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Figure 4.17 Array System View 

 To update the component display, on the View menu, select Refresh or click . 

 To display component status and properties, select the component in the Component 
Status tab. 

 To display the properties of the subsystem, on the View menu, select Properties. The 
Property screen displays the following information. See Figure 4.18. 
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Figure 4.18 Property – Array Unit 

– Array Unit Type: Subsystem type 

– Construction: Subsystem configuration type 

– Serial Number: Subsystem serial number 

– Microprogram Revision: Subsystem microprogram revision 

– Controller Number 

– IP Address: IP address of each controller 

– Subnet Mask: Subnet Mask of each controller 

– Default Gateway: Default gateway of each controller 

4.2.3 Displaying Array Unit Configuration Information 

To display array unit configuration information on the Storage Navigator Modular: 

1. Click an array unit icon on the Array Unit screen. On the Tools menu of the Array 
System Viewer window, select Configuration Settings or click . 

2. Click the LAN tab. 

The LAN configuration displays the information that is validated in the subsystem. See 
Figure 4.19. 
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Figure 4.19 Configuration Settings - LAN panel 

4.2.4 Displaying an Information Message 

To display the Information Message dialog box, see Figure 4.20. 

Click a patrol lamp icon ( ) in the Array Unit Screen. 

 

Figure 4.20 Information Message 
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– Controller 0/1 Common: After the array unit starts, the fault information and status 
information displays in the Controller 0/1 Common box. 

– Controller 0: As the array unit starts, the fault information and status information 
displays in the box of Controller 0. 

– Controller 1: As the array unit starts, the fault information and status information 
displays in the box of Controller 1. 
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Chapter 5 Definition of RAID Group/Logical Unit 

The Storage Navigator Modular Graphical User Interface (GUI) can be used to set and delete 
the RAID group. Additionally, the logical unit can be created and deleted. 

In Monitor mode, the current definition information is displayed, but no button for the 
definition is displayed. 

This chapter includes the following sections: 

 5.1 Displaying RAID Group/Logical Unit Definition  

 5.2 Creating a RAID Group Automatically 

 5.3 Creating a RAID Group Manually 

 5.4 Deleting a Specified RAID Group  

 5.5 Constituting a Logical Unit Automatically 

 5.6 Constituting a Logical Unit Manually 

 5.7 Formatting a Logical Unit 

 5.8 Deleting a Specified Logical Unit 

 5.9 Changing Default Controller in Charge of a Logical Unit  

 5.10 Parity Correction 
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5.1 Displaying RAID Group/Logical Unit Definition 

1. Click the Logical Status tab on the Logical Units panel. 

 

Figure 5.1 Array System Viewer - Logical Units 

Figure 5.1 displays the definition information of all RAID groups and all logical units 
defined in the array unit: 

– RAID Groups: Information about all RAID groups defined for an array unit displays 
for each RAID group. 

– Logical Units: Information about all logical unit number (LUN) defined for an array 
unit displays for each LUN. 

2. To display the relation of the RAID group that defines the logical unit and a drive, select 
Drive Configuration on the View menu. 

The Drive Configuration dialog displays. 
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3. When you click the RAID group number icon, the RAID level is highlighted on the icon for 
the drive that composes the RAID group. Figure 5.2 shows a modified layout. The 
displayed RAID level overlaps the icon. 

 

Figure 5.2 Array System Viewer - Drive Configuration 
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5.2 Creating a RAID Group Automatically 

To create a new RAID group by selecting the drives automatically: 

1. Click the Logical Status tab on the Array Unit screen. 

2. On the Settings menu of the Array System Viewer, select RAID Group, then click 
Create, or click . 

You can also complete this operation from the context menu of the RAID Groups icon. 

The Create RAID Group dialog displays. See Figure 5.3. 

 

Figure 5.3 Create RAID Group Dialog Box 

3. Select and/or enter a RAID Level and Drive Configuration which includes the Drive 
Type, Drive Capacity, Combination, and Parity Groups, then click OK. 

4. Click OK as needed to continue and to respond to the confirmation messages. 

Clicking OK updates the set RAID group and displays Figure 5.4. 
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Figure 5.4 Array System Viewer - Array Unit 

5.3 Creating a RAID Group Manually 

To create a new RAID group by selecting the drives manually: 

1. Click the Logical Status tab on the Array Unit screen. See Figure 5.5. 

2. On the Settings menu of the Array System Viewer, select RAID Group, and then click 
Create or click . 

You can also complete this operation from the context menu of the RAID Groups icon. 
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Figure 5.5 Array System Viewer - RAID Group 

3. Enter the settings in the Create RAID Group dialog box. See Figure 5.6. 

 

Figure 5.6 Create RAID Group Dialog Box 
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4. In Drives, in the Select Drives dialog box,  select the Manual Selection option, and click 
Select. See Figure 5.6. 

The Select Drives dialog displays. See Figure 5.7. 

 

Figure 5.7 Select Drives Dialog Box 

5. In Available Drives list, click the HDU number. See Figure 5.7. 

6. Click the HDU number to compose a RAID group, keeping the Shift key pressed. See 
Figure 5.8. 

7. Click . 
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Figure 5.8 Select Drives 

8. Click OK as needed to continue and to respond to messages.  

Clicking OK updates the set RAID group and displays Figure 5.9. 

 

 

Figure 5.9 Array System Viewer - Array Unit 
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5.4 Deleting a Specified RAID Group 

To delete a specified RAID group from set RAID groups: 

1. Click the Logical Status tab on the Array Unit screen. 

2. Click the icon of a RAID group on the Array Unit screen.  

To delete more than one RAID group, select additional groups while pressing the Shift 
key. 

3. On the Settings menu of the Array System Viewer, select RAID Group and click Delete. 
See Figure 5.10. 

 

Figure 5.10 Array System Viewer - RAID Group 

4. To continue through warning or status messages, click OK or Close. 

Note: If a logical unit is defined in the RAID group, all of the user data is invalidated by 
deleting the RAID group. 

If a logical unit is defined in the specified RAID group, this RAID group cannot be 
deleted, depending on the disk array subsystem. To delete the specified RAID group, 
first delete all logical units in the specified RAID group, and then delete the RAID group. 
This updates the deleted RAID group and displays Figure 5.11 . 
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Figure 5.11 Array System Viewer – Array Unit 

5.5 Constituting a Logical Unit Automatically 

1. Click the Logical Status tab on the Array Unit screen. 

2. Click the icon of the desired RAID group to create a logical unit.  

3. On the Settings menu, select Logical Unit and click Create, or click . See Figure 
5.12. 

You can also complete this operation from the context menu of the RAID group number 
icon. 
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Figure 5.12 Array System  Viewer - Logical Unit 

The Create Logical Unit menu displays. See Figure 5.13. 

 

 

Figure 5.13 Create Logical Unit Dialog Box 

4. Select a Logical Unit No., Default Controller, and input Size. 

A created logical unit number displays the Logical Unit No. and RAID group number and 
displays the logical units that are defined for the RAID Group. Additionally, a logical 
unit capacity that can be created displays: 

– Specify Number of Block, MB, or GB Increased. 
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To specify a value clearly, specify the allocation (number of blocks, MBs, or GBs). 
When you allocate all of the remaining capacity of the designated RAID group, 
specify a capacity displayed on the screen. 

Notes:  

• When the capacity of a logical unit is specified by GB or MB and the capacity 
is specified as the rightmost value of the slider, a logical unit with the whole 
free capacity of the RAID group to which the logical unit belongs is created. 
When a fractional capacity is included in the free capacity, a logical unit 
with a capacity that includes it is created. (You can see whether the free 
capacity has a fractional portion by viewing the Free Capacity field.) When 
you want to create a logical unit that does not have a fractional capacity, 
specify the logical unit using the other unit. 

• The relation between MB and blocks is: 1 MB = 2,048 blocks. A fraction less 
than 2,048 blocks is omitted. The relationship between GB and MB is 1 GB = 
1,024 MB. A fraction less than 1,023 MB is omitted. 

Example: 2,048,000 blocks = 1,000 MB 
  2,049,024 blocks = 1,000 MB 

– Specify the Controller No. 

Select Controller 0 or Controller 1 to select the controller in charge of the logical 
unit. If you select the wrong controller, the logical unit can unexpectedly switch 
during operation. Performance quality may deteriorate as a result. 

This is necessary with a dual system connection. It is not displayed with a single 
system connection. 

Note:  When dual active mode is selected in the dual system, the controller in 
charge of a logical unit must be selected to set up the logical unit. Perform the 
logical unit setting, including the selection of the controller that is referred to in 
Figure 5.14. When you change a controller in charge of the logical unit, see section 
5.9. 
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Example: 

 

Dual system 

(Dual Active Mode) 

HOST#1HOST#0 

Abnormal
(Switching by 
the host is 
required) 

Normal

LU1 LU0 

CTL#0 CTL#1

 

Figure 5.14 Dual Active Mode 

– Dual Active Mode: Select a controller to access from the host to the logical unit as 
the controller for the logical unit. 

In Figure 5.14, CTL#0 is in charge of logical unit0 and CTL#1 is in charge of logical 
unit1. In this example, set up the logical unit by selecting optional button CTL#0 to 
select logical unit0 and button CTL#1 to select logical unit1 respectively. 

5. After setting logical unit information, click OK. 
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6. A message displays stating that the setting is complete. Click OK. 

Clicking OK updates the logical unit information, and then Figure 5.15 displays. 

 

Figure 5.15 Array Unit Logical Unit 

5.6 Constituting a Logical Unit Manually 

1. Click the Logical Status tab on the Array Unit screen. See Figure 5.16. 

2. Click the icon of the desired RAID group to create a logical unit.  

3. On the Settings menu, select Logical Unit and click Create, or click . See Figure 
5.16. 

This operation can also be completed from the context menu of the RAID group number 
icon. 



 Hitachi TagmaStore AMS and WMS Storage Navigator Modular for Web User’s Guide 65 

 

Figure 5.16 Array Unit - Create Logical Unit 

The Create Logical Unit screen displays. See Figure 5.17. 

 

Figure 5.17 Create Logical Unit 
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4. Click Detail. 

5. Select a Logical Unit No., a Default Controller, and the input Size. Click Select. See 
Figure 5.18. 

 

Figure 5.18 Select Area Dialog Box 

6. Select Area and No. and then click OK. 

7. In the Create Logical Unit dialog box, click OK. 

8. Click OK to confirm the confirmation messages. 

Clicking OK updates the logical unit information and displays Figure 5.19. 

 

Figure 5.19 Array Unit – Logical Unit 
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5.7 Formatting a Logical Unit 

To format the logical unit: 

 Format: If multiple logical units are specified, up to six logical units are formatted 
concurrently. A host I/O can be received even when formatting logical units. 

1. Click the Logical Status tab on the Array Unit screen. 

2. Click the logical unit icon on the Array Unit screen. On the context menu of the logical 
unit icon, select Format. See Figure 5.20. 

When you select multiple logical units, hold down the Ctrl key and click the icons of the 
logical units you want to format. 

 

Figure 5.20 Logical Unit - Format 

Note: The formatting may be interrupted during the following conditions: 

– A host is rebooting 

– I/O path switching 

– Access to a logical unit of the non-ownership controller 

3. To continue through warning and confirmation messages, click OK.  

This updates the formatted logical unit information and displays Figure 5.21. 
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Figure 5.21 Logical Unit Information 

5.8 Deleting a Specified Logical Unit 

To delete a specified logical unit: 

1. Click the Logical Status tab on the Array Unit screen. See Figure 5.22. 

2. Click the logical unit icon on the Array Unit screen. On the context menu of the logical 
unit icon, select Delete. 

When you select multiple logical units, press the Ctrl key, and click the logical units 
icons that you want to delete. 
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Figure 5.22 Logical Unit - Delete 

3. To continue through confirmation and status messages, click OK and Close. 

The logical unit is deleted. 
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5.9 Changing Default Controller in Charge of a Logical Unit 

To change the default controller in charge of a logical unit: 

1. Click the Logical Status tab on the Array Unit screen. See Figure 5.23. 

2. Click the logical unit in the Array Unit screen. On the context menu of the logical unit 
icon, select Change Default Controller. 

 

Figure 5.23 Logical Units - Change Default Controller 

3. To continue through confirmation and status messages, click OK. 

4.  The default controller in charge of the logical unit is changed. 

Note: Switching the default controller owning the logical unit changes the default controller 
currently displayed. When the switching is executed twice, the specified controller is 
changed to the original default controller that is controlling the logical unit. 
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5.10 Parity Correction 

Restore the logical unit in which the parity error occurred. From the status of the logical 
unit, you can determine if a parity error has occurred. 

1. Click the Logical Status tab on the Array Unit screen. See Figure 5.24. 

2. Select the logical unit to which you want to correct parity. Select Logical Unit in the 
Settings menu, and then select Parity Correction. 

If the parity restoration displays in halftone, no parity error has occurred. 

 

Figure 5.24 Logical Unit – Parity Correction 
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To continue, click OK in the confirmation message. 

The unconnected logical units list displays. See Figure 5.25. 

 

To the top 

To the upper next line 

To the lower next line 

To the bottom 

To be delete 

 

Figure 5.25 Parity Correction Dialog Box 

3. Change the order of the restoration process, when necessary. 

(The logical unit listed at the top is processed first.) 

4. To continue, click Start, and then click OK. (Or to cancel, click Skip and click OK.) 

5. A message displays. Click OK. 

6. A message displays stating that the parity correction has started. Click OK. 

Storage Navigator Modular only directs the process being performed. The subsystem 
microprogram performs the specific operation. 
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Chapter 6 Configuring Array Unit 

This chapter includes the following: 

 6.1 Creating Logical Units by Wizard 

 6.2 Designating Spare Drives 

 6.3 Setting Differential Management LU 

 6.4 Setting Command Devices 

 6.5 Setting Optional Features 
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6.1 Creating Logical Units by Wizard 

To create logical units by wizard: 

1. On the Tools menu, select Wizard  Create Logical Units. 

On the Select Usage drop down list (see Figure 6.1), select logical unit usage. A dialog box 
displays where you can select the usage by setting the suitable parameter for Drive Type, 
RAID Level, and Parity. If you want to customize the parameter, click Customize and select 
Parameter to set the Drive Type, RAID Level, and Parity. See Table 6-1. 

 

 

 

Figure 6.1 Logical Unit Creation Wizard - Setup 
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Table 6-1 Usage for Logical Unit 

Usage Recommended RAID Configuration Drive Type 

Default 4D+1P FC/SATA 

Data Base 4D+1P FC 

File System 4D+1P FC 

Backup 8D+1P FC 

Archive 8D+1P SATA 

Archive2 8D+2P SATA 

Streaming 4D+1P SATA 

Digital Surveillance System 8D+1P FC 

High Performance Computing 4D+4D FC 

2. Specify the logical unit size, number of logical units, and port(s) to use. See Figure 6.1. 

3. Select Next. 

4. The specification contents display. See Figure 6.2. When the specification contents are 
no problem, click Confirm. If you want to modify the contents, click Back. 

 

Figure 6.2 Logical Unit Creation Wizard - Confirmation 

5. Click Done. The Logical Unit Creation Wizard Summary displays. See Figure 6.3. 
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Figure 6.3 Logical Unit Creation Wizard - Summary 

6.2 Designating Spare Drives 

To ensure maximum storage capacity, assign a spare drive in the subsystem. Any drive 
except a data drive can be assigned as spare. 

6.2.1 Designating Spare Drives 

To designate a spare drive: 

1. Click the Logical Status tab on the Array Unit screen. See Figure 6.4. 

2. Click the Spare Drives icon. 
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Figure 6.4 Array System Viewer - Spare Drives 

3. Click Set. The Spare Drives Settings dialog displays. See Figure 6.5. 

 

Figure 6.5 Spare Drives Settings Dialog Box 

4. In the Available Drives list, select the HDU number for the spare drives you want to set, 
and click . 

The selected HDU number moves to the Drives to Set list. See Figure 6.6. 



78 Chapter 6 Configuring Array Unit 

 

Figure 6.6 Spare Drives - Available Drives 

5. Click OK. 

6. Confirmation and status messages display To continue through the confirmation and 
status messages, click OK and Close. 

The setting information displays. See Figure 6.7. 

 

Figure 6.7 Array System Viewer 
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6.2.2 Releasing Spare Drive 

To release the spare drive: 

1. Click the Logical Status tab on the Array Unit screen. 

2. Click the Spare Drives icon. See Figure 6.8. 

 

Figure 6.8 Array System Viewer – Spare Drives 

3. Select the HDU number of the spare drives you want to release. Click Release.  
Confirmation and status messages display. To continue through the confirmation and 
status messages, click OK and Close. The setting information displays. 

6.3 Setting Differential Management LU 

When the Differential Management LU is not set, you can set it. The Differential 
Management LU is an exclusive logical unit for storing the differential data at the time when 
the volume is copied. The Differential Management LU in the disk subsystem is treated in the 
same way as the other logical units. However, a logical unit that is set as the Differential 
Management LU is not recognized by a host because it is hidden. 

The minimum logical unit size for the Differential Management LU is 5 GB. Up to the two 
Differential Management LUs can be set. The second Differential Management LU is used for 
the mirroring. 
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6.3.1 Setting Differential Management LU 

To set the Differential Management LU: 

1. Click the Logical Status tab on the Array Unit screen. See Figure 6.9. 

2. Click the Differential Management LU icon. 

 

Figure 6.9 Array System Viewer - Differential Management 

3. Click Set. 

The Select Logical Unit dialog box displays. See Figure 6.10. 

 

Figure 6.10 Select Logical Unit Dialog Box 

4. Select the LUN you want to set to the differential management LU, and click OK. 

5. Confirmation and status messages display. To continue through the confirmation and 
status messages, click OK. 
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The setting information displays. See Figure 6.11. 

 

Figure 6.11 Array System Viewer - Setting Information 

6.3.2 Releasing Differential Management LU 

To release the differential management LU: 

1. Click the Logical Status tab on the Array Unit screen. See Figure 6.12. 

2. Click the Differential Management LU icon.. 
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Figure 6.12 Array System Viewer - Differential Management 

3. Select the LUN you want to release to the differential management LU, and click 
Release. 

4. Confirmation and status messages display. To continue through the confirmation and 
status messages, click OK. 

The setting information displays. 

6.4 Setting Command Devices 

Two command devices can be designated for the subsystem. The Command Device LU size 
must be greater than or equal to 33 MB. 

6.4.1 Setting Command Devices 

1. Click the Logical Status tab on the Array Unit screen. See Figure 6.13. 

2. Click the Command Devices icon. 
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Figure 6.13 Array System Viewer - Command Devices 

3. Click Set. 

The Command Devices to Set dialog box displays. See Figure 6.14. 

 

Figure 6.14 Command Devices Window 

4. In the Available Logical Units list, select the LUN you want to set in the command 
devices, and click . See Figure 6.15. 

The selected LUN moves to the Command Devices to Set list. 
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Figure 6.15 Command Devices - Available Logical Units 

5. Click OK. 

6. A message displays. Click OK. 

The setting information displays. See Figure 6.16 

 

Figure 6.16 Array System Viewer - Setting Information 
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6.4.2 Changing Command Devices 

To change the command devices: 

1. Click the Logical Status tab on the Array Unit screen. See Figure 6.17. 

2. Click the Command Devices icon. 

 

Figure 6.17 Array System Viewer - Command Devices 

3. Select the Command Device number you want to change in the Command Device dialog 
box, and click Modify. 

The Modify Command Devices dialog box displays. See Figure 6.18. 
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Figure 6.18 Modify Command Devices Dialog Box 

4. In the RAID Manager Protect drop-down list, select Disable or Enable. 

5. Click OK. 

6. Confirmation and status messages display. Click OK to continue through confirmation 
and status messages. 

The setting information displays. See Figure 6.19. 

 

Figure 6.19 Array System Viewer - Setting Information 
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6.4.3 Releasing Command Devices 

To release the command devices: 

1. Click the Logical Status tab on the Array Unit screen. 

2. Click the Command Devices icon. 

3. Select the Command Device number you want to release the command devices, and 
click Release. 

4. Confirmation and status messages display. Click OK to continue through confirmation 
and status messages. 

The setting information displays. 

6.5 Setting Optional Features 

This section describes how to install and uninstall optional features. 

6.5.1 Installing Optional Features 

WARNING: Rebooting requires stopping I/O from the host.  

WARNING: If you are using TrueCopy or TrueCopy Extended Distance and you are required to 
reboot the subsystem, change the pair status to PSUS before you reboot. 

WARNING: If you are using a NAS, you must also stop the clusters between NAS units. When 
restarting the subsystem, you must restart the clusters. 

To install the optional features: 

1. Click the Logical Status tab on the Array Unit screen. See Figure 6.20. 

2. Click the License Key icon. 
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Figure 6.20 Array System Viewer - License Key 

 

3. Click Install. 

The Install Options dialog box displays. See Figure 6.21. 

 

Figure 6.21 Install Options Dialog Box 
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4. Choose an install option, Key Code, or Key File: 

Key Code: For the key code of the priced optional features, refer to the priced optional 
features manual. In the Key Code field, enter the key code, and click OK. 

Key File: In the Key File field, enter the path to the key file and click OK. An Install 
Options box displays. Select the desired features, and click OK. See Figure 6.22. 

 

Figure 6.22 Install Options  - Option Name 
 

5. In any confirmation screens that display, click OK or Close to continue. 

6. A status message indicates whether the install is successful.  

Note: Some options may require a subsystem restart before the options are functional. 
Follow the on-screen instructions. Before restarting, ensure that the host is not 
accessing data on the subsystem. A subsystem restart takes about 4 to 15 minutes. 

To perform other operations on the Main screen (see section 3.2), select the subsystem from 
the Main screen and open the selected Array Unit screen. 

Note: For additional information on priced optional features, refer to the corresponding 
manual of each feature. 

6.5.2 De-installing Optional Features 

WARNING: Rebooting requires stopping I/O from the host.  

WARNING: If you are using TrueCopy or TrueCopy Extended Distance and you are required to 
reboot the subsystem, change the pair status to PSUS before you reboot. 

WARNING: If you are using a NAS, you must also stop the clusters between NAS units. When 
restarting the subsystem, you must restart the clusters. 

To de-install the optional features: 

1. Click the Logical Status tab on the Array Unit screen. 

2. Click the License Key icon. 

3. Click Close. 

The De-install Options dialog displays. See Figure 6.23. 
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Figure 6.23 De-install Options Dialog Box 

4. Enter the key code, and click OK. 

5. A status message displays and indicates whether the de-install is successful. 

Note: If the message indicates that a subsystem restart is needed, follow the 
instructions in the message. Before restarting, ensure that the host is not accessing data 
on the subsystem. A subsystem restart takes about 4 to 15 minutes. 

To perform other operations on the Main screen (see section 3.2), select the subsystem from 
the Main screen and open the selected Unit screen. 

6.5.3 Setting Optional Features 

After releasing the key of the optional feature, set enable or disable this feature. 

WARNING: Rebooting requires stopping I/O from the host.  

WARNING: If you are using TrueCopy or TrueCopy Extended Distance and you are required to 
reboot the subsystem, change the pair status to PSUS before you reboot. 

WARNING: If you are using a NAS, you must also stop the clusters between NAS units. When 
restarting the subsystem, you must restart the clusters. 

To set the optional features: 

1. Click the Logical Status tab on the Array Unit screen. See Figure 6.24. 

2. Click the License Key icon. 



 Hitachi TagmaStore AMS and WMS Storage Navigator Modular for Web User’s Guide 91 

 

Figure 6.24 Array System Viewer - License Key 

3. Select the optional features to be set up, and click Change. 

4. A confirmation message displays. Click OK to continue setting the enable/disable option.  

5. A status message displays and indicates that the priced optional features have been set 
up.  

Note: If the message indicates that a subsystem restart is needed, follow the 
instructions in the message. Before restarting, ensure that the host is not accessing data 
on the subsystem. A subsystem restart takes about 4 to 15 minutes. 

To perform other operations on the Main screen (see section 3.2), select the subsystem from 
the Main screen and open the selected Unit screen. 
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Chapter 7 Setting Host Group Information 

This chapter contains information about setting a host group 0 (000:G000), such as a host 
group option and mapping information. 

For information on creating a host group, refer to the LUN Manager User's Guide. 

This chapter includes the following sections: 

 7.1 Setting Host Group Options 

 7.2 Setting Mapping Guard 

 7.3 Specifying Mapping Mode 
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7.1 Setting Host Group Options 

To set the host group options: 

1. Click the Logical Status tab. See Figure 7.1. 

2. Click the PortA  plus sign. 

3. Click the 000:G000 plus sign, then select Option. 

4. Click Simple Settings. 

 

Figure 7.1 Array System Viewer - Simple Settings 

5. As necessary, select Platform, Alternate Path, and Failover. See Figure 7.2. The 
combination, which can be chosen for every platform, is limited. 
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Figure 7.2 Simple Settings Dialog Box 

Platform:  

– HP-UX 

– Solaris 

– AIX®  

– Windows 2000 

– Windows 2003 

– Linux®  

– Tru64 

– Not specified 

Alternate path:  

– Not specified  

– PV Link: Can be used by HP-UX. 

– HDLM: Can be used by Solaris, AIX, and Windows 2000/2003. 

– VxVM: Can be used by HP-UX, AIX, Solaris, Windows 2000/2003, and Linux. 

– MPxIO: Can be used by Solaris. 

Failover:  

– Not specified 

– MC/ServiceGuard: Can be used by HP-UX. 

– SunCluster: Can be used by Solaris. 

– VCS: Can be used by Solaris and Linux. 

– HACMP: Can be used by AIX. 

– MSCS: Can be used by Windows 2000/2003. 
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– Tru Cluster: Can be used by Tru64. 

6. Click Additional Parameters. See Figure 7.3. 

 

Figure 7.3 Additional Parameters Dialog Box 

7. Select the appropriate options in the Item group and click OK. 

8. Click Detail. See Figure 7.4. 

 

Figure 7.4 Detail Settings Dialog Box 

9. Select Host Connection Mode 1, Host Connection Mode 2 and click OK. 
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Host Connection Mode 1: 

– Standard Mode: Open system emulation mode 

– Open VMS Mode: Open VMS mode 

– TRESPASS Mode: TRESPASS mode 

– Wolfpack Mode: Wolfpack mode 

Host Connection Mode 2: 

– HP-UX Mode: Enables the HP-UX Mode. 

– PSUE Read Reject Mode: Enables the PSUE Reject Mode. 

– UA (60/2A00) Suppress Mode: Suppresses the unit attention (06/2A00). 

– NACA Mode: Enables the NACA Mode. 

– HISUP OFF Mode: Enables the HISUP OFF Mode. 

– Reset Propagation Mode: The mode to propagate reset to other ports. 

– Unique Reserve Mode 1: Enables the Unique Reserve Mode 1. 

– ASL Report Mode (Active/Passive Group): Enables the ASL Report Mode 
(Active/Passive Group). 

– ASL Report Mode (Active/Passive): Enables the ASL Report Mode (Active/Passive). 

– ASL Report Mode (Active/Active): Enables the ASL Report Mode (Active/Active). 

– Port ID No Report Mode: Enables the Port ID No Report Mode. 

– Port ID Conversion Mode: Enables the Port ID Conversion Mode. 

– TruCluster Mode: Enables the TruCluster Mode. 

– Product Serial Response Mode: Enables the Product Serial Response Mode. 

– Same Node Name Mode: Enables the Same Node Name Mode. 

– CCHS Mode: Enables the CCHS convert. 

– SPC-2  Mode: Enables the SPC-2 Mode. 

10. Click OK. 

11. A confirmation message displays. Click OK. 

The modified host group options display. 

7.2 Setting Mapping Guard 

Mapping guard is a function to protect mapping setting against erroneous operation. Users 
cannot perform the mapping operation on the Storage Navigator to the Logical Unit on which 
the mapping guard is set to effective. 

To enable or disable Mapping Guard: 

1. Click the Logical Status tab on the Array Unit screen.  

2. On the Tools menu, select Mapping Guard. 
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Figure 7.5 Mapping Guard Dialog Box 

3. In the Mapping Guard window. See Figure 7.5. 

a) Select a LUN. 

b) Click Enable or Disable.  

c) Click OK. 

4. A confirmation message displays. Click OK. 

7.3 Specifying Mapping Mode 

To enable or disable Mapping Mode: 

1. Click the Logical Status tab on the Array Unit screen. 

2. Click the Access Mode plus sign next to the Mapping Mode. See Figure 7.6. 
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Figure 7.6 Array System Viewer - Mapping Mode 

3. On the Mapping Mode list, select Enable or Disable and click Modify. 

This operation can also be done from the context menu of the list view. 

The Mapping Mode dialog box displays. See Figure 7.7. 

 

Figure 7.7 Modify Mapping Mode Dialog Box 

4. Select Enable or Disable and click OK. 

5. A confirmation message displays. Click OK. 

The setting information displays. 
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7.3.1 Setting Mapping Information 

To set mapping information: 

1. Click the Logical Status tab on the Array Unit screen. 

2. Click the Port 0A plus sign and select 000:G000. 

3. Select the Logical Unit icon. See Figure 7.8. 

 

Figure 7.8 Array System Viewer - Logical Unit 

4. Select Modify Mapping. 

The Mapping Property dialog box displays. See Figure 7.9. 
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Figure 7.9 Modify Mapping Dialog Box 

5. Select one H-LUN to be added. Select LUN, and click . The added contents display 
in the Mapping Information list. See Figure 7.10.  

To delete, click the line to be deleted in Mapping Information list and click . The 
deleted contents disappear. 

 

Figure 7.10 Modify Mapping Window 

6. Click OK. 

7. A confirmation message displays. Click OK. 

The set mapping information is updated and the following window displays. See Figure 
7.11. 
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Figure 7.11 Array System Viewer - Set Mapping Information 
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Chapter 8 Setting Target Information 

This chapter contains information about setting  Target 0 (000:T000) information, such as a 
target options and mapping information. For information on creating a target, refer to the 
LUN Manager User's Guide. 

This chapter includes the following sections: 

 8.1 Setting Target Options 

 8.2 Setting Mapping Guard 

 8.3 Specifying Mapping Mode 

 8.4 CHAP User 

 8.5 Setting a Target Information 
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8.1 Setting Target Options 

To set the target options: 

1. Click the Logical Status tab. See Figure 8.1. 

2. Click the Port 0A plus sign. 

3. Click the 000:T000 plus sign and select Options. 

4. Click Simple Settings. 

 

Figure 8.1 Array System Viewer - Simple Settings 

5. As necessary, select Platform, Alternate Path, and Failover. The combination, which 
can be chosen for every platform, is limited. See Figure 8.2. 
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Figure 8.2 Simple Settings Dialog Box 

Platform:  

– HP-UX 

– Solaris 

– AIX  

– Windows 2000 

– Windows 2003 

– Linux  

– Tru64 

– Not specified 

Alternate path:  

– Not specified  

– PV Link: Can be used by HP-UX. 

– HDLM: Can be used by Solaris, AIX®, and Windows 2000/2003. 

– VxVM: Can be used by HP-UX, AIX®, Solaris, Windows 2000/2003, and Linux. 

– MPxIO: Can be used by Solaris. 

Failover:  

– Not specified 

– MC/ServiceGuard: Can be used by HP-UX. 

– SunCluster: Can be used by Solaris. 

– VCS: Can be used by Solaris and Linux. 

– HACMP: Can be used by AIX. 

– MSCS: Can be used by Windows 2000/2003. 
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– Tru Cluster: Can be used by Tru64. 

6. Click Additional Parameters. See Figure 8.3. 

 

Figure 8.3 Additional Parameters Dialog Box 

7. Select the appropriate options in the Item group and click OK. 

8. Click Options (Detail). See Figure 8.4. 

 

Figure 8.4 Detail Setting Dialog Box 

9. Select Host Connection Mode 1, Host Connection Mode 2 and click OK. 

Host Connection Mode 1: 

– Standard Mode: Open system emulation mode 

– Open VMS Mode: Open VMS mode 

– TRESPASS Mode: TRESPASS mode 
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– Wolfpack Mode: Wolfpack mode 

Host Connection Mode 2: 

– HP-UX Mode: Enables the HP-UX Mode. 

– PSUE Read Reject Mode: Enables the PSUE Reject Mode. 

– UA (60/2A00) Suppress Mode: Suppresses the unit attention (06/2A00). 

– NACA Mode: Enables the NACA Mode. 

– HISUP OFF Mode: Enables the HISUP OFF Mode. 

– Reset Propagation Mode: The mode to propagate reset to other ports. 

– Unique Reserve Mode 1: Enables the Unique Reserve Mode 1. 

– ASL Report Mode (Active/Passive Group): Enables the ASL Report Mode 
(Active/Passive Group). 

– ASL Report Mode (Active/Passive): Enables the ASL Report Mode (Active/Passive). 

– ASL Report Mode (Active/Active): Enables the ASL Report Mode (Active/Active). 

– Port ID No Report Mode: Enables the Port ID No Report Mode. 

– Port ID Conversion Mode: Enables the Port ID Conversion Mode. 

– Tru Cluster Mode: Enables the Tru Cluster Mode. 

– Product Serial Response Mode: Enables the Product Serial Response Mode. 

– Same Node Name Mode: Enables the Same Node Name Mode. 

– CCHS Mode: Enables the CCHS convert. 

– SPC-2  Mode: Enables the SPC-2 Mode. 

10. Click OK. 

11. A confirmation message displays. Click OK. 

The modified target options display. 

8.2 Setting Mapping Guard 

To enable or disable Mapping Guard: 

1. Click the Logical Status tab on the Array Unit screen. 

2. On the Tools menu, select Mapping Guard.  
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Figure 8.5 Mapping Guard window 

3. In the Mapping Guard window: See Figure 8.5. 

a. Select a LUN. 

b. Click Enable or Disable.  

c. Click OK. 

4. A confirmation message displays. Click OK. 

8.3 Specifying Mapping Mode 

To enable or disable Mapping Mode: 

1. Click the Logical Status tab on the Array Unit screen. 

2. Click the Access Mode plus sign. Select Mapping Mode. See Figure 8.6. 
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Figure 8.6 Array System Viewer - Mapping Mode 

3. On the Mapping Mode list, select Enable or Disable, and click Modify. 

This operation can also be done from the context menu of the list view. 

The Mapping Mode dialog box displays. See Figure 8.7. 

 

Figure 8.7 Modify Mapping Mode Dialog Box 

4. Select Enable or Disable and click OK. 

5. A confirmation message displays. Click OK. 

The setting information displays. 
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8.3.1 Setting Mapping Information 

To set mapping information: 

1. Click the Logical Status tab on the Array Unit screen. See Figure 8.8. 

2. Click the Port 0A  plus and select 000:T000. 

3. Select the Logical Unit icon. 

 

Figure 8.8 Array System Viewer - Logical Unit 

4. Select Modify Mapping. 

The Mapping Property dialog box displays. See Figure 8.9. 
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Figure 8.9 Modify Mapping Dialog Box 

5. Select one H-LUN to be added. Select LUN, and click . The added contents display 
in the Mapping Information list. See Figure 8.10. 

To delete, click the line to be deleted in the Mapping Information list and click . 
The deleted contents disappear. 

 

Figure 8.10 Modify Mapping - Mapping Information 

6. Click OK. 

7. A confirmation message displays. Click OK. 

The set mapping information is updated and the following window displays. See Figure 
8.11. 
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Figure 8.11 Array System Viewer - Set Mapping Information 

8.4 CHAP User 

This section contains information about adding, changing, and deleting a CHAP user. 

8.4.1 Adding a CHAP User 

To add a CHAP User: 

1. Click the Logical Status tab. See Figure 8.12. 

2. Click the Port 0A plus sign and select CHAP User. 

3. Click Add. 
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Figure 8.12 Array System Viewer - CHAP User 

The CHAP User dialog box displays. See Figure 8.13. 

 

Figure 8.13 CHAP User Dialog Box 

4. In the CHAP User dialog box, enter the User Name, Secret, and Secret Confirmation. 
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5. From the Available Targets list, select the target to be assigned, and click . 

– User Name: Enter the name of the User with 256 or less alphanumeric character. 
The following symbols can be used: 

(.  -  +  @  _  =  :  /  [  ]  ~  (space)) 

– Secret: Enter the Secret from 12 through 32 alphanumeric characters. The following 
symbols can be used: 

(.  -  +  @  _  =  :  /  [  ]  ~  (space)) 

6. Click OK. 

7. A confirmation message displays. Click OK. 

8.4.2 Changing the CHAP User 

To change the CHAP user: 

1. Click the Logical Status tab. See Figure 8.14. 

2. Click the Port0A plus sign and select CHAP User. 

3. Select the CHAP User to be changed from the CHAP User list. 

4. Click Modify. 

 

Figure 8.14 Array System Viewer - CHAP User List 

The CHAP User dialog box displays. See Figure 8.15. 
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Figure 8.15 CHAP User dialog box 

5. As necessary, enter the User Name, Secret, and Secret Confirmation. 

6. As necessary, change the assigned Target, and click OK. 

7. A confirmation message displays. Click OK. 

8.4.3 Deleting the CHAP User 

To delete the CHAP user: 

1. Click the Logical Status tab. See Figure 8.16. 

2. Click the Port0A plus sign and select CHAP User. 

3. Select the CHAP User to be deleted from the CHAP User list. 

4. Click Delete. 
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Figure 8.16 Array System Viewer - CHAP User Delete 

5. A confirmation message displays. Click OK. 

8.5 Setting a Target Information 

This section includes changing target information and initializing the target. 

8.5.1 Changing Target Information 

1. Click the Logical Status tab. See Figure 8.17. 

2. Click Port0A. 

3. Select the Target to be changed from the Target list. 

4. Click Modify. 
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Figure 8.17 Array System Viewer - Target 

The Target dialog box displays. See Figure 8.18. 

 

Figure 8.18 Target Dialog Box 

5. In the Target dialog box, enter or select the Alias, the Authentication Method, the 
CHAP Information, the iSCSI Name. 

– Alias: Enter the name of the Target with 32 or less alphanumeric character. 

(Excluding  \, /, : , , , ;, *, ?, “, <, >, | and ‘) 

Spaces at the top or end are ignored. An identical name cannot be used in an 
identical Port. 

– Authentication Method: Select the CHAP, None, or CHAP,None. 
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– CHAP Information: 

CHAP Algorithm: Displayed MD5 always. 

Two-Way Authentication: Select the Enable or Disable radio button. 

When the Enable radio button is selected, specify following items. 

User Name: Enter the name of the User with 256 or less alphanumeric character. 
The following symbols can be used: 
(.  -  +  @  _  =  :  /  [  ]  ~  (space)) 

Secret: Enter the Secret from 12 through 32 alphanumeric characters. The following 
symbols can be used: 
(.  -  +  @  _  =  :  /  [  ]  ~  (space)) 

Secret Confirmation: Enter the characters that enter into the Secret. 

– iSCSI Name: Enter the name of the iSCSI Name with 223 or less alphanumeric 
character. A period (.), hyphen (-), and colon (:) can be used. 

6. Select the Authentication Method from the drop-down list. 

– Name: Enter the name of the Target with 16 or less alphanumeric character. 

(Excluding  \, /, : , , , ;, *, ?, “, <, >, | and ‘) 

Spaces at the top or end are ignored.  An identical name cannot be used in an 
identical Port. 

– Authentication Method: Select the CHAP, None, or CHAP,None. 

– iSCSI Name: Enter the name of the iSCSI Name with 233 or less alphanumeric 
character. A period (.), hyphen (-), and colon (:) can be used. 

7. Click OK. 

8. A confirmation message displays. Click OK. 

8.5.2 Initializing the Target  

1. Click the Logical Status tab. See Figure 8.19. 

2. Click the Port. 

3. Select the Target to be initialized from the Target list. 

4. Click Initialize. 
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Figure 8.19 Array System Viewer -  Initialize 

5. A confirmation message d. displays. Click OK. 
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Chapter 9 Setting System Parameters  

This chapter contains information about setting a system configuration, such as Fibre 
information, for an array unit. Individual items to be set are selected by switching the tab 
screen. Tab screens might not display, depending on the connected array unit and other 
variables.  

This chapter includes the following sections: 

 9.1 Setting Boot Options 

 9.2 Setting Fibre Channel Information 

 9.3 Setting iSCSI Port Information 

 9.4 Setting iSNS Server Information 

 9.5 Sending Ping 

 9.6 Setting System Parameters 

 9.7 Setting Port Options 

 9.8 Setting Drive Restoration Options 

 9.9 Online Verify Mode 

 9.10 Setting Format Priority Mode 

 9.11 Setting LAN Configuration  

 9.12 Setting the LAN Port Number 

 9.13 Setting the IP Address of the Maintenance Port 

 9.14 Setting RTC 

 9.15 Setting Time Zone and NTP Server 

 9.16 Outputting Configuration Information to a File 

 9.17 Replacing a Microprogram 

 9.18 Setting the Backend Diagnosis Information 
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9.1 Setting Boot Options 

When the boot option is set, the subsystem requires a restart after setting changes.  

WARNING: Rebooting requires stopping I/O from the host.  

WARNING: If you are using TrueCopy or TrueCopy Extended Distance and you are required to 
reboot the subsystem, change the pair status to PSUS before you reboot. 

WARNING: If you are using a NAS, you must also stop the clusters between NAS units. When 
restarting the subsystem, you must restart the clusters. 

To set the boot option: 

1. On the Tools menu, select Configuration Settings or click . Click the Boot Option 
tab and set the options. See Figure 9.1. 

 

Figure 9.1 Configuration Settings - Boot Option 

– System Startup Attribute: Select the subsystem configuration. 

– Single Mode: Single configuration 

– Dual Active Mode: Dual active configuration 

– Delay Planned Shutdown: Specify the time in minutes to delay the execution of the 
planned shutdown when the main switch has turned off. The applicable range is 
from 0 to 60 minutes. 

– Drive Detach Mode: Validates the drive blockade mode. 
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– Vendor ID: Enter an eight-character vendor name. When the name consists of less 
than eight characters, make an eight-character entry by filling the reset with 
space(s). The default value set in HITACHI . (  Denotes a space.) 

– Product ID: Enter a 16-character model name. When the name consists of less than 
16 characters, make a 16-character entry by filling the reset with space(s). 
The default value set in DF600F . (  Denotes a space.) 

– ROM Microprogram Version: Specifies a microprogram version of a ROM reported by 
inquiry command. 

– RAM Microprogram Version: Specifies a microprogram version of a RAM reported by 
inquiry command. 

2. Click Apply. 

3. Follow the information in messages that appear. Click OK to continue or Cancel.  

4. The subsystem restarts in about 4 to 15 minutes. 

9.2 Setting Fibre Channel Information 

Fibre channel settings include Port Address, Transfer Rate, and Topology Information. 

9.2.1 Displaying Fibre Channel Information 

To display fibre channel information: 

1. On the Tools menu, select Configuration Settings or click .  

2. Click the Fibre Channel tab. See Figure 9.2. 
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Figure 9.2 Configuration Settings - Fibre Channel 

– Node Name: Describes 8 bytes of data hexadecimal (with 16 characters). 

– Port Name: Describes 8 bytes of data hexadecimal (with 16 characters). 

– Port Address: Port address displays as a hexadecimal number. 

– Transfer Rate: Indicates fibre transfer rate. 

– Topology Information: Indicates topology status. 

– Link Status: Indicates link status. 

– LinkUp (Private Loop): Arbitrated Loop that is not connected with the Fibre 
Channel switch. 

– LinkUp (Public Loop): Arbitrated Loop that is connected with Fibre Channel 
switch. 

– LinkUp (N_Port connection): Connect Point to Point with host. 

– LinkUp (F_Port connection): Connect Point to Point with Fibre Channel switch. 

– Loop Port Bypass: Bypassed from the loop. 

– Standby: Standby state. 

– LinkDown: Link is down. 

– LinkFailure: Link initialization condition. 

9.2.2 Setting Fibre Channel Settings 

Fibre channel information is set up on a port basis. 

Note: This procedure causes the subsystem to cease host access. Before setting, stop access 
to the port from the host. 

To set the fibre channel settings: 

1. On the Tools menu, select Configuration Settings or click . 

2. Click the Fibre Channel tab. 

3. Set the Port Address, Transfer Rate, and Topology Information making them conform 
to an environment that matches a host. 

– Port Address: Enter 8 bytes of data hexadecimal (with 16 characters). 

– Transfer Rate: Select the value from the drop-down menu. 

– Topology Information: Select the value from the drop-down menu. 

4. Click Apply. 

5. Click OK to continue.  

Note: It may take time to complete the setting. Click Refresh to verify that the correct 
settings have been made. 
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9.3 Setting iSCSI Port Information 

To set the iSCSI port information: 

1. On the Tools menu, select Configuration Settings or click . Click the Boot Option 
tab and set options. 

2. Click the iSCSI tab. See Figure 9.3. 

 

Figure 9.3 Configuration Settings - iSCSI 

3. Set the iSCSI port parameters: 

– Network: Set the IP Address, Subnet Mask, Default Gateway, Port Number, and 
Keep Alive Timer(sec.) making them conform to an environment. 

4. Click Apply. 

5. Click OK to continue. 
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9.4 Setting iSNS Server Information 

To set the iSNS server information: 

1. On the Tools menu, select Configuration Settings or click . Click the Boot Option 
tab and set options. 

2. Click the iSNS tab. See Figure 9.4. 

 

Figure 9.4 Configuration Settings - iSNS 

3. Set the iSNS server parameters: 

– Select iSNS Server 

– Click Use: Specify whether to use the iSNS server or not. When use the iSNS server, 
specify the IP Address and Port Number of the iSNS server. 

4. Click Apply. 

5. Click OK to continue. 
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9.5 Sending Ping 

Sends the ping to the initiator (host) and displays the result of the sending. 

1. On the Tools menu, select Configuration Settings or click .  

2. Click the Boot Option tab and set options. 

3. Click the Ping tab. See Figure 9.5. 

 

Figure 9.5 Configuration Settings - Ping 

4. Set the ping parameters: 

– Port: Select the port that sends the ping. 

– Destination IP Address: Specify the IP address of the initiator. 

5. Click Start. 

6. Click OK to continue. 

The result displays. 

7. Select Refresh as necessary to display the latest information. 
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9.6 Setting System Parameters 

This setting information becomes valid without restarting the subsystem. 

1. On the Tools menu, click the Configuration Settings or click . 

2. Click the System Parameter tab .See Figure 9.6. 

 

Figure 9.6 Configuration Settings - System Parameter 

3. Set the system parameters. See Table 9-1for a description of these parameters. 

4. Click Apply. 

5. Click OK. 
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Table 9-1 Setting System Parameters 

Parameter Description Operation 

Turbo LU Warning This parameter is to be specified 
when the Turbo LU setting 
function is used. 
Default = Disable 

Disable: When the Turbo LU can no longer be maintained due to 
a failure, the parameter allows host access to be issued. 
Enable: When the Turbo LU can no longer be maintained due to 
a failure and the performance is lowered, the parameter 
suppresses host access and issues a warning. 

Write Unique 
Response Mode 

This parameter is to be specified 
when a host of the NX series is 
connected. 
Default = Disable 

Disable: Cache memory is used for write commands. 
Enable: Write commands are executed unconditionally in write-
through mode (write data directly to disk without using cache). 

Auto Reconstruction 
Mode 

This parameter specifies 
operations to be performed when 
a disk drive is removed. 
Default = Disable 

Disable: When a disk drive is removed, correction copy to a 
spare disk drive is not performed. 
Enable: When a disk drive is removed, correction copy to a spare 
disk drive is performed. 
Caution: This mode is for test purposes and should only be used 
by authorized service personnel. 

Forced Write 
Through Mode 

This parameter specifies the 
method for executing write 
commands after a CTL 
detachment or power failure. 
Default = Disable 

Disable: If a CTL detachment or power failure has occurred, 
cache memory is used for write commands. 
Enable: If a CTL detachment or power failure has occurred, write 
commands are executed in write-through mode (write data 
directly to disk without using cache). 

LU Ownership 
Change Disable 
Mode 

This parameter specifies an 
operation to re-assign an LU to a 
non-owner controller when the 
controller attempts to access the 
LU. 
Default = Disable 

Disable: Request internal processing to the Control Unit in 
charge of the LU. If there is no access for one minute from the 
Control Unit in charge of the LU, reallocate the Control Unit in 
charge of the LU. 
Enable: The access is always made by the Control Unit that 
controls the LU concerned by request, without re-assigning the 
LU to a Control Unit that wants to access the LU. 

ShadowImage I/O 
Switch Mode 

This parameter specifies an 
operation of a ShadowImage 
P-VOL to be performed when a 
double disk drive failure occurs. 
Default = Disable 

Disable: If a double failure occurs in disk drives of a 
ShadowImage P-VOL in the PAIR status, the status is changed to 
PSUE. 
Enable: If a double failure occurs in disk drives of a 
ShadowImage P-VOL in the PAIR status, the execution of the 
host I/O is switched to the S-VOL to continue the execution. 
Note: For further information, see the ShadowImage User’s 
Guide. 

Synchronize Cache 
Execution Mode 

This parameter specifies an 
operation to be performed when 
the Synchronize Cache 
command is received. 
Default = Disable 

Disable: No operation is performed when the Synchronize Cache 
command is received. 
Enable: When the Synchronize Cache command is received, all 
data in the cache memory is written to disk drives. 
Note: For further information, see the TrueCopy User’s Guide. 

Drive Detach Mode Specifies an operation to be 
performed when a drive failure 
occurs in the same RAID group. 
Default = Disable 

Disable: When a failure occurs in a disk drive in a state in which 
another disk drive in the same RAID group has already been 
detached due to a failure, the parameter does not detach the disk 
drive that failed secondarily. 
Enable: When a failure occurs in a disk drive in a state in which 
another disk drive in the same RAID group has already been 
detached due to a failure, the parameter detaches the disk drive 
that failed secondarily and detaches LUs (makes LUs 
unformatted) in the RAID group concerned. 
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Parameter Description Operation 

Operation if the 
Processor Failure 
Occurs 

This parameter specifies the 
operation to be performed when 
a processor failure occurs. 
Default = Reset of occurred 

Reset the Fault: The parameter resets the failure and reboots 
the Control Unit. 
Shutdown System: The parameter shuts the disk array 
subsystem down. 

Web When the Web function built in 
the disk subsystem is displayed 
with the browser, this parameter 
specifies characters to be 
displayed in the browser title bar. 
Default = Not set 

Characters that can be entered (maximum 32) are alphabetic 
characters, numerals, and characters other than numerals 
(excluding ', ", and \). 

Write & Verify 
Execution Mode 

This parameter specifies the 
execution mode for write and 
verify operation. 
Default = ON 

ON: The write and verify operation is performed. 
OFF: The write and verify operation is not performed. 
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9.7 Setting Port Options 

The Port Options tab allows you to set the system parameter port options. The setting 
information becomes valid without restarting the subsystem. 

1. On the Tools menu, click the Configuration Settings or click . 

2. Click the Port Options tab. See Figure 9.7. 

 

Figure 9.7 Configuration Settings - Port Options 

3. Select the desired port, and then select the desired Port Options: 

– Reset/LIP Mode (Signal): Set this option to transmit Reset/LIP signals to other ports. 

– Reset/LIP Mode (Process): Set this option to transmit reset processing to other 
ports. If this option is set, the Reset/LIP Mode (signal) is automatically enabled. 

– LIP Port ALL Reset Mode: Set this option to execute reset on receiving LIP. 

Note: Multiple Port Options can be set, but depending on the setting, it may not 
function properly. If it is to be set, please refer to the appended subsystem manual and 
set only the applicable parameters. 

4. Click Apply to apply the selected settings to the subsystem. 
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9.8 Setting Drive Restoration Options 

Do not set drive restoration options while a drive restoration is in progress. 

To set drive restoration options: 

1. On the Tools menu, select Configuration Settings or click . 

2. Click Restore Options tab. See Figure 9.8. 

 

Figure 9.8 Configuration Settings - Restore Options 

3. Enter the following settings: 

Drive Restoration Mode: 

– Background: Executes drive restoration while host I/O processing is not executed. 

– Interleave (Normal): Restores the drive at preset time intervals (specified as 
“Interval Time”) giving preference to a host command (restores after executing the 
command). 

– Interleave (Prior): Restores the drive at preset time intervals (specified as “Interval 
Time”) taking preference over a host command. 

Drive Restoration: 

– Manual: Starts restoring data and copying by manual operations. 

– Auto: Automatically starts data and copying restoration. 

Interval Time: 

The default is 10 × 10 ms with restoration executed at intervals of 100 ms. To set, 
specify a multiplication factor from 0 to 255 in a unit of 10 ms. 
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– Processing Unit Size: Specify the size of the data block to be restored. The value of 
the range of 1 to 511 is specified by a multiple of 128. The minimum value is 128, 
which restores 65 KB data in a single operation. When Interleave mode is specified, 
the function restores the data of the processing unit size that is specified, waits for 
the time interval that is specified, and then starts the next data restoration. 

Dynamic Sparing: Specify a mode for data restoration for the spare drive when the error 
occurrence count controlled by preventive maintenance exceeds the threshold value. 

– Execute (Read/Write & Online Verify): When the error occurrence count in 
Read/Write Error or Online Verify Error, Threshold Value Over and Start of Dynamic 
Sparing display on the panel. Data restoration is performed for the spare drive (when 
the spare drive is not used), and the error disk is blocked. 

– Execute (Read/Write): When the error occurrence count in Read/Write Error 
exceeds the threshold value, Threshold Value Over and Start of Dynamic Sparing 
displays on the panel. Data restoration is performed for the spare disk in the spare 
drive (when the spare disk is not used), and the error disk is blocked. 
When the error occurrence count in Online Verify Error exceeds the threshold 
value, Threshold Value Over displays on the panel, but Dynamic Sparing is not 
performed. 

– Do not Execute: When the error occurrence count in Read/Write Error or Online 
Verify Error exceeds the threshold value, Threshold Value Over displays on the 
panel, but Dynamic Sparing is not performed. 

Spare Drive Operation Mode: Specify the spare drive operation mode. 

– Variable: When a failed drive is replaced, the new drive becomes a spare drive. 

– Applying No Copy Back Mode on All Units: Specify whether to set the Applying No 
Copy Back Mode on All Units effective or ineffective. 

– Fixed: Uses only a drive that is designated as a spare (see section 6.2.1). 

4. Click Apply. 

5. A confirmation message displays. Click OK. 

9.9 Online Verify Mode 

To enable Online Verify Test or to skip Online Verify: 

1. On the Tools menu, select Configuration Settings or click . 

2. Click the Online Verify tab. See Figure 9.9. 
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Figure 9.9 Configuration Settings - Online Verify 

3. Select the desired options: 

– Online Verify Test 

– Skip Verify: When a verify command is received from a host, ensure that verification 
operation is performed. 

4. Click Apply. 

5. A confirmation message displays. Click OK. 

9.10 Setting Format Priority Mode 

Changes to Format Priority Mode apply without restarting the subsystem. 

To change the Format Priority Mode: 

1. On the Tools menu, select Configuration Settings or click . 

2. Click the Format Mode tab. See Figure 9.10. 
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Figure 9.10 Configuration Settings - Format Mode 

3. Select the Format Priority mode and Format Data settings. 

Format Priority mode: 

– Normal: Formats at an idle time when no host I/O is executed. 

– Host: Host's I/O is executed preferentially. 

– Format: Subsystem formats are done preferentially. 

Format Data: Specify a format data. 

4. Click Apply. 

5. A confirmation message displays. Click OK. 

9.11 Setting LAN Configuration 

9.11.1 Setting LAN Configuration without Rebooting 

LAN information cannot be set when it accesses the user port and the maintenance port of 
the controller to be set with Web, etc. Execute LAN information after stopping access to the 
controller to be set. 

To Set the LAN configuration without rebooting: 

1. On the Tools menu, select Configuration Settings or click . 

2. Click the LAN tab. 

3. Select Set now without reboot. See Figure 9.11. 
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Figure 9.11 Configuration Settings - LAN panel 

– Set with reboot: Rebooting is necessary. 

– Set now without reboot: Rebooting is unnecessary. You cannot select the DHCP 
mode. 

– Maintenance Port IP Address Automatic Change Mode: The IP address of the 
maintenance port is set automatically in accordance with the IP address that has 
been set. When the mode is set as Enable, the maintenance port cannot be set with 
the Maintenance LAN tab. 

– LAN: Specify IP Address, Subnet Mask, Default Gateway, and Negotiation, which is 
part of the LAN information. Ether Address is displayed but cannot be changed. 

– The Setting value and the Current value are displayed as the information that has 
been set and that is enabled in the subsystem, respectively.  

4. Click Apply. 

5. A message displays stating that the setting is completed. To continue, click OK. 

6. Figure 9.12 displays when the LAN information is set in the case that it accesses the user 
port and the maintenance port of the controller to be set with Web, etc. 
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Figure 9.12 LAN Message  

The usage condition of the LAN port is output to netstat.inf. See Figure 9.13. In the 
netstat.inf file, “Local address” means IP address of the controller, “Foreign Address” 
means IP address of PC connecting with the subsystem, “State” means the status of TCP 
connection. Regardless of “Status” in the netstat.inf file, stop the all application 
currently connecting from “Foreign address”, and execute it again. 

 

Figure 9.13 netstat.inf - Notepad 

9.11.2 Setting LAN Configuration with Rebooting 

This procedure requires restarting the subsystem. 

WARNING: Rebooting requires stopping I/O from the host. 

WARNING: Setting the LAN configuration is a disruptive procedure for TrueCopy or 
TrueCopy Extended Distance operations. The subsystem restart required by this procedure 
disrupts TrueCopy or TrueCopy Extended Distance settings and causes both TrueCopy or 
TrueCopy Extended Distance paths to fail. You must re-establish TrueCopy or TrueCopy 
Extended Distance operations after restart. 

WARNING: If you are using a NAS, you must also stop the clusters between NAS units. When 
restarting the subsystem, you must restart the clusters. 

To set the subsystem LAN configuration: 

1. On the Tools menu, select Configuration Settings or click . 

2. Click the LAN tab. See Figure 9.14. 

3. Select Set with reboot. 
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Figure 9.14 Configuration Settings - Set with Reboot Array Unit 

– Maintenance Port IP Address Automatic Change Mode: The IP address of the 
maintenance port is set automatically in accordance with the IP address that has 
been set. When the mode is set as Enable, the maintenance port cannot be set with 
the Maintenance LAN tab. 

– DHCP: Specifies whether the DHCP mode will be valid or invalid. 

– LAN: Specifies IP Address, Subnet Mask, Default Gateway, or Negotiation, which is 
part of the LAN information. Ether Address is displayed but cannot be changed. 

– The Setting value and the Current value are displayed as the information that has 
been set and that is enabled in the subsystem, respectively. 

Note: When ON is selected in DHCP, Network is disabled (gray) and cannot be selected. 

4. Click Apply. 

5. A message indicates that a subsystem restart is needed to apply the settings. Before 
restarting, be certain that the host is not accessing data on the subsystem. A subsystem 
restart takes about 4 to 15 minutes. 

To continue, click OK. 

6. A message warns that the subsystem restart can cause disruptions when using TrueCopy 
or TrueCopy Extended Distance:  failure of TrueCopy or TrueCopy Extended Distance 
paths and changing pairs with PAIR or COPY status to PSUE. 

To restart and apply the LAN settings, click OK. 
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Notes: 

 To validate the LAN information, restart the array unit. The previous settings stay valid 
until restarting. The array unit cannot access the host until the reboot is completed and 
the system restarts. Therefore, ensure that the host has stopped accessing data before 
beginning the restart process. 

 If LAN configuration information is modified, an error message (Interface Error) may 
display without displaying a restart completion message when restarting is initiated. 
When an error message displays after the LAN configuration information is modified and 
a restarting is directed to be done, close the Array Unit screen, make a change in the 
information that has been registered through the Main screen, and then open the Array 
Unit screen again. 

9.12 Setting the LAN Port Number 

The port number can be set when the microprogram version of the AMS500/AMS200/WMS100 
array subsystem is 0726/E or later (9500V/9520V array subsystem is x65B/H or later) and the 
version of Web Navigator is 2.61 or later. 

The port number is set for each controller, however, set both controllers without closing the 
setting window. After setting the both controllers, close the Array Unit screen and edit the 
services file of the OS that is operating Web Navigator. When the two or more disk array 
subsystems are registered, set all of them. The setting of the services file is enabled without 
closing the Main screen. 

Set the port number in a range of 1024 to 49151. 

1. On the Tools menu, select Configuration Settings or click . 

2. Click the LAN Port Number tab. See Figure 9.15. 
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Figure 9.15 Configuration Settings - LAN Port Number 

3. Select the radio button of Controller1 and enter a port number in the port number text 
field. 

Note: Enter a port number that is not used by the OS that is operating Web Navigator, 
various types of applications, etc. in the port number field. 

4. Click Apply. 

5. When the confirmation message displays, click OK (three times). 

6. When the following confirmation message displays, click Cancel. See Figure 9.16. 

 

Figure 9.16 Message Dialog Box 

Web Navigator goes to the LAN Port Number tab screen. 

7. Select the radio button of the Controller0 and enter a port number to be set in the port 
number text field. Enter the port number that is set in the Controller1. 

8. Click Apply. 

9. When the confirmation message displays, click OK (five times). 

The Unit screen is closed. 
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An example of the edit of the services file (in the case of Windows 2000): 

1. Open the services file using a text editor such as Notepad.exe, etc. 

2. Add a port number to be used by Web Navigator referring to the following example, and 
then overwrite and save it. 

When adding the port number to the last line, ensure that you  start a new line. 

# Copyright (c) 1993-1999 Microsoft Corp. 
# 
# This file contains port numbers for well-known services defined by IANA 
# 
# Format: 
# 
# <service name>  <port number>/<protocol>  [aliases...]   [#<comment>] 
# 
 
echo                7/tcp 
echo                7/udp 
 : 
 : 
radacct          1813/udp                           #RADIUS accounting protocol 
nfsd             2049/udp    nfs                    #NFS server 
knetd            2053/tcp                           #Kerberos de-multiplexor 
man              9535/tcp                           #Remote Man Server 
df-damp-snm      23456/tcp 
 

9.13 Setting the IP Address of the Maintenance Port 

Note: The LAN configuration information for the maintenance of the subsystem is usually 
set at the factory shipment, therefore you do not have to set it. 

To set the IP address of the maintenance port: 

1. On the Tools menu, select Configuration Settings or click . 

2. Click the Maintenance LAN tab. See Figure 9.17. 
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Figure 9.17 Configuration Settings - Maintenance LAN Panel 

IP Address: Select the IP address of the CTL0 from the drop-down list. When the 
Maintenance Port IP Address Automatic Change Mode is set as Enable with the LAN 
tab, the display is grayed and the setting cannot be made. 

3. Click Apply. 

4. When the confirmation message displays, click OK. 

9.14 Setting RTC 

Changes to the RTC apply without restarting the subsystem. 

To set the RTC: 

1. On the Settings menu, click the Configuration Settings or click . 

2. Click the RTC tab. See Figure 9.18. 
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Figure 9.18 Configuration Settings - RTC 

3. Set the RTC: 

– Setting: Select Manual or Auto. 

– Manual: Sets the date and time. 

– Auto: Sets the time of the Web Server executing the Storage Navigator Modular. 

– Date: Displays the date. 

– Time: Displays the time. 

4. Click Apply. 

5. A confirmation message displays. Click OK. 

9.15 Setting Time Zone and NTP Server 

To set the time zone: 

1. On the Tools menu, select Configuration Settings or click . 

2. Click the Time Zone tab. See Figure 9.19. 
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Figure 9.19 Configuration Settings - Time Zone 

– Time Zone: Select a time zone from the Time Zone drop-down list. 

– Automatically adjust clock for daylight saving changes: Specify whether to use the 
daylight saving or not. 

– NTP Server: Specify the IP address of the NTP server. 

3. Click Apply. 

4. When the confirmation message displays, click OK. 

9.16 Outputting Configuration Information to a File 

This section describes how to output the configuration information of the subsystem in a 
text file or set the configuration using a text file. 

The configuration information output in a text file includes the status of the system 
parameters, RAID group/logical unit, port/host group, and the constituent parts of the 
subsystem. The configuration to be set includes the system parameters, RAID group/logical 
unit, and port/host group. The status of the constituent parts of the subsystem cannot be 
set. 

The configuration information is handled with separate text files for the system parameters, 
for RAID group/logical unit, and for port/host group. 

Copying configuration information between subsystems can be executed by outputting a text 
file of the configuration from the subsystem, then using the output text file to set another 
subsystem. 
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Editing a text file to set the subsystem can be done, however, it is recommended that this 
function be used for the configuration of the same subsystem. To change the configuration, 
use individual functions. 

9.16.1 File Output for System Parameters 

To output the settings of the system parameters for the subsystem in text form to a 
specified file: 

1. On the Tools menu, select Configuration Settings or click . 

2. Click the Constitute tab. See Figure 9.20. 

 

Figure 9.20 Configuration Settings - Constitute panel (Output) 

3. Check the System Parameters option in the Select Configuration Information box. 

4. Specify the directory and file name to which the configuration file will be output. 

5. Select the Output option. 

6. Click Apply. 

7. When the confirmation message displays, click OK. 

System parameter information is saved in the form of a text file with the specified file 
name. The format of the output file consists of the following items. The outline of the 
layout of the output file is shown in Figure 9.21. 

 File header 

 Subsystem registration name with the Storage Navigator Modular  



146 Chapter 9 Setting System Parameters 

 Output time (Web Server time where the Storage Navigator Modular is installed) 

 Microprogram revision 

 Subsystem type 

 Serial number 

 Common controller parameters 

 Controller parameters 

 

Figure 9.21 System Parameter Output File Format 

9.16.2 Setting System Parameters with a File 

Set the system parameters in the subsystem with the information described in the file. If you 
set the system parameters using a file that was output when a priced optional feature is in 
an unlocked state, the setting may terminate abnormally. To set system parameters, use a 
file that was output when all priced optional features are in a locked state. 

For a dual system, setting cannot be executed if one of the controllers is detached. Verify 
that the subsystem is operating normally. 

When system parameters are set, the subsystem cannot execute commands from the host. 
The functions of the Storage Navigator Modular can no longer work; however, the wizard 
sets the system parameters and failure monitoring. After setting, restart the subsystem. 
Confirm that it is operating successfully. It connects to the host and the Storage Navigator 
Modular. 

To set subsystem parameters with a file: 
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1. Edit the file for setting the system parameters to set the subsystem. The file has a 
specified format. The format of the file is the same as that of the file output by the 
subsystem. Refer to the following sections of this manual for the format and parameters 
of the file respectively. 

For the format of the file, see section 9.16.1. 

2. On the Tools menu, select Configuration Settings or click . 

3. Click the Constitute tab. 

4. Click the System Parameter option. 

5. Specify the directory and file name of the file that describes the system parameters 
edited in step 1. The specified file name displays in the text box. 

6. Select the Input option. 

7. Click Apply. 

8. When the confirmation message displays, click OK. 

9.16.3 RAID/Logical Units and Configuration File Output Status  

To output RAID group/logical unit definition information already set in the subsystem to a 
specified file in a text format: 

1. On the Tools menu, select Configuration Settings or click . 

2. Click the Constitute tab. See Figure 9.22. 

 

Figure 9.22 Configuration Settings - Constitute panel (output) 
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3. Click the RAID Group/Logical Unit option in the Select Configuration Information box. 

4. Specify the directory and file name to output the file of the configuration. 

5. Select the Output option. 

6. Click Apply. 

7. When the confirmation message displays, click OK. 

System parameter information is saved in the form of a text file with the specified file 
name. 

The format of the output file consists of the following items. An outline of the layout of the 
output file is shown in Figure 9.23. 

 File header 

 Subsystem registration name at the Storage Navigator Modular 

 Output time (Web Server time where the Storage Navigator Modular is installed) 

 Microprogram revision 

 Subsystem type 

 Serial number 

 RAID group/logical unit configuration 

 Status of constituent parts 

 

Figure 9.23 RAID Group/Logical Unit Configuration Information Output File Format 
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9.16.4 Setting RAID Group/Logical Unit Definition with a File 

Set the subsystem according to the RAID group/logical unit setting information described in 
a file. If the setup of the RAID group/logical unit is configured and completed, all of the 
previous user’s data will be lost. The RAID group/logical unit configuration, as specified in 
the file, is set after deleting the current RAID group/logical unit. If user data is needed, 
configure the setting after backing up the system. 

1. Edit the file to set the RAID group/logical unit information in the subsystem. The file has 
a specified format. The format of the file is the same as that of the file output by the 
subsystem. For the proper file format, see section 9.16.3. 

The parameters in the file are RAID configuration information, LU configuration 
information, and Drive information in the format of the output file. In the output file, 
there are items that give the status of constituent parts. Ignore these items while 
setting up the configuration. The parameters are described below: 

a) RAID configuration information: Sets the RAID configuration which specifies RAID 
level, RAID group number and RAID size. If the RAID group is not set, “-” is shown 
after Level, and no other parameters are set. 

b) LU configuration information: Sets the logical unit configuration. 

Specifies the logical unit number, logical unit capacity, pre-read capacity, number 
of controllers in current use, number of controllers in default use, RAID group 
number and RAID level, and logical unit status. 

In logical unit status, for cases where formatting is to be executed, specify Normal. 
Formatting cannot be executed if another status is specified. 

In cases where the full capacity of the RAID group is allocated to one logical unit, 
specify All in Capacity. 

If the number of the controller in current use is specified as “0” or “1”, it becomes 
the same as the number of the controller in default use. 

In cases where logical units of less than the maximum logical unit number are 
created, specify at the end that “After nn, not define” (nn: the last logical unit 
number + 1). 

c) Drive information: Sets the configuration of the HDU installed in the subsystem. For 
an HDU that is not installed, do not specify anything. 

When a capacity bigger than that of the installed HDU is specified, it is regarded as 
an error and not set. 

2. On the Tools menu, select Configuration Settings or click . 

3. Click the Constitute tab. 

4. Click the RAID Group/Logical Unit option. 

5. Specify the directory and name of the file that describes the RAID group definition and 
logical unit definition edited in step 1. The specified file name is shown in the text box. 

6. Select the Input option. 

7. Click Apply. 

8. Messages display and warn you of the following: 
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– The procedure deletes the current RAID/LU configuration. 

– User data in the logical units are invalidated and cannot be recovered. 

To continue, click OK in the messages. 

9. A message displays, stating that the RAID configuration setting has started: 

– When the setting of the RAID group ends abnormally, an error message displays and 
interrupts processing. 

– If the setting of the RAID group ends normally, a message that the setting of logical 
unit has started displays, and executes the logical unit setting. 

– When the logical unit setting ends abnormally, an error message displays and 
interrupts processing. 

– If the logical unit setting ends normally, formatting of the set logical unit starts. 

10. A message displays stating that the setting is complete. Click OK. 

9.16.5 Port/Host Group Information File Output 

To output the settings of the port/host group information for the subsystem in text form to a 
specified file: 

1. On the Tools menu, select Configuration Settings or click . 

2. Click the Constitute tab. See Figure 9.24. 

 

Figure 9.24 Configuration Settings - Constitute panel (output) 
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3. Check the Port Information option in the Select Configuration Information box. 

4. Specify the directory and file name to which the host group information file will be 
output. 

5. Click the Output option. 

6. Click Apply. 

7. When the confirmation message displays, click OK. 

The host group information is saved in the form of a text file with the specified file name. 

The format of the output file consists of the following items. The outline of the layout of the 
output file is shown in Figure 9.25. 

 File header 

 Registration name with the Storage Navigator Modular of the subsystem  

 Output time (Web Server time where the Storage Navigator Modular is installed.) 

 Microprogram revision 

 Subsystem type 

 Serial number 

 Mapping mode 

 Port option 

 Host group option 

 Host group information 

 Logical unit mapping information 
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Figure 9.25 Format Outline of Port/Host Group Information Output File 

9.16.6 Setting Port/Host Group Information with a File 

To set Port/Host Group settings with a file: 

1. On the Tools menu, select Configuration Settings or click . 

2. Click the Constitute tab. See Figure 9.26. 
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Figure 9.26 Configuration Settings - Constitute panel (input) 

3. Click the Port Information (Update) option in the Select Configuration Information 
box. 

4. Select the items that you will set from setting information for Fibre. An error will occur 
if nothing is chosen. (When the LUN Manager function is valid, the WWN Information 
displays for setting information for Fibre.) 

5. Specify the directory and file name to which the host group information file will be 
input. 

6. Select the Input option. 

7. When the confirmation message displays, click OK to continue. 

8. One or more messages advise that a subsystem restart is required. Follow the on-screen 
instructions to stop subsystem access and click OK to continue. 

9. A message displays, stating that the setting is complete. Click OK. 
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9.16.7 File Output of Boot Option Information 

1. On the Tools menu, select Configuration Settings or click . 

2. Click the Constitute tab. See Figure 9.27. 

 

Figure 9.27 Configuration Settings – Boot options (output) 

3. Check Boot Options in the Select Configuration Information box. 

4. Specify the directory and file name to which the boot option information file will be 
output. 

5. Click Apply. 

6. When the confirmation message displays, click OK. 

The boot options information is saved in the form of a text file with the specified file name. 

The format of the output file consists of the following items. The outline of the layout of the 
output file is shown in Figure 9.28. 

 File header 

 Registration name with the Storage Navigator Modular of the subsystem 

 Output time (Web Server time where the Storage Navigator Modular is installed.) 

 Microprogram revision 

 Subsystem type 

 Serial number 
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 Boot options information 

 

Figure 9.28 Format Outline of Boot Options Information Output File 

9.16.8 Setting Boot Option Information with a File 

WARNING: Rebooting requires stopping I/O from the host.  

WARNING: If you are using TrueCopy or TrueCopy Extended Distance and you are required to 
reboot the subsystem, change the pair status to PSUS before you reboot. 

WARNING: If you are using a NAS, you must also stop the clusters between NAS units. When 
restarting the subsystem, you must restart the clusters. 

1. On the Tools menu, select Configuration Settings or click . 

2. Click the Constitute tab. See Figure 9.29. 
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Figure 9.29 Configuration Settings - Boot Options (input) 

3. Check Boot Options and Input option in the Select Configuration Information box. 

4. Specify the directory and file name to which the boot option information file will be 
input. 

5. Click Apply. 

6. When the confirmation message displays, click OK. 

7. One or more messages advise that a subsystem restart is required. Follow the on-screen 
instructions to stop subsystem access and click OK. 

When you choose to restart the subsystem, the time the restart began displays. This 
usually takes approximately 4 to 15 minutes. 

Note: It may take time for the subsystem to respond, depending on the condition of the 
subsystem. If it does not respond after 15 minutes, check the condition of the 
subsystem. 

8. A message displays, stating that the restart is successful.  

9.16.9 File Output of Parts Information 

To output parts information to a file: 

1. On the Tools menu, select Configuration Settings or click . 

2. Click the Constitute tab. See Figure 9.30. 
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Figure 9.30 Configuration Settings - Parts Info Panel (output) 

 

3. Check Parts Information in the Select Configuration Information box. 

4. Specify the directory and file name to which the parts information file will be output. 

5. Click Apply. 

6. When the confirmation message displays, click OK.  

9.16.10 Outputting NAS System LU/User LU to a File 

To output the NAS system LU/User LU to a file: 

1. On the Tools menu, select Configuration Settings or click . 

2. Click the Constitute tab. See Figure 9.31. 
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Figure 9.31 Configuration Settings - NAS System LUN Panel (output) 

3. Check the NAS:System LU/User LU option in the Select Configuration Information box. 

4. Specify the directory and file name to which the NAS system LU/User LU information file 
will be output. 

5. Click Apply. 

6. When the confirmation message displays, click OK. 

The NAS System LU and NAS User LU information is saved in the form of a text file with the 
specified file name. 

The format of the output file consists of the following items. The outline of the layout of the 
output file is shown in Figure 9.32. 

 File header 

 Registration name with the Storage Navigator Modular of the subsystem 

 Output time (Web Server time where the Storage Navigator Modular is installed.) 

 Microprogram revision 

 Subsystem type 

 Serial number 

 NAS System LU information 

 NAS User LU information 



 Hitachi TagmaStore AMS and WMS Storage Navigator Modular for Web User’s Guide 159 

 

Figure 9.32 Format Outline of NAS System/User LU Information Output File 
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9.16.11 Setting NAS System LU/User LU Information with a File 

1. On the Tools menu, select Configuration Settings or click . 

2. Click the Constitute tab.  

3. Check the NAS:System LU/User LU option and Input option in the Select Configuration 
Information box. 

4. Specify the directory and file name to which the NAS system LU/User LU information file 
will be input. 

5. Click Apply. 

6. When the confirmation message displays, click OK. 

9.16.12 File Output of iSCSI Port Information 

To output the settings of the iSCSI port information for the subsystem in text form to a 
specified file: 

1. On the Tools menu, select Configuration Settings or click . 

2. Click the Constitute tab. See Figure 9.33. 

 

Figure 9.33 Configuration Settings - Port Information Panel (output) 

3. Check the Port Information option in the Select Configuration Information box. 

4. Specify the directory and file name to which the iSCSI port information file will be 
output. 

5. Click the Output option. 
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6. Click Apply. 

7. When a message displays, confirming that the iSCSI port information is output with the 
specified file name, click OK. 

The iSCSI port information is saved in the form of a text file with the specified file name. 

The format of the output file consists of the following items. The outline of the layout of the 
output file is shown in Figure 9.34. 

 File header 

 Registration name with the Storage Navigator Modular of the subsystem 

 Output time (Web Server time where the Storage Navigator Modular is installed.) 

 Microprogram revision 

 Subsystem type 

 Serial number 

 Mapping mode 

 iSCSI port information 

 Port options 

 Target information 

 Host system configuration 

 Target options 

 Logical unit mapping information 
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Figure 9.34 Format Outline of iSCSI Port Information Output File 
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9.16.13 Setting iSCSI Port Information with a File 

To set iSCSI Port settings with a file: 

1. On the Tools menu, select Configuration Settings or click . 

2. Click the  Constitute tab. See Figure 9.35. 

 

Figure 9.35 Configuration Settings - Port Information Update Panel (input) 

3. Click the Port Information (Update) option in the Select Configuration Information 
box. 

4. Select the items that you will set from Setting Information for iSCSI. An error occurs if 
nothing is chosen. (When the LUN Manager function is valid, the Initiator Information 
displays for Setting Information for iSCSI.) 

5. Specify the directory and file name to which the iSCSI port information file will be input. 

6. Select the Input option. 

7. A confirmation message displays. To continue, click OK. 

8. One or more messages advise that a subsystem restart is required. Follow the on-screen 
instructions to stop subsystem access and click OK to continue. 

9. A message displays, stating that the setting is complete. Click OK. 
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9.16.14 Setting CHAP User Information with a File 

1. On the Tools menu, select Configuration Settings or click . 

2. Click the Constitute tab. See Figure 9.36. 

 

Figure 9.36 Configuration Settings - CHAP User (input) 

3. Click the CHAP User option in the Select Configuration Information box. 

4. Specify the directory and file name to which the CHAP User information file will be 
input. 

5. Select the Input option. 

6. A confirmation message displays. To continue, click OK. 

The CHAP User information setting file format is shown in Table 9-2. 
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Table 9-2 CHAP User Information Setting File Format 

File Contents Descriptions 

User name,secret,Target No. or alias ... The lines are invalid until <CHAP User> appears. 

<CHAP User>,, The valid lines are from <CHAP User> to <END>. 

<Port 0A>,, The line specifies the port. (<Port ALL> specifies all ports.) 

hitachi-0,abcdefghij00,alias0 The first column is CHAP User, and the second column is Secret. 

hitachi-1,abcdefghij01,alias1 The third row and the following are aliases of Target to assign. 

#hitachi-1,abcdefghij01,alias1 The line with the first character of # is a comment line. (Invalid line.) 

hitachi-2,abcdefghij02,3 The Target number can be specified as the alias of Target. 

<Port 0B>,,  

<Add CHAP User>,, If <Add CHAP User> is specified, CHAP User is added. 

hitachi-0,abcdefghij00,alias0 If nothing is specified, all CHAP Users are deleted, and then added. 

hitachi-1,abcdefghij01,alias0,alias01,alias02 One or more Targets can be specified. 

<Port 1A>,,  

<Port 1B>,,  

<END>,, The line of <END> and the following are all invalid lines. 

9.16.15 File Output of LAN Information 

To output the settings of the LAN information for the subsystem in text form to a specified 
file: 

1. On the Tools menu, select Configuration Settings or click . 

2. Click the Constitute tab. See Figure 9.37. 
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Figure 9.37 Configuration Settings window (output) 

3. Check the LAN Information option in the Select Configuration Information box. 

4. Specify the directory and file name to which the LAN information file will be output. 

5. Click the Output option. 

6. Click Apply. 

7. When a message displays, confirming that the LAN information is output with the 
specified file name, click OK. 

The LAN information is saved in the form of a text file with the specified file name. 

The format of the output file consists of the following items. The outline of the layout of the 
output file is shown in Figure 9.38. 

 File header. 

 Registration name with the Storage Navigator Modular of the subsystem. 

 Output time (Web Server time where the Storage Navigator Modular is installed.). 

 Microprogram revision. 

 Subsystem type. 

 Serial number. 

 User LAN information. 

Maintenance Port IP Address Automatic Change Mode. 

 Maintenance Port LAN information. 
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Concerning the Ether Address of the user LAN information, only the information on the 
controller connected over the LAN is output. To output the information on the both 
controllers, connect the both controllers over the LAN. When the information is output in 
the state in which the controller(s) is (are) blocked, the LAN information on the blocked 
controller(s) is output as 0.0.0.0. 

 

Figure 9.38 Format Outline of LAN Information Output File 

9.16.16 Setting LAN Information with a File 

WARNING: The User LAN Parameter (Maintenance Port IP Address Automatic Change Mode, 
IP Address, Subnet Mask, Default Gateway) and Maintenance LAN Parameter (Network 
Address) can be set up. The other information cannot be set up. 

To set LAN settings with a file: 

1. On the Tools menu, select Configuration Settings or click . 

2. Click the Constitute tab. See Figure 9.39. 
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Figure 9.39 Configuration Settings Window 

3. Click the Input option in the Operation box. 

4. Check the LAN Information option in the Select Configuration Information box. 

5. Specify the directory and file name to which the LAN information file will be input. 

6. Click Apply. 

7. A confirmation message displays. To continue, click OK. 
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9.17 Replacing a Microprogram 

Note: If a microprogram is read during the microprogram download, the download 
processing is interrupted. Read a microprogram after checking that it is not under download. 

The function downloads and replaces the microprogram in the subsystem. When replacing 
the microprogram, download it, and then replace it. 

This section includes the following: 

 Microprogram Download. 

 Replacing the Microprogram. 

9.17.1 Microprogram Download 

Download the microprogram from the CD-R into the subsystem. In the download, the 
microprogram is stored in the subsystem; the microprogram of the subsystem is not 
replaced. 

1. Copy the microprogram from the CD-R to the hard disk. 

Note: For a directory where the Storage Navigator Modular is installed, do not copy the 
microprogram directly to the CD-R. Create a subdirectory and copy it under this 
subdirectory. Specify the name of a directory in the hard disk drive to which the 
microprogram is copied, with a one-byte coded alphanumeric. 

2. On the Tools menu, select Configuration Settings or click . 

3. Click the Micro Update tab. See Figure 9.40. 

 

Figure 9.40 Configuration Settings Window – Microprogram 
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– Current Revision: Microprogram revision of each controller of the subsystem. 

– New Revision: A microprogram revision stored in the system in which the Storage 
Navigator Modular is installed. When the microprogram is not read, a blank is 
displayed. 

– Interval Time: Interval time for download. Specify the time between 1 and 
60 seconds. For the LAN connection, when the interval time is specified as 3 seconds, 
the download requires approximately 9 minutes. The time required for the execution 
varies with the network status and depends on I/Os issued by the host. When the 
interval time is specified as one second longer, the time required for the download is 
prolonged by 3 minutes. 

This function can be used during execution of the I/O instructed by the host. 
However, when the download function is executed, I/O performance of the host is 
reduced. To enhance performance, specify a longer interval time. 

– Revision Check: Instructs the revision check of the microprogram to be downloaded. 
When the download instruction is specified, whether or not a hot replacement is 
applicable to the microprogram is checked. Select Yes. 

When no microprogram is read, the Download and Delete buttons are displayed in gray 
and cannot be selected. 

4. The microprogram is read into the PC in which the Storage Navigator Modular is 
installed. Click Read. When a revision is displayed Revision (Read), the microprogram is 
already read. To download the microprogram that is already read, execute Download. 

When you have clicked Read, specify the revision directory in which the microprogram is 
installed is specified, all the microprograms are read automatically. 

5. When a confirmation message displays, asking whether to read the microprogram, click 
OK. 

If the microprogram is already read, a confirmation message displays. When OK is 
clicked, the microprogram is overwritten. To stop reading the microprogram, click 
Cancel. 

To delete the microprogram that is already read in the Web Server, click Delete. When a 
confirmation message displays, click OK. 

6. When a window for specifying a revision directory in which the read microprogram exits 
displays, enter this directory. See Figure 9.41. When OK is clicked, reading the 
microprogram is started. 

 

Figure 9.41 Micro Update Dialog Box 
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Figure 9.42 shows a path-input example. 

When using Windows®: 

D:/DF700/program/micro_upload/microprogram/0710A 

 Directory in the hard disk in which the 
microprogram is copied. 

 

Figure 9.42 Path-Input Example 

7. When a message displays indicating that the microprogram has been read, click OK. 

The revision of the read microprogram displays in the Revision (Read) field. See Figure 
9.43. 

 

Figure 9.43 Configuration Settings - Revision 

8. To download the microprogram, click Download. 

9. When a confirmation message displays requesting confirmation to download the 
microprogram, click OK. 

10. Select the access receptionist opportunity from the host after microprogram replaced. 
See Figure 9.44. 

 

Figure 9.44 Message dialog box 

– If you click Yes, the Storage Navigator Modular will not receive access from the host 
until you click OK. 
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– If you click No, the Storage Navigator Modular receives access from the host. 

A message displays stating that the download is being executed. See Figure 9.45. This 
message displays the revision of the program being downloaded, interval time, and 
progress. 

 

Figure 9.45 Microprogram Download Dialog Box 

The download can be aborted. To abort the download halfway, click Cancel. A 
confirmation message displays. See Figure 9.46. When OK is clicked, the download is 
aborted. When Cancel is clicked, the download is continued. 

 

Figure 9.46 Message Dialog Box (Cancel) 

11. When the microprogram is normally downloaded, a confirmation message displays. Click 
OK. 

Note: After the microprogram downloads, restart the subsystem or replace the 
microprogram. If a hot replacement of the controller board is done before restarting the 
subsystem or the microprogram replacement, the replaced new controller may be 
blocked. Download may terminate with a DMES05EA03 message when the subsystem is 
heavy host I/Os. Perform the download operation again. 

9.17.2 Replacing a Microprogram 

Replace the microprogram for the controller with the microprogram downloaded in the 
subsystem. When replacing the microprogram, replace both controller 0 and controller 1 
microprograms. When connecting with both controllers or only with controller 0, 
replacement begins with controller 0 and then with controller 1. When connecting only with 
controller 1, replacement takes place in controller 1 and then controller 0. 
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Note: When only the controller of one side replaces microprograms and the Array Unit 
screen is closed, there is a case where the Array Unit screen stops opening after that. When 
the Array Unit screen does not open, replace the microprograms after replacing the 
microprograms into the registration of a controller that is not replacing microprograms. 

WARNING: This operation will interrupt I/O from the host and may require rebooting the 
subsystem. 

WARNING: If you are using TrueCopy or TrueCopy Extended Distance and you are required to 
reboot, change the pair status to PSUS before you reboot. 

To replace the microprogram: 

1. On the Tools menu, select Configuration Settings or click . 

2. Click the Micro Update tab. See Figure 9.47. 

 

Figure 9.47 Configuration Settings - Micro Update 

3. Select the controller whose microprogram is to be replaced and click Replace. 

4. A confirmation message displays. Click OK. See Figure 9.48. 

 

Figure 9.48 Confirmation Message 

A status message displays. 

5. After the microprogram download, the following message displays. See Figure 9.49. 
Check the contents of the message and click OK. 
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Figure 9.49 Message Dialog Box 

6. When the microprogram replacement terminates normally, a completion message 
displays. When you click OK, the replacement microprogram updates and a window 
displays. 

If the downloaded microprogram fails, a failure message displays. To validate the 
downloaded microprogram, restart the subsystem. 

Note: It may take time for the subsystem to respond, depending on the condition of the 
subsystem. If it does not respond after 15 minutes, check the condition of the 
subsystem. 

7. Repeat this procedure to replace the microprogram on the other controller. When 
replacements for both controllers terminate normally, the subsystem microprogram 
replacement is complete. 

Note: When a microprogram is replaced, if the microprogram for only one of the 
controllers is replaced, the subsystem declares a warning state. When the other 
controller’s subsystem is replaced, the subsystem recovers from the warning state. 
Always replace the microprogram for both controllers. 

9.18 Setting the Backend Diagnosis Information 

1. On the Tools menu, select Configuration Settings or click . 

2. Click the Backend Diagnosis tab. See Figure 9.50. 
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Figure 9.50 Backend Diagnosis Setting 

– Auto Diagnosis Threshold: Specify the value in a range of 1 to 255. 

3. Click Apply. 

4. A confirmation message displays. Click OK. 
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Chapter 10 Configuring NNC 

This chapter includes the following sections: 

 10.1 Setting NNC LAN Information 

 10.2 Setting NAS System Logical Units 

 10.3 Setting NAS User Logical Units 

 10.4 Shutting Down/Booting/Rebooting NNC 

Figure 10.1 shows an example of a connection of the host computer (Web Server) in which 
the Storage Navigator Modular is installed and the disk array subsystem to which the NNC 
option has been added. 

 

10BaseT/100BaseT twisted pair cable 

Switch

LAN

Web Server

Array Unit 
(dual system) 

CTL1 LAN 

CTL0 LAN 

LAN

NTP Server

nnc1 LAN 

nnc0 LAN LAN 

Web Client

 

Figure 10.1 Disk Array Subsystem with NNC Option (Management Ports) 
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10.1 Setting NNC LAN Information 

To set the NNC LAN information for management port: 

1. On the Tools menu, select Configuration Settings or click . 

2. Click the NNC LAN tab. See Figure 10.2. 

 

Figure 10.2 Configuration Settings - NNC LAN 

Network: Specify the IP Address, Subnet Mask, MTU, and Negotiation, which is part of 
the LAN information. 

3. Click Apply. 

4. When the confirmation message displays, click OK. 
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10.2 Setting NAS System Logical Units 

Note: The NAS system logical units are usually set at the factory shipment, so that a user is 
not required to set them. 

Nine logical units are required for the NAS system. Figure 10.3 shows the capacity that is 
necessary. When no logical unit is available for allocating to the NAS system logical unit, 
create it. See section 5.5 for information about creating a logical unit. 

For NNC Type2    For NNC Type1 

  

Figure 10.3 Example of Name LUN Capacity display 

To set the NAS system logical units: 

10.2.1 For NNC Type2 

1. Click the Logical Status tab on the Array Unit screen. 

2. Click the NAS plus sign. See Figure 10.4. 

3. Click the NNC0/2 plus sign. 
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Figure 10.4 Array System Viewer - NNC0/2 

4. Click Set. 

The System LU dialog displays. See Figure 10.5. 

 

Figure 10.5 System LU dialog box 

5. Click Select to set the System LU. 

The Select Logical Unit dialog displays. See Figure 10.6. 

 

Figure 10.6 Select Logical Unit Dialog Box 

6. Select the LUN you want to set the System LU and click OK. 

The selected LUN displays to the System LU dialog box. See Figure 10.7. 

7. Repeat steps 5 and 6 and complete a System LU list. 
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Figure 10.7 System LU Dialog Box 

8. Click OK. 

9. When the confirmation message displays, click OK. 

10.2.2 For NNC Type1 

1. Click the Logical Status tab on the Array Unit screen. 

2. Click the NAS plus sign. See Figure 10.8. 

3. Click the NNC0/2 plus sign. 

 

Figure 10.8 Array System Viewer - NNC0/2 
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4. Click Set. 

The System LU dialog displays. See Figure 10.9. 

 

Figure 10.9 System LU dialog box 

5. Click Select to set the System LU. 

The Select Logical Unit dialog displays. See Figure 10.10. 

 

Figure 10.10 Select Logical Unit Dialog Box 

6. Select the LUN you want to set the System LU and click OK.  

The selected LUN displays to the System LU dialog box. See Figure 10.11. 

7. Repeat steps 5 and 6 and complete a System LU list.  
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Figure 10.11 System LU Dialog Box 

8. Click OK. 

9. When the confirmation message displays, click OK. 

10.3 Setting NAS User Logical Units 

When no logical unit is available for allocating to the logical unit for the NAS user, create it.  
See section 5.5 for information about creating a logical unit. 

To set the NAS user logical units: 

1. Click the Logical Status tab on the Array Unit screen.  

2. Click the NAS plus sign. See Figure 10.12. 

3. Click the NNC0/2 plus sign. 
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Figure 10.12 Array System Viewer - User 

4. Click Set. 

The User LU dialog box displays. See Figure 10.13. 

 

Figure 10.13 User LU Dialog Box 

5. Select one H-LUN to be added. Select one LUN and click . The added contents are 
displayed in Logical Unit for User Volume list. 
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6. Repeat step 5 and complete a User LU list. See Figure 10.14. 

 

Figure 10.14 User LU - H-LUN 

To cancel the assigned user LU, click the H-LUN to be canceled in the Logical Unit for 
User Volume list and click . 

The selected H-LUN moves to the Available Logical Units list. 

7. Click OK. 

8. When the confirmation message displays, click OK. 

10.4 Shutting Down/Booting/Rebooting NNC 

10.4.1 Shutting Down the NNC 

Note: When shutting down the NNC, just after the subsystem power ON or cluster start from 
the NAS Manager Modular, stop the NNC after the following confirmation displays: 

– The cluster status is “ACTIVE”, and the resource group status is “Online” or 
“Offline”. 

When shutting down NCC and NNC is not in the above situation, it is possible that the 
cluster setting and resource group setting cannot execute normally. 
(Example: When executing the cluster stop from the NAS Manager Modular that is 
connected to the NNC which is not executed the shutdown the NNC, it is possible that 
the cluster stop is not finished.) In this case, reboot the NNC, which is not executed the 
shutdown the NNC from Storage Navigator Modular. 

1. Click the Logical Status tab on the Array Unit screen. 
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2. Select the NAS icon and then select the NNC number on the NNC Status list. See Figure 
10.15. 

 

Figure 10.15 Array System Viewer - NNC Status 

– NNC Status: Status of NAS OS: 

– ACTIVE: NAS OS is active and the Node is in operation. 

– BOOT: NAS OS is in boot process. 

– DISUSE: The controller is blocked. 

– DOWN: NAS OS is abnormally stopped. 

– DUMP: A NAS Dump is being collected. 

– HUNGUP: NAS OS is hung-up. 

– INACTIVE: NAS OS is in operation and the Node is stopped. 

– INST: NAS OS is in installation process. 

– NEW: NAS OS is not installed. 

– SHUTDOWN: NAS OS is in shutdown process. 

– STOP: NAS OS is normally stopped. 

– WARN: NAS Manager is not installed, or NAS OS is in operation and the status of 
the Node is unknown. 

3. Click Shutdown. 

4. When the confirmation message displays, click OK. 
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10.4.2 Booting the NNC 

Note: There is not a difference in operation of boot and reboot. Do not specify anything for 
the boot option. 

1. Click Logical Status on the Array Unit screen. 

2. Select the NAS icon, and then select the NNC number on the NNC Status list. See Figure 
10.16. 

 

Figure 10.16 Array System Viewer - NNC Status list 

3. Click Boot. 

4. When the confirmation message displays, click OK. 

10.4.3 Rebooting the NNC 

Note: When rebooting the NNC immediately after the subsystem power ON or cluster start 
from NAS Manager Modular, reboot the NNC after the following confirmation displays. 

– The cluster status is “ACTIVE”, and the resource group status is “Online” or 
“Offline”. 

When rebooting the NNC and NCC is not in the above situation, it is possible that the 
cluster setting and resource group setting cannot execute normally. 
(Example: When executing the cluster stop from the NAS Manager Modular that is 
connected to NNC which is not executed the rebooting the NNC, it is possible that the 
cluster stop is not finished.) In this case, reboot the NNC which is not executed the 
rebooting the NNC from Storage Navigator Modular. 
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1. Click Logical Status on the Array Unit screen. 

2. Select the NAS icon, and then select the NNC number on the NNC Status list. See Figure 
10.17. 

 

Figure 10.17 Array System Viewer - NNC Status list 

3. Click Reboot. 

4. When the confirmation message displays click OK. 



 Hitachi TagmaStore AMS and WMS Storage Navigator Modular for Web User’s Guide 189 

Chapter 11 Displaying Statistical Information 

This chapter includes the following sections: 

 11.1 Displaying Controller Activity  

 11.2 Displaying Host Commands Received (Read/Writes per LU) 

 11.3 Displaying Command Execution Activity 

 11.4 Displaying Cache Load Condition 
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11.1 Displaying Controller Activity 

To display controller activity: 

On the Tools menu, select Statistical Information or click . See Figure 11.1. 

 

Figure 11.1 Statistical Information Window 

 Array Time 

– Controller is active for (Integrated): The accumulated time when the power is 
applied from the initial powering on of the disk array subsystem to the latest 
powering off is displayed by the minute. 

– Power on for (Work): The time elapsed from the powering on of the disk array 
subsystem to the present time is displayed by the millisecond. 

 Controller 

– Powered on counts: Integrated number of power ON times (at interruption) of the 
controller. 

– H-SCSI reset counts: Integrated number of host bus SCSI reset times (total of 
interruptions and messages) of the controller (not supported). 
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11.2 Displaying Host Commands Received (Read/Writes per LU) 

To display the cumulative read and write commands per logical unit, select the 
Host Commands tab. See Figure 11.2. 

 

Figure 11.2 Statistical Information - Host Commands 

11.3 Displaying Command Execution Activity 

To display the command execution activity, select the Execution tab. See Figure 11.3. 

 

Figure 11.3 Statistical Information - Execution 
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 A: Logical Unit: Logical unit number 

 B: Read Cache Hits: Total of READ commands (hitting cache or partially hitting cache) 

 C: Write Cache Hits: Total of WRITE commands (cache read hits) 

 D: Sequential Read: Total of READ commands (recognized as sequential reading) 

 E: Sequential Write: Total of WRITE commands (recognized as sequential writing) 

 F: Prefetch Staging: Total of prefetch jobs executed 

 G: Write Through Operation: Total of WRITE or WRITE & VERIFY commands (substituted 
by Write-Through operations) 

 H: Reassigned Blocks: Number of re-assigned blocks (not supported) 
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11.4 Displaying Cache Load Condition 

To display cache load activity, click the Cache Load tab. See Figure 11.4. 

 

Figure 11.4 Statistical Information - Cache Load 

Number of Inflow Threshold Reached: Total number of occurrences of inflow limitations. 

This equipment manages the amount of data in cache as an inflow limit. When the host tries 
to write data exceeding this limit, an inflow limitation occurs. In this case, the write request 
from the host waits until part of the write data is transferred to the drive. 
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Chapter 12 Acquiring Performance Information 

In the statistics information, the command operation state is output for each logical unit in 
the array unit. The command operation state consists of three types of data: the number of 
received commands, the number of cache-hit commands, and the cache hit rate for each 
Read or Write command. 

This chapter includes the following sections: 

 12.1 Collecting Performance Statistics 

 12.2 Manually Outputting Performance Statistics to a Text File 

 12.3 Automatically Outputting Performance Statistics to a Text File 
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12.1 Collecting Performance Statistics 

To collect performance statistics: 

1. On the Tools menu, select Performance  Settings. See Figure 12.1. 

 

Figure 12.1 Performance Statistics Window 

2. Select items from the Collection of Performance Statistics. 

3. Click OK. 

A confirmation message indicates that the host access may be affected during statistic 
collection. Click OK. 

12.2 Manually Outputting Performance Statistics to a Text File 

To create a performance-statistic text file: 

1. On the Tools menu, select Performance  Output File or click . See Figure 12.2. 
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Figure 12.2 Performance Window 

2. Select a component name (Port, RAID Groups, Logical Unit, Cache, Processor, Drive, 
Drive Operation, or Back-end) for information about the controller. 

3. Specify the extent of the output using Select, excluding the Cache and Processor. When 
the extent is not specified, all is output. For example, when you want to specify an 
extent of information on the Logical Unit, select the Logical Unit icon, click Select, and 
specify the extent of the Logical Unit. See Figure 12.3. 

 

Figure 12.3 Performance - Logical Unit Selection 

4. Click the number of the first LU you do not want to output. Scroll the LU numbers with 
the slider keeping the Shift key pressed, and click the number of the last LU. See Figure 
12.4. 



198 Chapter 12   Acquiring Performance Information 

 

Figure 12.4 Performance - Logical Unit Selection 

5. Click OK. 

6. Select the Manual option. 

7. Set the Collectively output option:  

– Select to append the current output to the previous output. 

– Clear to collect only the current output. 

8. Specify the output directory. If the output directory is omitted, output defaults to the 
directory Storage Navigator Modular installation directory. 

9. Click Start. 

10. Click Get Data. See Figure 12.5. 

 

Figure 12.5 Performance Window 
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a) When the Collectively output is not specified: 

These files are output in the text file format. 

: pfm$$$$$.txt ($$$$$: serial number from 00000 to 19999) 

Note: Files are output with the names of pfm00000.txt to pfm19999.txt. After 
pfm19999.txt, pfm00000.txt is overwritten. Transfer the necessary information to 
another directory. 

The information is acquired according to the following timing. See Figure 12.6. 

 Get dataGet dataGet dataGet data 

pfm00002.txtpfm00001.txtpfm00000.txt  

Figure 12.6 Timing 

b) When the Collectively output is specified: 

This file is output in the text file format (pfm.txt). 

11. After the file processed is terminated, a confirmation message displays. Click OK. 

12. Click Stop. 

When the single system is connected, information is only collected for the controller 0 
side. 

Note: For AMS500 subsystems, a single output to text file is 500 KB. Multiple outputs 
increase the file size proportionally. A file with 20,000 outputs requires about 10 GB of 
disk space. 

– No.: Output number. 

– Information getting time: Time and date when the information is acquired. 

– CTL: Controller number. 

– Port: Port number. 

– IO Rate (IOPS): Number of Read/Write commands received per second. 

– Read Rate (IOPS): Number of Read commands received per second. 

– Write Rate (IOPS): Number of Write commands received per second. 

– Read Hit (%): Rate of the number of the Read commands, which could cache-hitting, 
out of the Read commands received in the specified period. 

– Write Hit (%): Rate of the number of the Write commands, which could write data 
immediately to the cache, out of the Write commands received in the specified 
period. 

– Trans. Rate (MB/S): Transfer size of Read/Write commands per second. 

– Read Trans. Rate (MB/S): Transfer size of Read commands per second. 

– Write Trans. Rate (MB/S): Transfer size of Write commands per second. 

– Read CMD Count: Received number of Read commands. 

– Write CMD Count: Received number of Write command. 
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– Read CMD Hit Count: Number of the Read commands that had been cache-hit. 

– Write CMD Hit Count: Number of the Write commands, which could write data 
immediately to the cache. 

– Read Trans. Size (MB): Transfer size of Read commands. 

– Write Trans. Size (MB): Transfer size of Write commands. 

– RG: RAID group number. 

– LU: Logical unit number. 

– Read CMD Hit Count2: Number of the Hit Read Special Path commands out of the 
read commands that made cache hits. 

– Read CMD Hit Time(microsec.): The average response time of the Hit Read Special 
Path command. 

– Read CMD Hit Max Time(microsec.): The maximum response time of the Hit Read 
Special Path command. 

– Write CMD Hit Count2: Number of the Write Special Path commands out of the 
Write commands, which could write data immediately to the cache. 

– Write CMD Hit Time(microsec.): The average response time of the Write Special 
Path command. 

– Write CMD Hit Max Time(microsec.): The maximum response time of the Write 
Special Path command. 

– Read CMD Miss Count: The number of the Miss Read Special Path commands out of 
the Read commands that made no cache hits. 

– Read CMD Miss Time(microsec.): The average response time of the Miss Read 
Special Path command. 

– Read CMD Miss Max Time(microsec.): The maximum response time of the Miss Read 
Special Path command. 

– Write CMD Miss Count: The number of the Random Write Special Path commands 
that could complete the high-speed process up to the parity generation that is an 
extended process of the Write command. 

– Write CMD Miss Time(microsec.): The average response time of the Random Write 
Special Path command. 

– Write CMD Miss Max Time(microsec.): The maximum response time of the Random 
Write Special Path command. 

– Read CMD Job Count: The number of the Read commands that could not perform 
the high-speed process. 

– Read CMD Job Time(microsec.): The average response time of the Read command 
job. 

– Read CMD Job Max Time(microsec.): The maximum response time of the Read 
command job. 

– Write CMD Job Count: The number of the Write commands that could not perform 
the high-speed process. 

– Write CMD Job Time(microsec.): The average response time of the Write command 
job. 
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– Write CMD Job Max Time(microsec.): The maximum response time of the Write 
command job. 

– Read Hit Delay CMD Count(<300ms): The number of commands, whose response 
time is less than 300 ms, out of the Hit Read Special Path commands. 

– Read Hit Delay CMD Count(300-499ms): The number of commands, whose response 
time is in a range of 300 ms to 499 ms, out of the Hit Read Special Path commands. 

– Read Hit Delay CMD Count(500-999ms): The number of commands, whose response 
time is in a range of 500 ms to 999 ms, out of the Hit Read Special Path commands. 

– Read Hit Delay CMD Count(1000ms-): The number of commands, whose response 
time is 1000 ms or more, out of the Hit Read Special Path commands. 

– Write Hit Delay CMD Count(<300ms): The number of commands, whose response 
time is less than 300 ms, out of the Write Special Path commands. 

– Write Hit Delay CMD Count(300-499ms): The number of commands, whose response 
time is in a range of 300 ms to 499 ms, out of the Write Special Path commands. 

– Write Hit Delay CMD Count(500-999ms): The number of commands, whose response 
time is in a range of 500 ms to 999 ms, out of the Write Special Path commands. 

– Write Hit Delay CMD Count(1000ms-): The number of commands, whose response 
time is 1000 ms or more, out of the Write Special Path commands. 

– Read Miss Delay CMD Count(<300ms): The number of commands, whose response 
time is less than 300 ms, out of the Miss Read Special Path commands. 

– Read Miss Delay CMD Count(300-499ms): The number of commands, whose 
response time is in a range of 300 ms to 499 ms, out of the Miss Read Special Path 
commands. 

– Read Miss Delay CMD Count(500-999ms): The number of commands, whose 
response time is in a range of 500 ms to 999 ms, out of the Miss Read Special Path 
commands. 

– Read Miss Delay CMD Count(1000ms-): The number of commands, whose response 
time is 1000 ms or more, out of the Miss Read Special Path commands. 

– Write Miss Delay CMD Count(<300ms): The number of commands, whose response 
time is less than 300 ms, out of the Random Write Special Path commands. 

– Write Miss Delay CMD Count(300-499ms): The number of commands, whose 
response time is in a range of 300 ms to 499 ms, out of the Random Write Special 
Path commands. 

– Write Miss Delay CMD Count(500-999ms): The number of commands, whose 
response time is in a range of 500 ms to 999 ms, out of the Random Write Special 
Path commands. 

– Write Miss Delay CMD Count(1000ms-): The number of commands, whose response 
time is 1000 ms or more, out of the Random Write Special Path commands. 

– Read Job Delay CMD Count(<300ms): The number of commands, whose response 
time is less than 300 ms, out of the Read command job. 

– Read Job Delay CMD Count(300-499ms): The number of commands, whose response 
time is in a range of 300 ms to 499 ms, out of the Read command job. 
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– Read Job Delay CMD Count(500-999ms): The number of commands, whose response 
time is in a range of 500 ms to 999 ms, out of the Read command job. 

– Read Job Delay CMD Count(1000ms-): The number of commands, whose response 
time is 1000 ms or more, out of the Read command job. 

– Write Job Delay CMD Count(<300ms): The number of commands, whose response 
time is less than 300 ms, out of the Write command job. 

– Write Job Delay CMD Count(300-499ms): The number of commands, whose 
response time is in a range of 300 ms to 499 ms, out of the Write command job. 

– Write Job Delay CMD Count(500-999ms): The number of commands, whose 
response time is in a range of 500 ms to 999 ms, out of the Write command job. 

– Write Job Delay CMD Count(1000ms-): The number of commands, whose response 
time is 1000 ms or more, out of the Write command job. 

– Tag Count: The maximum number of tags in the specified period. 

– Cache Write Pending Rate (%): Rate of cache usage capacity (middle+physical) 
within the cache capacity. 

– Cache Clean Queue Usage Rate (%): Rate of clean cache usage. 

– Cache Middle Queue Usage Rate (%): Rate of middle cache usage. 

– Cache Physical Queue Usage Rate (%): Rate of physical cache usage. 

– Cache Total Queue Usage Rate (%): Rate of total cache usage. 

– Partition: Partition number. 

– Usage (%): Operation rate of the processor. 

– Host-Cache Bus Usage Rate (%): The use rate of the bus between the host and the 
cache. 

– Drive-Cache Bus Usage Rate (%): The use rate of the bus between the drive and the 
cache 

– Processor-Cache Bus Usage Rate (%): The use rate of the bus between the processor 
and the cache. 

– Cache (DRR) Bus Usage Rate (%): The use rate of the bus between the parity 
generation circuit (DRR) and the cache. 

– Dual Bus Usage Rate (%): The use rate of the bus between the controllers. 

– Total Bus Usage Rate (%): The total use rate of the cache bus. 

– Unit: Unit number. 

– HDU: HDU number. 

– Online Verify. Rate (IOPS): Number of Online Verify commands per second. 

– Online Verify CMD Count: Number of Online Verify commands. 

– Operating Rate (%): Operation rate of the drive. 

– Tag Count: Number of Tag. 

– Unload Time (min.): Unload time of the drive. 

– Path: Path number. 

– Loop: Loop number. 
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12.3 Automatically Outputting Performance Statistics to a Text File 
Command operation state for each logical unit in the subsystem is output at the specified 
intervals by the specified times. 

1. On the Tools menu, select Performance or click . See Figure 12.7. 

 

Figure 12.7 Performance Window 

2. Select a component name (Port, RAID Groups, Logical Unit, Cache, Processor, Drive, 
Drive Operation, or Back-end) for information about the controller. 

3. Specify the extent to be output using Select, excluding the Cache and Processor. When 
the extent is not specified, all is output. For example, when you want to specify an 
extent of information on the Logical Unit, select the Logical Unit icon, click Select, and 
specify the extent of the Logical Unit. 

4. Select the Auto option. 

5. Specify the Interval Time and Get Count Times. 

6. When you want to make an output as an addition to the information previously output, 
check the Collectively output check box. Do not check this box when you want to 
overwrite the information that was previously output. 

7. Specify the output directory. If the output directory is omitted, it will be outputted to 
the directory where the Storage Navigator Modular is installed. 
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8. Click Start. See Figure 12.8. 

A status message displays. 

 

Figure 12.8 Automatic Acquisition Dialog Box 

a) When Collectively output is not specified: 

These files are output in the text file format. 

: pfm$$$$$.txt ($$$$$: serial number from 00000 to 19999) 

Note: Files are output with the names of pfm00000.txt to pfm19999.txt. After 
pfm19999.txt, pfm00000.txt is overwritten. Transfer necessary information to 
another directory. 

b) When Collectively output is specified: 

This file is output in the text file format (pfm.txt). 

9. After the file processed terminates, a confirmation message displays. Click OK. 

When the single system is connected, only information from controller 0 is collected. 

The format to the file to be retrieved is the same as that of the file retrieved manually. 

Note: For AMS500 subsystems, a single output to text file is 500 KB. Multiple outputs 
increase the file size proportionally. A file with 20,000 outputs requires about 10 GB of 
disk space. 



 Hitachi TagmaStore AMS and WMS Storage Navigator Modular for Web User’s Guide 205 

Chapter 13 Monitoring Errors  

This chapter includes the following sections: 

 13.1 Setting Error Monitoring Options 

 13.2 Registering the Failure Monitoring Account 

 13.3 Outputting Failure Information to a Log File 

 13.4 Error Monitoring 

 13.5 Checking Status 
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13.1 Setting Error Monitoring Options 

During error monitoring, when a failure is detected on the monitored array unit, the E-mail 
Report or one in a specified application can be started. 

In Error Alert, click the E-Mail Error Report Enabled check box and the Execute 
Application check box to enable them. See Figure 13.1. 

1. On the Tool menu, select Error Monitoring  Options or click . 

 

Figure 13.1 Setting Error Monitoring Options 

13.1.1 Interval Time 

1. Specify the interval time for error monitoring. 

Specify Interval Time in the range of 1 minute to 720 minutes (12 hours). The interval 
means the time from an end of all target array unit monitoring until the start of the next 
monitoring. 

2. Click OK. 

The setting is validated without rebooting Storage Navigator Modular. 

13.1.2 E-mail Report 

When an error is detected by error monitoring, the contents of the error are reported. 

If an error is detected on the array unit while error monitoring is executed, the following 
error information is reported by E-mail. Usually, the subject is appended before the  
E-mail is transmitted. 

 E-mail Subject 

 E-mail Message Text 
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E-Mail Subject 

For E-mail, the section that failed is appended to the subject. The subject format is shown 
below. Table 13-1 shows a list of subjects. 

Storage Navigator Modular/Obstruction (Failed Part) 

Table 13-1 List of E-mail Subjects 

Subject Meaning 

Disk A drive blockade occurred (for 9200). 

FC Disk An FC drive blockade occurred (for 9500V). 

SATA Disk An SATA drive blockade occurred. 

DC Power A DC power supply failure occurred. 

Battery A battery voltage error occurred. 

Fan A fan failure occurred. 

Controller A controller blockade occurred. 
(This occurs only in the dual controller configuration.) 

AC Power An AC power supply error occurred. 

Cache Memory A cache failure occurred. 

Cache Backup Circuit A backup circuit failure occurred. 

ENC An enclosure error occurred. 

SENC An SENC error occurred. 

Loop A loop error occurred. 

Path A path blockade occurred. 

Warning The array unit entered the warning state. 

Array connection A failure occurred in the connection with the subsystem. 
A power OFF or a failure occurred in the subsystem. 

Host Connector A host connector error occurred (for the AMS subsystem). 

NNC An NNC blockade occurred (for the AMS subsystem). 

E-mail Message Text 

When using E-mail, the failed part is reported using the message text in the subject. The 
format of the message text is shown below. A list of messages is shown in Table 13-2 and 
Table 13-3. The message format is: 

Day, Mon.dd hh:mm:ss yyyy/DF Name/message text 
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Table 13-2 List of E-mail Message Texts (AMS200 and AMS500) 

No. Message Text Meaning of Message 

1 ARRAY Alert Started. The error monitoring is started. 

2 ARRAY FC Drive Detached. 
ARRAY Detached FC Drive Position Unit No.X HDU 
No.Y. 

An FC drive blockade occurred. 
(The blocked drive is indicated with a set of a Unit No. and an 
HDU No.) 

3 ARRAY SATA Drive Detached. 
ARRAY Detached SATA Drive Position Unit No.X 
HDU No.Y. 

An SATA drive blockade occurred. 
(The blocked drive is indicated with a set of a Unit No. and an 
HDU No.) 

4 ARRAY Battery Alarm. Position Battery No.X. A battery voltage error occurred. 

5 ARRAY Fan Alarm. Position Unit No.XX Fan No.X. A fan failure occurred. 

6 ARRAY CONTROLLER Detached. 
Position CONTROLLER No.X. 

A controller blockade occurred. 
(This occurs only in the dual controller configuration.) 

7 ARRAY AC Power Supply Failure. 
Position Unit No.XX AC Power No.X. 

An AC power supply error occurs. 

8 ARRAY Cache Memory Alarm. A cache failure occurred. 

9 ARRAY Cache Backup Circuit Alarm. A backup circuit failure occurred. 

10 ARRAY ENC Alarm. Position Unit No.XX ENC No.X. An enclosure error occurred. 

11 ARRAY SENC Alarm. Position Unit No.XX SENC 
No.X. 

An SENC error occurred. 

12 ARRAY Loop Alarm. A loop error occurred. 

13 ARRAY Path Alarm. A path blockage occurred. 

14 ARRAY Host Connector Alarm. 
Position CONTROLLER No.X. 

A host connector error occurred. 

15 ARRAY Warning. The array unit entered the warning state. 

16 ARRAY Storage Navigator Modular Interface error 
occurred 

A failure occurred in the connection with the array unit. 
A power OFF or a failure occurred in the array unit. 

17 ARRAY NNC Detached. Position NNC No.X. An NNC blockade occurred. 

18 ARRAY NNC Warning. Position NNC No.X. An NNC partial blockade occurred. 
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Table 13-3 List of E-mail Message Texts (9200 and 9500V) 

No. Message Text Meaning of Message 

1 ARRAY Alert Started. The error monitoring is started. 

2 ARRAY Drive Detached. 
ARRAY Detached Drive Position Port No.X Row No.Y 

A drive blockade occurred. 
(9200: The blocked drive is indicated with a set of a Port No. 
and a Row No.) 

3 ARRAY FC Drive Detached. 
ARRAY Detached FC Drive Position Unit No.X HDU 
No.Y. 

An FC drive blockade occurred (for 9500V). 
(The blocked drive is indicated with a set of a Unit No. and an 
HDU No.) 

4 ARRAY SATA Drive Detached. 
ARRAY Detached SATA Drive Position Unit No.X 
HDU No.Y. 

An SATA drive blockade occurred (for 9500V). 
(The blocked drive is indicated with a set of a Unit No. and an 
HDU No.) 

5 ARRAY Battery Alarm. A battery voltage error occurred. 

6 ARRAY Fan Alarm. A fan failure occurred. 

7 ARRAY CONTROLLER Detached. A controller blockade occurred. 
(This occurs only in the dual controller configuration.) 

8 ARRAY AC Power Supply Failure. An AC power supply error occurs. 

9 ARRAY Cache Memory Alarm. A cache failure occurred. 

10 ARRAY Cache Backup Circuit Alarm. A backup circuit failure occurred. 

11 ARRAY ENC Alarm. An enclosure error occurred. 

12 ARRAY SENC Alarm. An SENC error occurred. 

13 ARRAY Loop Alarm. A loop error occurred. 

14 ARRAY Path Alarm. A path blockage occurred. 

15 ARRAY Warning. The array unit entered the warning state. 

16 ARRAY Storage Navigator Modular Interface error 
occurred 

A failure occurred in the connection with the array unit. 
A power OFF or a failure occurred in the array unit. 

1. Specify the setting items in the E-mail Report. 

– E-mail Error Report Enabled: Specifies whether or not to execute the E-mail Report 
when an error is detected by error monitoring. When this item is checked off, the  
E-mail Report will be executed. ON/OFF is displayed on the right side depending on 
whether a check mark exists or not. 

– Domain Name: Specifies a domain name. Specify it in 39 or less alphanumeric 
characters or a code. 

– Mail Server Address: Specifies the IP address or host name of the mail server. 
Specify the host name in 99 or less alphanumeric characters. 

– From Address: Specifies the mail address of the E-mail sender. Specify it in 99 or 
less alphanumeric characters or a code. 

– Send To Address: Specifies the mail address of the E-mail receiver. Specify it in 99 
or less alphanumeric characters or a code. Up to 20 addresses can be set as 
receivers. 
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Add: Specify the Send To Address in the text box above Add and click Add. The 
Send to Address added to the Send to Address list displays. 

Replace: Click the Send to Address to be replaced in the Send to Address list. 
Specify the Send to Address in the text box above Add. Click Replace. The replaced 
Send to Address displays in the Send to Address list. 

Delete: Click the Send to Address to be deleted in the Send to Address list and 
click Delete. The deleted Send to Address disappears from the Send to Address list. 

2. To verify the setting, click Test. 

When the mail has been normally transmitted, a confirmation message displays. Click 
OK. 

The following mail is transmitted to the set Send to Address. Check the receipt of mail 
by Send to Address. If the mail has not been received, check the setting. 

– Subject: Storage Navigator Modular/Obstruction (test) 

– message: Day, Mon. dd hh:mm:ss yyyy/DF Name /Test message: 

Day: Day of the week hh:mm:ss: Hours, minutes, and seconds 

Mon: Month yyyy: Year 

dd: Date 

3. Click Close. 

The setting is validated without rebooting Storage Navigator Modular. 

13.1.3 Setting Additional Information on E-mail 

When registering or changing the properties of the subsystem, you can add unique 
information on the E-mail header or on the unit trace information header. 

1. In the Properties window of the subsystem, in the Mail Additional Information text box, 
enter the information in less than or equal to 64-byte characters. See Figure 13.2. 
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Figure 13.2 Modify Array Unit - Properties 

The information set on E-mail is added to the E-mail attribute. The format follows: 

– Day, Mon. dd hh:mm:ss yyyy/DF Name/Additional Information/message text 

To delete the information, select text and press the Delete key. 

13.1.4 Executing Application 

Execute Application is set so that another application may be started if an array unit error 
is detected when error monitoring is executed. 

When the application is started, it activates the window. The current size and position are 
displayed. 

1. Set the necessary items to start an application. 

 Execute Application: Specifies whether or not to activate the application when a 
failure is detected by the error monitoring. The application is activated when the check 
box is clicked. ON/OFF is displayed on the right side depending on whether a check mark 
exists or not. 

 Application Execute Mode: Specifies when to activate the application: 

– On the first failure: The specified application is activated when the first failure is 
detected after the error monitoring has been activated. When failures are detected 
continuously, the application is not activated. To activate the application again 
when a failure is detected after the application has been activated, terminate the 
error monitoring once and then restart it. 

– On every failure: The specified application is activated when a failure is detected 
after the error monitoring has been activated. When the same failure is detected 
while the error monitoring is executed, the application is not activated at the 
second and subsequent detections of it. 
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Note:  When you select On every failure, the specified application is started upon 
detection of each error. Consequently, multiple specified applications may be started 
and the system may hang-up. Select On first failure. After occurrence of an error, stop 
error monitoring, and restart it after a recovery from the error. 

If an error is caused by starting the specified application during error monitoring, a 
message is displayed and error monitoring is suspended. When the message is closed, the 
monitoring continues. 

 Application Name: Specifies a path and a file name of the application to be activated. 
See Figure 13.3. When the file name is long, enclose it with the quotation marks ( “ ). 
When specifying a data file name of the application, specify the full path if the data file 
is not in the same directory in which Storage Navigator Modular is located. 

– For Windows 

Example 1: “C: \abc\application.exe” 

Example 2: “C: \abc\application.exe (option)” 

Example 3: “c:\abc\application.exe(option)” ”c:\abc\application.dat” 

Path and file name of the application Data file name of the application  

Figure 13.3 Example Application Name 

2. To check the setting, click Test. Verify that the specified application is started. 

3. Click OK. Setting will be validated without rebooting Storage Navigator Modular. 
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13.2 Registering the Failure Monitoring Account 

Failure monitoring cannot be applied to an array unit that is an object of the account 
management unless it is logged in. Register the common user ID and the password for the 
monitoring to be used at the time of the failure monitoring. Registering is required to create 
the user ID and the password for the failure monitoring beforehand for each array unit that 
the account management has validated. 

1. On the Tool menu, select Error Monitoring  Account. See Figure 13.4. 

 

Figure 13.4 Monitoring Account Information 

2. Select the Enable radio button on the Monitoring Account box. Enter the User ID and 
the Password for the failure monitoring that were created beforehand. 

In the Monitoring Test Result list, array units for which the failure monitoring has been 
validated are displayed. 

3. To check whether the failure monitoring can be applied to the certain array unit, select 
the array unit from the Monitoring Test Result list and click the Test button. 

4. Verify that displayed OK in the Result column and click the OK button. 

5. A message displays, click OK. 

13.3 Outputting Failure Information to a Log File 

When a failure is detected in the array unit when error monitoring is executed, the function 
outputs the failure information to a log file. 

The log file is output in the text file format with a file name of errlog.txt to the same 
directory in which Web Navigator execution file is located. The format for displaying the 
array unit state transition is shown below as an example. The file format is shown in the 
following figure. A list of message texts is shown in Table 13-4 and Table 13-5. 
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Day, Mon. dd hh:mm:ss yyyy/DF Name/message text: 

– Day: Day of the week  

– hh:mm:ss: Hours, minutes, and seconds 

– Mon: Month  

– yyyy: Year 

– dd: Date 
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Table 13-4 Message Texts (AMS200 and AMS500) 

No. Message Text Meaning of Message 

1 ARRAY Alert Started. The error monitoring is started. 

2 ARRAY FC Drive Detached. 
ARRAY Detached FC Drive Position Unit 
No.X HDU No.Y. 

An FC drive blockade occurred. 
(The blocked drive is indicated with a set of a Unit No. and an HDU 
No.) 

3 ARRAY SATA Drive Detached. 
ARRAY Detached SATA Drive Position Unit 
No.X HDU No.Y. 

A SATA drive blockade occurred. 
(The blocked drive is indicated with a set of a Unit No. and an HDU 
No.) 

4 ARRAY Battery Alarm. Position Battery 
No.X. 

A battery voltage error occurred. 

5 ARRAY Fan Alarm. Position Unit No.X Fan 
No.X. 

A fan failure occurred. 

6 ARRAY CONTROLLER Detached. 
Position CONTROLLER No.X. 

A controller blockade occurred. 
(This occurs only in the dual controller configuration.) 

7 ARRAY AC Power Supply Failure. 
Position Unit No.X AC Power No.X. 

An AC power supply error occurs. 

8 ARRAY Cache Memory Alarm. A cache failure occurred. 

9 ARRAY Cache Backup Circuit Alarm. A backup circuit failure occurred. 

10 ARRAY ENC Alarm. 
Position Unit No.X ENC No.X. 

An enclosure error occurs. 

11 ARRAY SENC Alarm. 
Position Unit No.X SENC No.X. 

An SENC error occurred. 

12 ARRAY Loop Alarm. A loop error occurs. 

13 ARRAY Path Alarm. A path blockade occurred. 

14 ARRAY Host Connector Alarm. 
Position CONTROLLER No.XX. 
Host Connector No.X. 

A host connector error occurs. 

15 ARRAY Warning. The array unit entered the warning state. 

16 ARRAY Storage Navigator Modular 
Interface error occurred. 

A failure occurred in the connection with the array unit. 
A power OFF or a failure occurred in the array unit. 

17 ARRAY NNC Detached. 
Position NNC No.X. 

An NNC blockade occurred. 

18 ARRAY NNC Warning. Position NNC No.X. An NNC partial blockade occurred. 
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Table 13-5 Message Texts (9200 and 9500V) 

No. Message Text Meaning of Message 

1 ARRAY Alert Started. The error monitoring is started. 

2 ARRAY Drive Detached. ARRAY Detached 
Drive Position Unit No.X HDU No.Y. 

A drive blockade occurred (for 9200). 
(The blocked drive is indicated with a set of a Unit No. and a HDU No.) 

3 ARRAY FC Drive Detached. 
ARRAY Detached FC Drive Position Unit 
No.X HDU No.Y. 

An FC drive blockade occurred (for 9500V). 
(The blocked drive is indicated with a set of a Unit No. and an HDU 
No.) 

4 ARRAY SATA Drive Detached. 
ARRAY Detached SATA Drive Position Unit 
No.X HDU No.Y. 

A SATA drive blockade occurred (for 9500V). 
(The blocked drive is indicated with a set of a Unit No. and an HDU 
No.) 

5 ARRAY Battery Alarm. A battery voltage error occurred. 

6 ARRAY Fan Alarm. A fan failure occurred. 

7 ARRAY CONTROLLER Detached. A controller blockade occurred. 
(This occurs only in the dual controller configuration.) 

8 ARRAY AC Power Supply Failure. An AC power supply error occurs. 

9 ARRAY Cache Memory Alarm. A cache failure occurred. 

10 ARRAY Cache Backup Circuit Alarm. A backup circuit failure occurred. 

11 ARRAY ENC Alarm. An enclosure error occurred. 

12 ARRAY SENC Alarm. An SENC error occurred. 

13 ARRAY Loop Alarm. A loop error occurred. 

14 ARRAY Path Alarm. A path blockage occurred. 

15 ARRAY Warning. The array unit entered the warning state. 

16 ARRAY Storage Navigator Modular 
Interface error occurred. 

A failure occurred in the connection with the array unit. 
A power OFF and a failure occurred in the array unit. 

The output size of a log file is up to 520 k bytes. When the log information exceeds the 
limit, the log file is renamed to “errlog.txt.pre” and log file “errlog.txt” is newly created. 

The string "--- end ---" comes at the end of log information output. If the log information 
surpasses its limit again, the existing log file "errlog.txt" is replaced with “errlog.pre.txt" 
and then a new log file "errlog.txt" is created again. 

Note: “Time when a failure is detected” is determined by the clock in the Web Server 
installing Web Navigator. 
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13.4 Error Monitoring 

Error monitoring checks the component status of the array unit. This including drives, 
controller, battery, fan, power supply, and cache. Placing a check in the Error Watch box in 
registered array unit information enables error monitoring at an interval specified for the 
interval time. 

Note:  When you perform error monitoring, close the Array Unit screen before monitoring. If 
error monitoring is performed with the Array Unit screen open, array units may not be 
monitored normally. 

To monitor errors: 

1. Click : Error Watch on the Main screen. See Figure 13.5. 

 

Figure 13.5 Storage Navigator Modular – Array Unit 

Monitoring is started for the array unit for which “Error Alert” is specified. The Error 
Watch button on the Main screen displays . After the start of error 
monitoring, the monitoring status displays in the status bar. The icon displays a 
monitoring result of the array unit. 

After error monitoring is performed for all the target array units, monitoring will be 
started again for these target array units after the lapse of the specified interval time. 

Error monitoring status displays on the left side of the scroll bar in the following three 
states. Additionally, the monitoring result of all the array units subject to monitoring 
displays with icons. 
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Table 13-6 Error Monitoring Status 

Monitoring 
Status 

Display Characters Character Color Array Unit Status 

Stop Stop 
  Gray Error monitoring is not executed. 

Monitoring 
   Blue Error monitoring is executed and the all the target array 

units are normal. 
Monitoring 

Monitoring 
   Red Error monitoring is executed and errors are detected in 

some of the target array units. 

Waiting 
   Blue Error monitoring is at the interval time and all the target 

array units that were previously monitored are normal. 
Waiting 

Waiting 
   Red Error monitoring is at the interval time and errors are 

detected in some of the target array units that were 
previously monitored. 

As an error monitoring result, the status displays with the icon color of the array unit in the 
Main screen. 

Subsystems in the dual system: 

  Gray 

 Not monitored 
 Monitored but failure to authenticate a user 

  Gray + Blue 

 Normal 

  Gray + Yellow 

 An error is detected. 
 A communication error occurs in a controller. 

  Gray 

 A power OFF or a failure of the array unit occurred. 
 A communication error occurs in both controllers. 

Subsystems in the single system: 

  Gray 
 Not monitored 
 Monitored but failure to authenticate a user 

  Gray + Blue 

 Normal 

  Gray + Yellow 

 An error is detected. 

  Gray 

 A power OFF or a failure of the array unit occurred. 
 A communication error occurred. 

2. To display the detail information of the array unit, stop error monitoring, click an array 
unit to be displayed, and click . The contents of display may be 
different depending on the relationship between Error Alert result and “Time” because 
polling is performed. 

When the icon displays a Caution symbol, this represents a communication disable status 
with the array unit. Detailed information cannot be displayed. 
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3. Click , and Error Alert will stop. The icon of the array unit 
continues to display the last error monitoring result. 

Click the icon of an array unit on the Main screen, and then click . 

Note: When the icon displays a Caution symbol as an Error Alert result, this represents a 
connection disable status to the array unit or an information get disable status from the 
array unit. The causes are as follows: 

Table 13-7 Icon Caution Error Alert 

Cause Contents of Check 

Communication line failure Check the LAN line. 

Connected array unit failure Check the READY status of the subsystem. 

Too high I/O load from the host Check the array unit operation status. 

Execution of the logical unit format of the connected 
array unit, wizard setting of system parameter, or SNMP 
environment information setting 

Check the array unit status or restart the subsystem. 

4. Check all of the above. After verifying that the connection with the array unit displayed 
with a Caution symbol has been enabled, start error monitoring. 

If the icon of the array unit goes yellow because of a controller blockage, the same 
status as that of the Caution symbol icon may be provided. 

If error monitoring is performed, and the array unit icon displays with a Caution symbol, 
the icon of the normal array unit may be displayed with a Caution symbol. If the cause 
corresponds to “Too high I/O load from the host”, continue to execute monitoring. 

If a drive whose display color is not blue in Unit Status in the Array Unit screen (a drive 
that is not logical unit-formatted or an undefined spare drive) is pulled out, no error 
report will be made but it has no effect on the operation. Insert it once again. 

If an error occurs, contact a Customer Engineer. 

13.5 Checking Status 

You can check the status of the following subsystem components: drives, controllers, 
batteries, fans, power supply and cache. A status check is done on the subsystem for which 
the check box of the Error Alert Flag in “Array Unit Define” is selected. 

To check the status of subsystem components: 

On the View menu, select Refresh. See Figure 13.6. 
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Figure 13.6 Storage Navigator Modular Web - Group 

The status of an array unit for which error monitoring is specified is checked. When checking 
begins, the icon of an array unit displays with the check result reflected into the icon. 

The status check performs functions equivalent to those of error monitoring. When an error 
is detected in an array unit that has been checked, output of a log, sending of an E-mail, 
and restarting of a specified application are performed in accordance with the settings of 
the monitor options. 



 Hitachi TagmaStore AMS and WMS Storage Navigator Modular for Web User’s Guide 221 

Chapter 14 Tuning Parameters 

The tuning parameters include parameters concerning the system and logical unit. 

This chapter includes the following sections: 

 14.1 Multi Stream Tuning Parameters 

 14.2 Prefetch Parameters 

 14.3 Setting System Tuning Parameters 
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14.1 Multi Stream Tuning Parameters 

1. On the Tools menu, click Tuning Parameter.  

The Tuning Parameter panel displays. See Figure 14.1. 

 

Figure 14.1 Tuning Parameter Window 

– Scope: Select System or Logical Unit. 

– Mode / Prefetch Information: 

– LUN: Displays All. 

– Mode: Displays Normal, Read, Write, or Read/Write. 

– Prefetch Next: Displays Disable or Enable. 

– Prefetch Criteria: Displays Base or Fixed. 

2. When you want to modify the setting, click Modify.  

The Prefetch Multi Stream (System) dialog displays. See Figure 14.2. 

 

Figure 14.2 Prefetch Multi-Stream Dialog Box 

– Mode: Specify the mode: 

– Read: When you select the Read mode, specify the Prefetch Next Enable or 
Disable. 



 Hitachi TagmaStore AMS and WMS Storage Navigator Modular for Web User’s Guide 223 

– Write: When you select the Write mode, you cannot specify the Prefetch Next. 

– Prefetch Criteria: Specify the pre-fetch criteria. 

3. Specify the parameters and click OK.  

4. Select the Logical Unit on the Scope. See Figure 14.3. 

 

Figure 14.3 Tuning Parameter - Logical Unit 

– Scope: Select System or Logical Unit. 

– Mode / Prefetch Information: 

– LUN: Displays logical unit number. 

– Mode: Displays Normal, Read, Write, or Read/Write. 

– Prefetch Next: Displays Disable or Enable. 

– Prefetch Criteria: Displays Base or Fixed. 

5. Select the LUN setting to modify, and click Modify. 

The Prefetch Multi Stream (Logical Unit) dialog displays. See Figure 14.4. 

 

Figure 14.4 Prefetch Multi Stream - Logical Unit 
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– Logical Unit No.: Displays the logical unit number. 

– Mode: Specify the mode: 

– Read: When you select the Read mode, specify the Prefetch Next Enable or 
Disable. 
You can specify only Fixed in the Prefetch Criteria. 

– Write: When you select the Write mode, cannot specify the Prefetch Next. 

– Prefetch Criteria: Specify the pre-fetch criteria. 

6. Specify the parameters and click OK. 

7. Click Apply on the Tuning Parameter panel. 

8. A message displays, stating that the setting is complete. Click OK. 

To initialize the Multi Stream parameters: 

1. When you want to initialize the multi stream parameters, click Default on the Tuning 
Parameter panel. 

2. A message displays stating that the setting is complete. Click OK. 

14.2 Prefetch Parameters 

1. On the Tools menu, select Tuning Parameter. 

The Tuning Parameter panel displays. See Figure 14.5. 

 

Figure 14.5 Tuning Parameter Window 

– Count of Judgment Sequential: Specify the count of judgment sequential. 

2. Select the LUN you want to modify the prefetch size, and then click Modify. 

The Prefetch Staging Size dialog displays. See Figure 14.6. 
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Figure 14.6 Prefetch Staging Size Dialog Box 

3. Specify Prefetch Size, click OK. 

4. Click Apply. 

5. The Setting Complete message displays; click OK. 

6. Initialize the Prefetch parameters. 

7. When you want to initialize the prefetch parameters, click Default on the Prefetch tab. 

8. A message displays stating that the setting is complete. Click OK. 

14.3 Setting System Tuning Parameters 

To customize system tuning parameters: 

1. From the Tools menu, select Tuning Parameter. 

The Tuning Parameter panel displays. 

2. Click the System tab. See Figure 14.7 
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Figure 14.7 Tuning Parameter Window 

– Dirty Data Opportunity: Specify an occasion to de-stage dirty data (%). 

– Dirty Data Stop Opportunity: Specify an occasion to stop de-staging dirty data (%). 

– Cache Control Mode: Specify the cache control mode. 

– Detailed Trace Mode: Specify the detailed trace mode. 

3. Click Apply. 

4. A confirmation message displays. Click OK to apply the settings. 

To restore the default system tuning parameters: 

1. From the Tools menu, select Tuning Parameter. 

The Tuning Parameter panel displays. 

2. Click the System tab. 

3. Click Default. 

4. A confirmation message displays. Click OK to apply the settings. 
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Appendix A Cooperation with HiCommand Device Manager 

This appendix describes the operating environments and the installation method when using 
Storage Navigator Modular with Solaris. 

This appendix includes the following sections: 

 A.1    About Cooperation 

 A.2    About Solaris  
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A.1 About Cooperation 

HiCommand Device Manager and Storage Navigator Modular can cooperate with each other. 

For procedures about installing HiCommand Device Manager and registering Storage 
Navigator Modular, refer to the HiCommand Device Manager manual. 

Install Storage Navigator Modular (Web server) in the same server computer in which 
HiCommand Device Manager has been installed. 

When starting Storage Navigator Modular (Web Client) using the Web server affiliated with 
HiCommand Device Manager, specify the URL shown below. 

Example: http//############/program/DeviceManager/stonavm/default.htm

A virtual directory of Web 
Navigator prepared in the 
Web server. 

IP address or host name of Web 
server. 
(Do not specify loop back address 
such as localhost and 127.0.0.1.)
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A.2 About Solaris 

The Solaris version of Storage Navigator Modular can be used only when it cooperates with 
HiCommand Device Manager. 

See the following for installation. 

Web server 

1. Create a new directory (example: /usr/stonavm) for installing Storage Navigator 
Modular. Copy the SNM-xxxx-S-GUI.tar file, which is in the stonavm_sol directory of the 
provided CD-R, to the newly created directory in the hard disk drive. 

(The portion “xxxx” of file names varies with the version of the Storage Navigator 
Modular, etc.) 

2. The SNM -xxxx-S-GUI.tar is the Tar format of a file. Develop the file by referring to the 
example below. 

Example: tar xvf SNM -xxxx-S-GUI.tar 

3. Edit the snmsrv file into a directory of Storage Navigator Modular. 

Alter the part, DFHOME=/home/user/public_html/stonavm, into the directory in which 
Storage Navigator Modular has been installed. 

At this time, suppose that DFHOME=/usr/stonavm. 

4. Copy the snmsrv file to the /etc/init.d directory and make a hard link, which is named 
S99snmsrv, in the /etc/rc3.d directory. 

Example: cp /usr/stonavm/snmsrv /etc/init.d & in /etc/init.d/snmsrv 
/etc/init.d/S99snmsrv 

5. Restart the SUN™ server. 

6. Set the memory size, if necessary, referring to Appendix B Notes on Making Multiple 
Launches. 

Web client 

For information about Web Client operations such as settings of the Web browser and 
Java Plug-in in Web client, refer to the HiCommand Device Manager manual. 
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Appendix B Notes on Making Multiple Launches 
 

B.1 Making Two or More Launches 

Two or more launches cannot be made for the same disk array subsystem. However, two or 
more launches can be made for different disk array subsystems. 
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B.2 Notes on Making Multiple Launches 

When two or more launches are made at the same time, the operation of Storage Navigator 
Modular may become unstable because its memory capacity becomes insufficient. This can 
be avoided when the maximum usable memory size of Java is enlarged through a setting. 
The default memory size is 64 MB. The maximum size that can be set varies and depends on 
the environment. Use the following procedure to set the memory size for Windows and 
Solaris servers: 

For Windows Server™ 

For Windows, the memory capacity becomes insufficient if the number of simultaneous 
launches is six or more. When the number of launches is about six or more, perform the 
following procedure. 

1. Select Control Panel → Administrative Tools → Service. 

2. Stop SNM Server. 

3. Select Run from the Windows Start menu, and input regedit. 

4. Select Export Registry File from the Registry menu of the Registry Editor. Back up the 
current registry information by selecting Export range, Selected branch and saving the 
information. 

5. Select the following keys from the tree view of the Registry Editor. 

HKEY_LOCAL_MACHINE 

  \SYSTEM 

    \CurrentControlSet 

      \Services 

        \SNMServer 

         \Parameters 

6. Double-click Options in the list view. Add the following character string at the end of the 
value data. 

|-Xmx#m 

Specify a numerical value larger than 64 for the “#”. The standard value is an estimated 
number of simultaneous launches multiplied by 12. 
 
Example: When the estimated number of simultaneous launches is eight, add|-Xmx96m. 

7. Exit the Registry Editor. 

8. Start SNM Server. 

For Solaris Server 

For Solaris, the memory capacity becomes insufficient if the number of simultaneous 
launches is four or more. When the number of launches is four or more, perform the 
following procedure: 
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1. Edit the snmsrv file in the directory in which Storage Navigator Modular has been 
installed. 

Change the following “$DAMP_JAVAHOME/bin/java jp.co. hitachi. str. 
diskarray. rmi. FileServer &” to the following: 

“$DAMP_JAVAHOME/bin/java -Xmx#m jp.co. hitachi. str. diskarray. 
rmi. FileServer &” 

Specify a numerical value larger than 64 for the # symbol. The standard value is an 
estimated number of simultaneous launches multiplied by 20. 

Verify that the standard change is different from the above for the Windows server™. 

Example: When the estimated number of simultaneous launches is eight: 

“$DAMP_JAVAHOME/bin/java -Xmx160m jp.co. hitachi. str. diskarray. 
rmi. FileServer &” 

2. Copy the snmsrv file to the /etc/init.d directory. 

3. Restart Solaris server. 
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Appendix C Using Resource Manager 9500V/9520V for Web and 
Storage Navigator Modular 

If you are using Resource Manager 9500V/9520V for Web, in addition to Storage Navigator 
Modular for Web, run one of the following procedures for your Windows or Solaris server. 

For Windows Servers 

1. Select Control Panel → Administrative Tools → Service. 

2. Stop the SNM Server and DFMNG Server. 

3. Select Run from the Windows Start menu, and enter regedit. 

4. Select Export Registry File from the Registry menu of the Registry Editor. Back up the 
current registry information by selecting Export range, Selected branch and then save 
the information. 

5. Select the following keys from the tree view of the Registry Editor. 

HKEY_LOCAL_MACHINE 

  \SYSTEM 

    \CurrentControlSet 

      \Services 

        \SNMServer 

         \Parameters 

6. Double-click Options in the list view. Add the following character string to the front of 
the value data: (|wrkdir). 

;< the directory in which Resource Manager 9500V/9520V for Web has been 
installed>\DAMP2\CONFMNG2.JAR|wrkdir 

7. Select the following keys from the tree view of the Registry Editor. 

  \SYSTEM 

    \CurrentControlSet 

      \Services 

        \DFMNGServer 

         \Parameters 

8. Double-click Options in the list view. Add the following character string to the front of 
the value data: (|wrkdir). 

;<Storage Navigator Modular Web installation directory>\server\stonavm.jar|wrkdir 

9. Exit the Registry Editor. 

10. Start the SNM Server and DFMNG Server. 
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For Solaris Servers 

1. Edit the snmsrv file in the directory in which Storage Navigator Modular for Web has 
been installed. 

2. Add the following character string after the line of 
“CLASSPATH=$STONAVM_HOME/stonavm.jar” 

;< the directory in which Resource Manager 9500V/9520V for Web has been 
installed>\damp2\confmng2.jar 

3. Copy the snmsrv file to the /etc/init.d directory. 

4. Edit the dfmngsrv file in the directory in which Resource Manager 9500V/9520V for 
Web has been installed. 

5. Add the following character string after the line of 
“CLASSPATH=$DAMP_ROOT_DIR_PATH/confmng2.jar” 

;<Storage Navigator Modular Web installation directory>\ 
server\stonavm.jar 

6. Copy the dfmngsrv file to the /etc/init.d directory. 

7. Restart Solaris the server. 
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Appendix D Logging on when Two or More LAN Cards are 
Installed on the Server 

The login can be accepted from only one LAN card even if two or more LAN cards are 
installed in the server. Perform the following procedure to accept the login from the other 
LAN card. 

1. Add the following file in the “server” directory located in the install directory: 

File name: snmserver.properties 

2. Edit the snmserver.properties file to have the following contents and save the file: 

jp.co.hitachi.str.diskarray.rmi.hostname=<IP address or host name> 

Example 

To accept logins from the LAN card of which IP address is “192.168.100.101”. 

jp.co.hitachi.str.diskarray.rmi.hostname=192.168.100.101 

3. For the Windows server™, restart SNM Server service. 

For the Solaris server, reboot the SUN server. 
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Appendix E Changing the Port Number for Storage Navigator 
Modular 

Storage Navigator Modular uses TCP port number 1099. If the server uses TCP port number 
1099 port for another application, Storage Navigator Modular will not work. Perform the 
following procedure to use another port number for Storage Navigator Modular. 

To change the port number for Storage Navigator Modular: 

1. Add the following file in the “server” directory located in the install directory: 

File name: snmserver.properties 

2. Edit the snmserver.properties file with the following contents and save the file: 

jp.co.hitachi.str.diskarray.rmi.port=<port number> 

Example: 

To use TCP port number 10990 for the Web Navigator: 

jp.co.hitachi.str.diskarray.rmi.port=10990 

3. Edit “UserLogin.html” located in the install directory. 

Example: 

To use TCP port number 10990 for the Web Navigator, add the following lines: 

      1      <!-- 

 

      ..     .. 

      65     "<PARAM NAME='model' VALUE='models/HyaluronicAcid.xyz'>", 

Add   66     "<PARAM NAME='SNM_RMI_PORT' VALUE='10990'>", 

 

      ..     .. 

      106    "<PARAM NAME='model' VALUE='models/HyaluronicAcid.xyz'>", 

Add   107    "<PARAM NAME='SNM_RMI_PORT' VALUE='10990'>", 

 

      ..     .. 

      155    </HTML> 

4. For the Windows server™, restart SNM Server service. 

For the Solaris server, reboot the SUN server. 
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Acronyms and Abbreviations 
Acronym Expansion 

AMS Adaptable Modular Storage 
 
CLI 

 
command line interface 

DAMP Disk Array Management Program 
DDL data definition language 
DHCP dynamic host configuration protocol 
 
GUI 

 
graphical user interface 

HACMP High Availability Cluster Multi-Processing 
HDLM Hitachi Dynamic Link Manager 

IIS Internet Information Service 
 
JRE 

 
Java 2 Runtime Environment 

KB kilobytes 

LAN local-area network 
LIP loop initialization primitive 
LU logical unit 
LUN logical unit number 

MB megabyte 

NAS network-attached storage 
NNC network node controller 
NTP network time protocol 

PV physical volume 

RAID redundant array of inexpensive disks 
RTC real-time clock 

SNM Storage Navigator Modular 
SNMP simple network management protocol 

VCS VERITAS Cluster Server 
VxVM VERITAS Volume Manager 

WMS Workgroup Modular Storage 
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Glossary 

A 

Attribute 
As used in this document, an attribute is one or more qualities possessed by an object. 

C 

Cache 
Cache is a temporary, high-speed storage mechanism. It can be either a reserved section 
of main memory or an independent high-speed storage device. Two types of caching are 
found in computers: memory caching and disk caching. Memory caches are built into the 
architecture of microprocessors and often computers have external cache memory. Disk 
caching works like memory caching; however, it uses slower, conventional main memory 
that on some devices is called a memory buffer. 

Capacity 
Capacity is the amount of information (in bytes) that can be stored on a disk drive. The 
capacity of a hard disk drive is usually expressed in megabytes. Capacity is the measure 
of the potential contents of a device; the volume it can contain or hold. In 
communications, capacity refers to the maximum possible data transfer rate of a 
communications channel under ideal conditions. 

Channel 
A channel is the path data communication follows between two nodes of a network. It is 
the link between the central processor and the peripherals. A channel can be the 
physical cabling that connects the nodes on a network, an electronic signal traveling 
over a pathway, or a sub-channel in a carrier frequency. 

Configuration 
Configuration for hardware involves setting various switches and jumpers. For software 
it means defining the values of parameters. For hardware and software respectively, 
configuration is the arrangement of the components that make up the system or the set 
up and set values of the software. 

L 

Logical 
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Logical is used to describe a user's view of the way data or systems are organized. The 
opposite of logical is physical, which refers to the real organization of a system. A 
logical description of a file is that it is a quantity of data collected together in one place. 
The file appears this way to users. Physically, the elements of the file could live in 
segments across a disk. 

Logical Unit (LU) 
See User Logical Unit (LU) 

Logical Volume 
An area on a disk consisting of device files that are logically integrated using a volume 
manager. 

M 

Microcode 
Microcode is the lowest-level instructions directly controlling a microprocessor. 
Microcode is generally hardwired and cannot be modified. 

P 

Pair 
See ShadowImage pair. 

Panel 
In this document a panel is equivalent to a window. 

Parity 
The quality of being either odd or even. The fact that all numbers have a parity is 
commonly used in data communications to ensure the validity of data. This is called 
parity checking. So parity provides an error detection scheme that uses an extra 
checking bit, called the parity bit, to allow the receiver to verify that the data is error 
free. 

Permission 
Using SMB/CIFS, HTTP, WebDAV, and SMTO gateways, permissions are granted from the 
owner to members of a group or other users to allow access to data files or directories in 
an archive. Read, write, and execute permissions can be granted for files, directories, or 
symbolic links. 



 

 Hitachi TagmaStore AMS and WMS Storage Navigator Modular for Web User’s Guide 245 

R 

Remote or target site  
A site that has the mirrored data of the production site. 

S 

SATA 
Serial ATA is a serial link, a single cable with a minimum of four wires creates a point-to-
point connection between devices. ATA is a computer bus technology primarily designed 
for transfer of data to and from a hard disk. SATA is the successor to the legacy 
Advanced Technology Attachment standard (ATA, also known as IDE or Integrated Drive 
Electronics). 

Service 
A service is the set of functions that one of the seven (7) Open Systems Interconnection 
(OSI) model layers delivers to the layer above it. For example, the TCP layer provides a 
reliable byte-stream service to the application layer above it. 

ShadowImage 
ShadowImage is a software program that replicates user data on TagmaStore® USP disks, 
bypassing the host system. 

Shadowimage Pair 
A disk is a Logical Volume Image (LVI). S-VOLs and T-VOLs are ShadowImage volumes for 
Source and Target. Data is physically copied from the S-VOL to the T-VOL. 

SNMP 
Simple Network Management Protocol is a protocol used to facilitate monitoring and 
management of clusters through an external interface. SNMP sends notifications to IP 
addresses whenever certain types of events occur. 

Snapshot 
A term used to denote a copy of the data and data-file organization on a node in a disk 
file system. A snapshot is a replica of the data as it existed at a particular point in time. 

T 

Target site 
See Remote or target site. 

TrueCopy 
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TrueCopy is a software program that replicates user data between two TagmaStore USP 
disks, bypassing the host system. 

U 

User Logical Unit (LU) 
A user logical unit is a term used to describe any device file located on an external disk 
subsystem connected to the TagmaStore USP or NSC by a fibre channel. 

V 

Volume 
A volume is the basic unit of storage that includes recovery logs and storage pools. A 
volume can be a logical volume management (LVM) logical volume, a standard file 
system file, a tape cartridge, or an optical cartridge. The various types of defined 
volumes include: external, internal, copy source, copy destination, reserve, data, 
journal, virtual, pool, system, LUSE, copy pair, and USP. 
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Index 

A 
array unit configuration, 36 
array unit error, 213 
array unit status, 222 
array unit system components, 17 

C 
Changing operation mode, 36 
CHAP User information, 165 
color number depth, 5 
command device LU size, 82 
command execution activity, 193 
constituent parts status, 145 
create RAID group, 54 

D 
data in cache, 195 
deleting a registered user, 35 
Differential Management LU, 79 
DirectX, 5 
disable status 

connection, 221 
dual active mode, 62 

E 
enable the change mode, 33 
errlog.txt, 215 
error monitoring, 208 

F 
failed part, 209 
fibre setting information, 154 
Free Capacity field, 62 

H 
HDU number, 57 
host group information, 152, 155, 159, 162 

I 
inflow limit, 195 
interval time, 171 
iSCSI port information, 161 
iSCSI port parameters, 126 

J 
Java plug, 10 
Java plug-in, 11 

K 
key code, 89 

L 
LAN cards, 9, 239 
LAN configuration, 47 
local host, 9 
log file size, 218 
logical unit icon, 25 
logical unit information, 66 
logical units 

required qty, 181 
logon information, 32 
loop back address, 31 

M 
mapping guard, 97 
message 

DMES05EA03, 173 
microprograms download, 170 
minimum logical unit size, 79 
monitor mode, 14 

N 
NNC option, 179 

P 
parity restoration, 71 
path-input example, 172 
patrol lamp icon, 48 
ping command, 7 
ping parameters, 128 
pointer tail or shadow, 31 
powering on display, 192 
prconf option, 5 
prefetch parameters, 227 

R 
RAID definition information, 52 
RAID group number, 23 
Registering the array unit, 33 
reset/LIP, 5 
restarting an array unit, 44 

S 
Set host group 0, 93 
set LAN configuration, 138 
Solaris, 229 
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spare drive, 76 
start of error monitoring, 219 
state 

locked and unlocked, 147 
subsystem icons, 41 
suspension status, 4 
SYSTEM account, 4 
system LU, 183, 185 

T 
TagmaStore AMS and WMS, introduction, 1 
TCP port number 1099, 241 
TCP/IP communication, 4 
TCP/IP port number, 30 

U 
unit screens, 4 
update the component display, 46 
user data 

is lost, 150 
user LU list, 187 

V 
virtual directory, 30 

W 
warning state, 175 
Web client, 12 
Web DAMP software, 10 
web server side, 4 
Windows firewall, 11 
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